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Foreword

EO’s founders built the E0 Personal Communicator to be highly

useful. But, as with any new product, we knew that some time

would pass before the market recognized and took advantage of

that usefulness. In writing this book, Ken Maki does a great ser—

vice to the market (and E0) by describing some of EO’s tremen—

dous capabilities as a communications device.

M1: Maki details the integration of the new technologies (such as

the pen interface, the Hobbit RlSC microprocessor, and advances

in miniaturization and communications) that make the EC) smaller,

lighter, and faster—a device that lets people who are out of the

office stay in touch and informed.

The E0 Personal Communicator is the route to easier and better

mobile communications, and i am most appreciative to Mr. Maki

for helping illuminate the way.

Alain Rossmann,

CEO <8: President of E0, lnc.
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Introduction

Earlier this year, a friend persuaded me to go to the Pen Expo, a

conference about pen—based computing technology in San Fran-
cisco. That’s when I first saw the E0 Personal Communicator, I

was blown away. Before I knew it, I had spent half an hour looking

at the E0 and another half hour looking at Perspective (the per—

sonal information manager that’s bundled with the E0).

My first reaction was that the E0 was a small computer on

steroids. Small, powerful, and more useful than any of the

portable computers I’d ever used, but I still had my doubts. What

did they mean by Personal Communicator? Was it just a market—

ing tool to differentiate the E0 from portable computers and other

pen—based systems? Or was there really substance to their claim

that this was something new?

After all, I could use my Macintosh PowerBook to send and

receive faxes. I could log into my E~mail accounts and send mes—

sages and transfer files. It would go with me anywhere I went and

was a great tool.

Then I brought the E0 home and got to know it better.

I’m afraid my PowerBook has been retired—not six months old

and I hardly take it anywhere. The E0 Personal Communicator is

everything EO Inc., claims. But, to see the E0 as something more

than a pen-based computer that has a modem, you need to see it
in action.

XIII
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INTRODUCTION 

This book is one way to see the E0 in action.

In the book, you’ll find descriptions of every aspect of the E0. But

beyond the descriptions are instructions and ideas about how to use

it. You’ll see that the E0 is not just an address book, a telephone, a

fax machine, a computing device, or an entry point into the world of

digital communications. It is all of these things and more.

It comes with enough software to make it complete without havv

ing to spend any more money. But if you want to expand on its

native capabilities, you can add software packages that are already
available. And, if you take some time to learn how to maximize

the E0, you’ll find that a desktop computer really becomes an

accessory to the E0.

The vision of EO’s formders is that the E0 will become as indis-

pensable as the telephone. Not quite a toaster, but then again who

talks to their toaster? This is the first machine of a new family of

machines that will change how business is done in the office or on

the road. I hope that my book does justice to the vision.

What You'l Fund In this Book

The E0 Travel Guide is your road map to an amazing new tech»

nology.

Each chapter is designed to explain what the E0 can do, then

show you how to do it. This book exceeds the scope of the user’s

manual that comes with the E0, and gives you more information

about how the E0 works and how to maximize its power. You’ll

also find real—life examples of how to use the E0 in your home,

office, and on the road.

Chapters 1-2 are about the EO’s hardware and getting started. It

describes the EO’s physical attributes, technical specifications, and

how to set it up.

Chapters 3—7 are about using the EO’s built~in software. You’ll

find discussions on the EO’s operating system, its major software

packages, and ideas on how you can use the EC).
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Chapters 8—40 explain how the E0 connects you to the rest of the

world using its communications capabilities. You find out how to

fax, send Email, use the cellular phone attachment, and hook the

E0 up to other computers. Also included in the third part will be a

complete troubleshooting guide.

Chapters 11—12 discuss each of the software packages that are

available for the E0 from third-party sources.

flontcmting the Author

BY APPLELINK

kmaki

BY ATM EasvtINK

lkmaki

BY CGMPUSERVE

76120, 2755

Br INTERNET

kinaki@netcorncom
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An Overview

of the E0

 natroducton

One of the things you’ll notice about the E0 is that it is not called a

computer. It is a personal communicator. This does not mean that

it does not perform computing functions, it means that it was

designed first and foremost as a device to enhance and enable per-

son to person communications. It is a cousin to the computer, but

it is more than a computer.

Computers cannot be used as if they were a pad of paper or a Day

Runner. Even the most portable notebook computer cannot easily

be used to take notes at a meeting, conference, or in a class. Every

time a notebook computer is used you have to have at least a seat

so you can hold it in your lap or a surface of some type so you can

open the notebook, start it, and use the keyboard.

The E0 is held in one arm like a pad of paper while you write

directly on the screen. The E0 can be used in any position whether

you are standing up, sitting down, or at a desk. Also, when you use

the E0 you are not placing a barrier between yourself and someone

1
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CHAPTER 1 

else, which is what happens when a notebook computer’s screen

forces its way between the user and anyone in front of them. These

are some of the differences between the E0 and other computers

that make it a personal communicator.

Another aspect of the E0 that differentiates it from traditional

computers is how all the 130’s communications capabilities are

combined in a single unit. With an E0 you have built—in E-mail,

fax, telephone, networking, and data communications capabilities

all in a single unit.

Despite the differences, when talking about the EC), terms like hard-

ware, software, RAM, ROM, and other computer terms are all going

to be used. This is because the E0 uses existing computer technol—

ogy as its base and the features that make the E0 a communicator

are in addition to, not instead of, existing computer technology.

This chapter looks at the physical aspects of the E0. In doing so,

the E0 will be described using the same terms used to describe

computers. The EO’s physical components (disk drives, memory,

etc.) make it easy to discuss it as if it were just a computer—part of

what makes the E0 more than a computer is the fundamental inte—

gration of all its hardware and software.

So as you read this chapter do not be fooled into thinking that the

E0 is just another computer trying to distinguish itself with a new
name. It isn’t.

To find out what the E0 really is we’ll start by looking at the com—

municator’s hardware. The physical attributes of the E0 440 and
880 will be examined. in detail. The EO’s accessories will be dis—

cussed as well. You will also find in this chapter sections that
describe how the E0 works in technical terms.

The EG’s Hardware

EO Inc, makes two personal communicators, the E0 440 and the
E0 880. Both of these communicators are similar and share the

same technology. The E0 440 is the less expensive of the two
machines. It is a bit smaller and lacks some of the features found

Kyocera PX 1046_20
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in the 880. E0 wanted to provide for everyone’s communication

needs, so a range of products is required. Some people are willing

to make the sacrifice on size, weight, and battery life to get the E0

880’s larger screen, backlighting, and more expansion. This is espe-

cially true of corporate customers.

This section will look at both the E0 440 and 880. You will find

descriptions and illustrations of the communicators. A comparison

between the E0 440 and 880 will be covered so you can see exactly

how they differ. And, you will also find a section that briefly
describes the software that comes with both communicators.

A Closer Look at the E0

E0 Inc, makes two personal communicators, the E0 440 and the

E0 880. Both of the communicators are thin rectangular devices

that have small bulges on either side called ears. Figure 1.1 shows
the front view of both the E0 440 and the E0 880.

When using the communicator you write and view all of your

information directly on the 130’s screen. Any function you want

the E0 to perform is done by drawing ”gestures” on the EO’s

screen. A gesture is a special mark that you draw which the E0

interprets as a command to perform a specific task. All commands

such as copying, moving items, opening, and closing documents

are executed in this fashion. (Chapter 3 contains a list of all the

gestures and their meanings.)
 

Figure 1.1  
  

Front View of

(0) the E0

440 and

(10) E0 880

 

   
Kyocera PX 1046_21



Kyocera PX 1046_22

{mm W“:

E 4 i CHAPTER 'lE . . , ,

The pen is stored in a special holder built into the right~hand side

of the E0. Figure 1.2 shows the pen being removed from the slot.

When you write on the screen it will feel like you’re writing on a

piece of paper that is being held in a clipboard. After you’re through

writing, the pen is replaced in its slot until it is needed again.

The EO’s ears give it a very distinctive appearance, and they are

extremely useful. The ears make it easier to hold the E0 while

working on it, and they also contain essential parts of the commu~

nicator. In the right ear there is a microphone and the modem con~

nection. The left ear contains a speaker and has ports for connecting

the E0 to a printer, a keyboard, and to other computers. Whether

you’re left— or right-handed, you have probably had the experience

of holding a clipboard and having your fingers get in the way

while writing. Well, the ears prevent this from being a problem

when you use an E0.

Both of the 1308 run on batteries which are stored in a compart—

ment at the tOp of the E0. Figure 1.3 shows the batteries and

where they are stored.

Figure 1.2

The EO’s pen

 

  
 

Figure 1.3

The EO's

battery

compartment
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he concept at using a computing device with a pen has been around

for a while. But, it has only been recently that the technology has
advanced to a point where pen-based devices are a reality. Using a pen
instead at a keyboard and a mouse is both attractive and at the same time
a bit daunting. We’ve become accustomed to using keyboards and mice

to interact with our computers, and no one really likes to change.

Also, for some people the idea at using gestures is a bit intimidating.
Using a computer with a keyboard and mouse can be hard enough to
learn, but learning how to draw a bunch of gestures and having one’s
handwriting interpreted can seem overwhelming. i know l had some reser—
vations at first.

i have always wanted a device like the E0 where i could write on the
screen and not have to worry about keyboards and mice. i wanted a com
puter to use like l use paper. But when l used the ED for the First time, l
had my doubts about remembering and executing commands with the
pen. i do not memorize commands weli, which is why We never liked
working in the MS-DOS environment, and l was concerned about remem~

bering a bunch of gestures. Also, as i’ll say several times throughout this
book, my handwriting is not neat.

Fortunately, i had nothing to tear. Using the E0 was a unique experi-

encewl was able to quickly iearn the basic set at gestures, and by thinking
about the E0 as a notebook, l was able to quickly learn to use it. Actually,
some at my computer experience was a disadvantage because l wanted to
make comparisons between what l do on the computer and what I was
doing on the EC). You can only make the most out of your EO it you

approach it as something entirely new.

I’ve stopped carrying around my notebook computer, and l foresee the
day when everyone will be using devices like the E0 and we’ll use desk-
top computers rarely and only for special tasks. The EC) tultills the promise
of truly independent computing that was dreamed of when the tirst per—
sonal computers were introduced over ten years ago.

Having the batteries at the top of the E0 rather than the bottom

makes the E0 feel like it is resting in your arm. If the weight of the

batteries were at the bottom you would have to brace the E0

against your hip or chest because it would always feel like it was

Kyocera PX 1046_23
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trying to slip out of your hand. The batteries would be pulling the

E0 down, rather than letting your arm support the communicator.

Across the top of the E0 just above the screen you’ll find a bar that

contains status lights, a contrast bar for adjusting the screen, and
the switch to turn the E0 on and off. There are no switches hidden

along the edges where you could accidentally bump them. The
status bar for each communicator will be described in the section

on each communicator.

Communications Capabilities

The E0 comes with software for fax, electronic mail, cellular phone,

and networking (connecting to an MS—DOS computer) which all

integrates with the EO’s other programs, giving you a system

where all of these components operate together seamlessly. The E0

is a complete communications center allowing you to take your

office with you no matter where you go.

One of the most important hardware components of this mobile

office is the EO’s fax /data modem. Although it is possible to pur—

chase an E0 without its modem, doing so seems to me like pur—

chasing a television without an antenna or cable TV connection.

The EO’s modem is the device that connects your E0 to a phone

line allowing you to send and receive faxes and to access the E—

mail (electronic mail) service that comes with the EO. With the

EO’s modem and. a telephone line you can send and receive faxes

or electronic mail wherever you have access to a phone line.

If you purchase the cellular telephone option you will have a truly

mobile office. The 1305 Cellular option lets you initiate or receive

phone calls, and it integrates with the modem so you can send or

receive from anyplace you happen to be. The Cellular option

attaches to the bottom of the E0 and adds less than a pound in

weight including the telephone handset. Figure 1.4 shows an E0

440 with the Cellular option installed.

Only the E0 communicator provides you with the ability to add a

cellular phone directly to a computing device as an integrated part

of the communicator. Although it is possible to use a cellular phone

with notebook computers, even pen-based computers, one would

Kyocera PX 1046_24
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Figure 1.4

An E0 440

with the

Cellular option  
need a standard cellular phone with additional cables and connec-

tors. Using a cellular phone with another computer presents so

many problems that most people wouldn’t even think about trying

it. It’s hard enough just carrying everything else you need.

Expansion Capabilities

In addition to the E0 being a highly mobile and complete personal

computing solution, it is also expandable. Both the E0 440 and 880

can use PCMCIA cards, and the EC) 880 also has a SCSI port.

(PCMCIA stands for Personal Computer Memory Card international

Association.) The PCMCIA originally set out to develop standards

for using small credit card—sized memory cards, but the interface

that was designed is now being used for modems, hard drives,

solid—state flash disks, and networking cards. PCMCIA cards are

classified as Type I, ll, or III (the classification pertains to the thick-

ness of the card which often impacts the card’s function). Currently

most cards are Type H with hard, drives being available as Type ll
and III cards.

Right now there are two types of PCMCIA cards that can be used

with an BC). One type is a SRAM card which is a memory card that

can be used as a disk drive. SRAM cards usually have a low capac-

ity and are expensive. The other type of card is a silicon disk card

that can also be used as an additional disk drive. The advantage of

the silicon disk card is its data capacity. One company, SunDisk,

makes cards that work with the EC) in capacities of 2.5, 5, 10, and

20 megabytes.

The reason that more cards are not available is because software

needs to be written that will let the E0 recognize the cards and
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utilize their functions. The software that lets the cards be accessed

is usually called a driver. Many vendors are writing drivers right

now so that their cards and other computing devices will work
on the E0.

Other cards that are under development for the PCMCIA slot include

a display pager and network cards. Hopefully, both of these will be

available around the end of the year (1993). With the pager card

you’ll be able to carry it in your pocket like a regular pager, but

when it goes off you’ll insert it into the PCMCIA slot and the E0

will access the pager and display any messages you have received.

The network cards, when they are available, will let you connect an

E0 to an existing Ethernet or Token Ring network so you can share

documents with other users and. maybe even use the network’s

electronic mail system.

The E0 440 has one Type II PCMCIA slot, and the 880 has two.

The E0 880’s two PCMCIA slots will also function as a single

Type III PCMCIA slot. The EC) 880 also has a SCSI port. (SCSI

stands for Small Computer System Interface.) SCSI (pronounced

”scuzzy”) is another industry standard for connecting peripheral

devices to computers. Using the SCSI port, it will be possible to

connect hard drives, scanners, printers, and maybe even other

computers to the E0.

Right now, all that can be attached to the E0 880’s SCSI port are

additional hard drives. Once again, it is not a lack of available
devices that limits what can be connected to the E0 880, but the

availability of drivers. Once companies start writing drivers for

the PenPoint operating system the E0 880 will be able to use these
other devices

The “s Software

All of the EO’s hardware is packed into a device that can weigh

from 2.2 pounds (a standard E0 440) to 5.1 pounds (an E0 880

with the Cellular option) all as a single unit. This is amazing by

itself. But when you consider the software that comes with the E0

and how it all integrates, the E0 Personal Communicator is even

more impressive.
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The E0 has eight megabytes of ROM (Read Only Memory) contain—

ing the operating system and all of the applications that come on the

HO. Eight megabytes is equivalent to five and a half 3.5—inch floppy

disks. The top of the line Macintosh only has two megabytes of

ROM, while most MS-DOS machines only have enough ROM to

make the machine turn itself on—usually about a quarter of a

megabyte. The advantage is speed—computers access data in ROM

much faster than data on a disk. The E0 has enough ROM to hold

everything it needs to run, plus many of the programs you’ll use.

The following is a list of what’s installed in an EO's ROMs:

Clock:+ An accessory so you can quickly get the date and time.

EO Calc A program that lets you work with numbers using a

”columnar pad."

EO Lock A utility that protects an E0 from unauthorized access.

E0 Phone A program that controls the Cellular Option which

can also be used with a standard telephone.

E0 Sound A program that you can use to record and playback
voice notes.

GO Fax The program that sends and receives faxes.

GO Mail The program used to send and, receive Electronic mail

using AT&T EasyLink services.

MiniNotei“ A basic program used to draw simple graphics and

for taking notes that are stored in electronic ink.

MiniTexf" A basic word processing program that has been opti—

mized for pen input.

PenPoint The 130’s operating system. The operating system is all

of the software that makes the E0 function as a computing device.

PenTOPS Networking software that lets you connect to an MS-

DOS machine running PenCentral (also included with the HO).

Personal Perspective A very powerful and complete personal

information manager. It includes a day planner with a calendar

and appointment scheduler, an address book, and a notes register.

Personal Perspective is used to keep track of all your contacts,

manage your time, and keep track of your projects.

* included. with the PenPoint Operating System.
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In addition to the built-in software, you also receive a free AT&T

EasyLink account and the PenCentral networking software when

you purchase an E0. All in all, the E0 is a complete system that

doesn’t require any additional software to be useful as soon as you

plug it in and turn it on. There are only a few computers you can

buy that offer this type of immediate functionality and none that

integrate everything as neatly as the E0.

New Technology
Part of what makes the E0 unique is the new technology that it

uses. Advances in miniaturization, processing chips, and operat-

ing systems are all combined in the BC. This is another reason the

E0 is not just another computer but a Personal Communicator.

Two of the new technologies used in the E0 are AT&T’s Hobbit

RISC processor and (30’s PenPoint operating system.

Both the EC) 440 and the E0 880 use the AT&T Hobbit central pro—

cessing unit or CPU. The CPU is a chip that controls the E0 or any

computing device. The Hobbit is a RISC or Reduced Instruction

Set Computer CPU. The RISC CPU is a new technology that runs

faster than the CPU in other computers. As a matter of fact, the E0

is probably the first computing device to use a RISC CPU. Other

companies are now making RISC CPUs, and they will be used in

other computers and computing devices. But the E0 is one of the

first to utilize this new technology and make it available on the

general market.

AT&T developed the Hobbit chip specifically for use in communi»
cations devices. And the E0 is one of the first devices to use it.

This is the primary reason that all of the EO’s communications

capabilities fit together so nicely. Another reason the E0 works so

well is due to its operating system, PenPoint. An operating system

.is the software that makes a computing device work. Another

example of an operating system is MS—DOS which stands for

Microsoft Disk Operating System.

PenPoint was written by GO, Inc. as an operating system specifi-

cally for pen-based computing systems. There is advantage to hav-
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ing an operating system written specifically for pen—based sys-

tems. PenPoint was designed completely with the idea of pen

input. As such, there is much more thought put into how the users

of the system will interact with the device and how the device will

respond to the user. Every aspect of the operating system is

designed with the user (you) in mind and the fact that the primary

form of interaction with the device will be a pen. GO went to great

lengths to make sure that a device running PenPoint would feel as

if you were working on a real piece of paper.

The PenPoint operating system is discussed in Chapter 3. Discussion

and instruction on using the EO’s built in software, including

MiniNote and MiniText, will be found in Chapters 4 and 5. In

Chapter 2 you will find everything you need to start using an E0

Personal Communicator. The rest of this chapter will look at the
E0 440, 880, and the E0 accessories.

The Technical Spec'fcat‘bns
The E0 440 is the smaller of the two machines. It is a very power—

ful and efficient communications device. If you want a small, easy

to carry, and easy to use communicator with a long battery life,

you couldn’t do better. It is precisely what it claims to be: a per—
sonal communicator.

The E0 880 is larger and heavier than the 440, but it is also faster

and has a larger, backlit screen. If you need an E0 with more

power, an external hard drive option, or to use your E0 with an

external monitor you will be interested in the 880. Besides being a

good personal communicator you can also use it for business pre—

sentations by connecting it to a VGA monitor. Also (I write from

experience), the weight of the E0 880 puts it right at the upper

limit of What is comfortable to carry. Any heavier and it would

probably be uncomfortable.

The following sections cover the really gritty details for both 1303.

If you’re shopping for an E0 maybe the following will help you

make up your mind. If you already own one, then you might want

to know what types of nuts and bolts it contains.
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The E0 440

This section contains a description of the 440’s features. Most of

this section uses computer jargon, so if you need help interpreting

the terms look in the glossary. The EC) 440’s dimensions are:

Length 10.8 inches

Width* 7.1 inches

Heightt .87 inches

Weight 2.2 pounds with batteries and 2.3 pounds with a hard
drive

* The EO’s ears add 2.4 inches to its total width and the height at the top is 1.57
inches.

These dimensions register the ED as one of the smallest, for the

power it packs, personal computing devices you can buy. The E0

440 is a 2.3 pound (including battery) personal communicator that

looks like Figure 1.5.

Figure ‘5 Contrast slider Amber buttery light

The E0 440 Green charging light On/Stondby button
tront View

    
Speaker ‘ A Microphone
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Figure 1.6

The E0 440's

viewed From

the lel't, right,
and bottom.

AN OVERVIEW OF THE E0 

On the front of the 130 you can easily see:

9 On /Standby button

0 Green charging light

6 Speaker

9 Contrast slider

0 Amber battery light

0 Microphone

On the E0 all of the controls have icons like those in Figure 1.5 for

easy identification. All of the EO’s control features are discussed in

Chapter 2.

So you can connect the E0 440 to other computers, phone lines,

printers, and the cellular phone it has the ports and connectors

shown in Figure 1.6.

 

 

 
      

  

 
 
 

Coin cell battery door

Cellular module port

RAM/ROM

PCMCIA 5  
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On the left—hand side of the E0 you will find the following ports
and doors:

9 Power adapter port

° Backup battery door

0 Serial port (also called the PC port)

0 Parallel port (also called the printer port)

6 Keyboard port

On the right hand side of the E0 you will find:

6 Main battery door

0 Phone port (if you have a modem)

9 The pen in its slot

And on the bottom of the E0 you will see the following:

6+ Coin cell battery door

a Wireless port used for the Cellular option (this port is covered)

49 PCMCIA card door

6 RAM and ROM card door

Table 1.1 lists the rest of the E0 440’s technical specifications.

The E0 440 is available in the following configurations (please check

with ED for up—to-date prices):

a 4 MB RAM, no modem, no hard drive

6 4 MB RAM, modem, no hard drive

9 8 MB RAM, modem

a 8 MB RAM, modem, and 20 MB hard drive

° 12 MB RAM, modem, and 20 MB hard drive

The E0 880

The E0 8800 is a 4 pound (including battery) personal communi-

cator that looks like Figure 1.7. The E0 880’s dimensions are:

Length 13.0 inches
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Figure l.7 Green charging light Amber battery light

The E0 880 On/Standby
front view button

 
 Brightness slider Contrast slider

   
 

Speaker Microphone

  
 

Width" 9.0 inches

Height"‘ 1.06 inches

Weight 4.0 pounds with batteries and 4.2 pounds with a hard
drive

’" The 130’s ears add 2.4 inches to its total width and the height at the top is 1.57
inches.

On the front of the E0 you can easily see the following controls

and displays:

9 On/Standby button

0 Green charging light

0 Brightness Slider

0 Speaker

0 Contrast slider
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 9 Table 1.1] [ITheiEo‘Afzgo'is’ te¢hhi¢altispg‘czi'fi‘tafisn; _ * ‘ ‘ ‘ ‘ 1

Microprocessor AT&T 92010 Hobbit 20 MHz RISC based processor.

This processor runs 2.5 times faster than a 20 MHz

3865L CPU and at .7 times the speed of a 33 MHZ
486SX CPU.

Memory RAM 4 megabytes, expandable to 20. Currently

the E0 can only be upgraded to 12

megabytes because the memory cards to

expand it to 20 are not available. RAM

upgrades come on 88 pin JEDEC cards.

ROM 8 megabytes. The ROM are upgradeable
and will be made available as new ver-

sions are developed.

Modern Data High—speed 14,400 bps (38,400 bps with

data compression) internal modem.

Protocols supported are Bell 103, 212,

v.22bis, v.32, v.32bis, v.42, v.42bis, MNP

2-5, MNP10, AXCELL external cell—

phone support.

Fax 9600 bps Group 3 send /receive fax

modem. Supports v.27ter and v.29 pro~
tocols.

Display 7.5 inch diagonal, 640 X 480 pixels, 8 levels of gray,

110 dots per inch, 0.23 dot pitch, high-«contrast

reflective supertwist LCD. The screen response time
is 250 ms and the refresh. rate is 70 Hz.

Internal Storage 20 megabyte internal hard drive. 2.5, 5, 10, and 20

Options megabyte SunDisks.

Power and Operating power 3.3 volts. Custom battery pack

Batteries using NiCad batteries. Standard (2—4 hrs.) and

extended life (4—6 hrs.) batteries are available. The
extended life batteries add about five ounces.

Input/Output Parallel AT 8 bit bi—directional port.

Serial Mini DIN 8 port requires special cable,

maximum speed 230.4 Kbits/ sec.

Keyboard Standard PS/ 2, PC AT keyboard will

work with an adapter.

PCMCIA Two Type II slots that can also be used

as one Type III.
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Figure 1.8

The EO 8805

viewed from

(a) the lett, (l3)

right, and (c)
bottom.

AN OVERVIEW or THE E9

9 Amber battery light

0 Microphone

 

On the E0 all of the controls have icons like those in Figure 1.7 for

easy identification. The 130’s control features are discussed in

Chapter 2.

So you can connect the E0 880 to other computers, phone lines,

printers and the cellular phone it has the ports and connectors

shown in Figure 1.8.

Battery door

 
 

Power

Backup battery

Modem/ Serial port
Phone

Parallel port

Pen in slot

Keyboard port

VGA port  
SCSI port

(covered)

Coin cell

battery door l

PCMClA RAM and

card door ROM card

door

 

Wireless port
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On the left-hand side of the EC) you will find:

9 Power adapter port

0 Backup battery door

0 Serial port (also called the PC port)

0 Parallel port (also called the printer port)

0 Keyboard port

0 VGA port

0 SCSI port

On the right—hand side of the E0 you will find:

0 Main battery door

0 Phone port (if you have a modem)

0 The pen in its slot

And on the bottom of the E0 you will see:

° Coin cell battery door

0 Wireless port used for the Cellular Option (this port is covered)

@ PCMCIA card door

a RAM and ROM card door

Table 1.2 lists the rest of the E0 880’s technical specifications.

The E0 880 is available in the following configurations:

0 4 MB RAM, no modem, no hard drive

6 4 MB RAM, modem, no hard drive

0 8 MB RAM, modem, and 64 MB hard drive

E0 Peripherals and Accessories

There are several ways to accessorize an E0. You might want to

connect a keyboard, use a solid-state flash disk, or even a floppy

disk drive with your EO. This section will look at the peripherals

and accessories you can use with your EO, and it also provides
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 Table 1.2 The EO‘V'880’svteC‘hnicdl spadsfir’dnfi if if; if 

Microprocessor AT&T 92010 Hobbit 30 MHZ RISC—based processor. This

processor runs at 3.5 times faster than a 20 MHZ 386SL

CPU and at the same speed as 33 MHz 486SX CPU.

Memory ILAM 4 megabytes, expandable to 20. Cur—

rently the E0 can only be upgraded to

12 megabytes because the memory

cards to expand it to 20 are not avail—

able. RAM upgrades come on 88 pin

JEDEC cards.

ROM 8 megabytes. The ROM are upgrade—
able and will be made available as new

versions are developed.

Modem Data High-speed 14,400 bps (38,400 bps

with data compression) internal

modem. Protocols supported are Bell
103, 212, v.22bis, v.32, v.32bis, v.42,

v.42bis, MNP 2-5, MNP10, AXCELL

external cellphone support.

Fax 9600 bps Group 3 send/receive fax mo—

dem. Supports v.27ter and v.29 protocols.

Display 9.4 inch diagonal, 640 X 480 pixels, 8 levels of gray, 85

dots per inch, 0.30 dot pitch, transmissive backlit

supertwist LCD. The screen response time is 150 ms
and the refresh rate is 70 Hz.

Internal Storage 64 megabyte internal hard drive. 2.5, 5, 10, and, 20

options megabyte SunDisks.

Power and Operating power 5 volts. Custom battery pack

Batteries using NiCad batteries with a two-hour battery life. 5

Input/Output Parallel AT 8 bit bi—directional port.

Serial Mini DIN 8 port requires special cable, i
maximum speed 230.4 Kbits / sec. 1

Keyboard Standard PS/2, PC AT keyboard will

work with an adapter.

SCSI 50 Pin standard, SCSI l or II port.

VGA Monitor Standard 66 Mhz VGA Port.

PCMCIA Two Type II slots that can also be used

as one Type III.
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some extra information about some of the accessories or peripher—
als that will not be found elsewhere in the book.

Peripherals and Accessories Available
through E0

Several of the accessories and peripherals you can get for an E0

can be obtained directly from E0 lnc., Table 1.3 quickly looks at

the accessories and peripherals that EO sells. The Cellular Module

and SunDisks sold by ED will be discussed in the next section.

Whenever you attach or detach any peripheral or cable to your EO,

you should put it into Standby mode. Although it is possible to

connect devices while the E0 is on, it is not recommended. If you

make a mistake or the pins do not align properly you could short

out the system and damage both the E0 and the peripheral device.

"the Cellular Medule

EO sells the Cellular Module that lets you use the E0 as a cellular

phone. The Cellular Module attaches to the bottom of the EC). The

components of the Cellular Module are shown in Figure 1.9.

The same unit fits on both the E0 440 and the 880. If you’re going

to use the Cellular Module with the E0 you must get an HQ with

the modem. Without the modem the Cellular Option will not

work. The modern uses extensions to v.42 that provide the same

 
 

Figure 1.9 _, r" :k/
The Cellular

Module

\

ATE“ HandsetI,/Kill r

{2

,6?

l////

/,'/
7/; /\t x /K)"

An te n n a

880 antenna extender
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capabilities as MNP 10. MNP 10 is a special error correction proto-

col that is needed when using a modem with a cellular phone, but

EO’s implementation makes it possible to use the Cellular Option

 93 Table {1 3 3 E0 ¢é¢e§ss$ri33andmperipherdlér ‘ V

Keyboard This is a standard PS/2 keyboard that you might

want to use to type documents rather than write
them.

Floppy Disk This is a special 3.5 high—density floppy disk drive

Drive that connects to the E0 through its parallel port. It can

be used to back up your EO’s data and to exchange

documents between you 130 and other computers.

AC Adapter You may want to have an extra AC adapter in case

something happens to the one that comes with the E0.

lt is also handy to have one at home and another in the

office so you don’t have to carry one back and forth.

EC) 440 Standard Extra battery for the E0 440. It never hurts to have an

 
Battery Pack extra battery or two.

E0 440 Extended This is the extended life battery. It weighs about

, Battery Pack twice as much as the regular battery and lasts almost

twice as long.

‘ E0 880 Standard Extra battery for the E0 880. It never hurts to have an

Battery Pack extra battery or two.

Pen Replacement pen in case you want an extra (a very g
good idea) or if you lose or break the one that comes

with the E0. You cannot use the E0 Without a pen,

so you should seriously consider having an extra.

PC Connection This is the cable that is used to connect your E0 to an

Cable lVlS—DOS machine. You might want an extra one for

the office if you have an MS—DOS machine at home
and the office.

Printer Cable Parallel printer cable. Used to connect the E0 to a

parallel printer.

Rugged Case This is a sturdy case to protect your E0 from beating

and banging while you travel.

Shoulder Strap If you are using the E0 in an environment where you

sometimes need both hands, but you also need to

have the EC) handy, you might find the shoulder

strap to be the answer.
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Figure 1.10

Attaching the
Cellular

Module

with a modern without requiring an MNP 10 Modern at the other

end. This is a definite advantage.

When you purchase the Cellular Module you can either have E0

activate the cellular phone service or take the phone to the cellular

service provider of your choice.

To install the Cellular Module:

1.

2.

6.

Put the E0 into Standby.

Remove the cellular port cover from the back of the BC) with a
Small screwdriver.

Attach the handset cradle to the cellular module if you’re

going to use it.

Fit the Cellular Module on the back of the E0 as shown in

Figure 1.10.

Tighten the two top screws with a Philips screwdriver.

Tighten the two lower screws.

Connect the handset.
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One of the options you can get with the Cellular Module is a ”Plan-

tronic Headset.” The headset is a replacement for the Cellular

Module’s handset. The headset allows you to use the phone and.

keep your hands free to use the E0 while talking.

SunDisks

SunDisks are solid-state flash memory modules that work like

large floppies when used with the E0. They install in the EO’s

PCMCIA slot and are automatically recognized by the E0.

SunDisks are made by the SunDisk Corporation in Santa Clara,

California. They are available in 2.5, 5, 10, and 20 megabyte sizes
and available from E0.

SunDisks are a very handy way to store lots of information and

can greatly enhance your EO storage capacity. They are especially

handy if you’re using an E0 440 since it is possible to fill up the 20

megabyte hard disk. SunDisks are also good for exchanging data
with other EC) users.

It is also possible to get a device called a Universal PC Card Drive

that you can attach to a MS-DOS machine which will read a

SunDisk. This makes it easy to exchange large amounts of informa—
tion between the E0 and the MS—DOS machine. The E0 uses a disk

format that is compatible with MS-DOS machines so the SunDisk

with a card reader like the CardPro from DATA l/O will let you

quickly exchange files between the E0 and your desktop computer.

SunDisks are installed in the PCMCIA slot. When installing a

SunDisk you should put the 130 into Standby mode and open the
door on the back of the E0 that covers the PCMCIA slot, then slide

the card into the E0. Figure 1.11 shows a card being put into the
PCMCIA slot.

When you install a card, the top of the card and the top of the E0

always have the same orientation. You cannot put a card in upside

down, but you can get one stuck in the slot by trying. To remove a

PCMCIA card be sure to put the E0 into Standby mode. You will

have to push the button to the left of the card. The button ejects the

cards. Once the card is loose you will be able to slide it out by

grasping the card at the edges and pulling.
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Figure Ll l

The PCMCIA

slot with a

card  
Peripherals Used with E0 880

The E0 880 has the ability to use a couple of peripherals that the
440 cannot. An external VGA monitor and hard drives can be con—

nected to the E0 880. In this section, use of these peripherals will

be discussed and will include some instructions that you will not
find elsewhere in the book.

Disk Drives (E0 880 only)

External. disk drives are connected to the E0 880 using its SCSI

port. The ability to quickly and easily connect external disk drives

can greatly enhance an, EO’s storage capacity. The SCSI port sup—

ports both SCSI I and II devices, so the 880 should be compatible

with any SCSI drive. Most of the external SCSI hard drives you’ll

find in the marketplace are intended for Macintosh use, but any of

these drives will work on the EC) 880. The only difference between

using a SCSI drive on an E0 rather than a Macintosh is the disks

format. The EC) uses MS—DOS formatted disks, so if you purchase

a Mac drive that you will be using with the E0 the drive will have

to be reformatted. If you want to use a SCSI drive to exchange data

with a Macintosh, you will have to use one of the removable

media hard drives described in Chapter 7 and get special software

for your Macintosh.

NOI'e Do not attach an external Macintosh drive to the E0 880 if it has
data on it that you want to save. The E0 will want to reformat the
Mac drive and all of the data will be destroyed.

When you attach a SCSI disk to your EO there are a few rules you

need to keep in mind. If you have any questions about the process
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of connecting a SCSI drive to your EO, contact the drives manu—

facturer before you proceed. The rules pertaining to SCSI are the
same for any computer system and standard. The E0 880 follows

all of the basic rules regarding SCSI connections which are:

0 The first and last SCSI device on a SCSI chain must be termi~

nated. The E0 as the first device is terminated.

0 Each SCSI device must have a unique identification number

between zero and seven. The 130 will always be the first device

and its internal hard drive is SCSI device zero, and the E0 is

SCSI device seven.

0 If you are using a SCSI disk that has been connected to an MS—

DOS, computer you will have to label the disk before it will

appear as a bookshelf on the E0. (See Chapters 3 and 7 for

more information.)

0 Always put the E0 into Standby mode when connecting and

disconnecting external SCSI drives.

The E0 880 has a standard 50 pin SCSI connector on its left—hand

side. The drive you use can have either a 25 or 50 SCSI connector.

Usually, most external SCSI drives have two connectors of the

same type, and it does not matter which connector you use. The

second connector on a SCSI drive permits you to attach more SCSI

devices. Whenever you attach SCSI devices you have what is

called a daisy or SCSI chain.

If you are unsure about how to connect a SCSI drive, whether or

not it is terminated, or the drive’s SCSI ID number, you should

contact the drive’s manufacturer before connecting it to an E0 880.

If you improperly connect a SCSI device to the E0 it is possible to

damage both the E0 and the device. After attaching the drive and

turning on the E0 it will recognize any formatted. MS—DOS disk or

ask to format the attached drive. If you are using an MS~DOS for—

matted disk and it does not appear on the 1305 Bookshelf, this is

because it does not have a label. You can give the disk a label from

the Connections accessory (see Chapter 7 or your E0 manual).

Monitors (E0 880 only)

You may want to connect an E0 880 to an external VGA monitor

for demonstrations, or you may find that while working at a desk

Kyocera PX 1046_43



Kyocera PX 1046_44

CHAPTER “I 

using an external monitor is more comfortable. Regardless of why

you would use an external monitor it is a nice option to have.

Attaching an external monitor to the EC) 880 is a fairly simple

matter. But it is not quite a matter of connecting the E0 and turn-

ing it on.

To connect a monitor to your E0:

1. Put the EC) into Standby mode (see Chapter 2).

2. Connect the E0 to the monitor. (The VGA port is in the left-

hand side of the E0.)

3. Turn the E0 back on.

4. Set the EO’s screen orientation if the image is horizontal rather

than vertical, or place the monitor on its side so you can View

the screen properly. Change the orientation of the EO’s screen

with the Font & Layout page in the Settings Notebook (see

Chapter 4). The E0 has the same screen dimensions as a stan—

dard VGA monitor, except that the EO’s screen is usually set to

View the screen in a portrait View rather than a landscape View.

All MS—DOS machines use their monitors with a landscape
View.

5. Turn on the Pen Cursor in the Fonts & Layout page of the Set—

tings Notebook. (This is especially important when you’re giv—

ing a presentation This way your audience can see where the

pen is.)

6. Align the pen in the Pen page of the Settings Notebook. (The

pen should always be realigned after changing orientation or

turning the pen cursor on or off.)

The screen on the E0 880 remains active when it is connected to

an external monitor. So you can still use the pen on the E0. You

will see any action performed on the E0 on the external monitor.
Also, because the connectors for the VGA monitor are on the left—

hand side of the E0, you may want to make the left-hand side of

the E0 the top of your screen so you can have the E0 on your

desk with all of the connection cables facing away from you. Also

by doing this you will not have to set the monitor on its side. This
should make the E0 easier to use while it is connected to the

external monitor.
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The image you will see on the monitor will be in black and white

with eight levels of gray. For now, PenPoint does not use color on

the E0 or when it is connected to a color monitor. So if you are

going to purchase a monitor just to use with the EC), you might

consider saving some money and getting a black and white VGA

monitor rather than a color one. The only caveat is that PenPoint

will probably support color in a future upgrade, at which time you

may want to use the E0 880 with a color monitor.

Mantenance, Upgrades, and Caveats

All of the tools we use usually require some type of maintenance,

even if it’s just cleaning. The E0 is no different. It needs to be

cared for, or it will not work properly. This section will look at tak—

ing care of the EO’S hardware, what conditions you might want to

avoid, and some general suggestions that might make life with the
E0 easier.

Battery Maintenance

The EO’s main power source is its batteries. If you do not properly

recharge, remove, or install the batteries your EO will not work as

expected. The following is a list of tips that will keep you out of

trouble and help you get the most from the EO’s batteries.

a Make sure the back—up batteries are installed.

3 Always put the E0 into Standby before removing the main bat-

tery.

e The EC) will only charge the main battery while the E0 is in

Standby mode.

m If you see a warning saying that the back—up batteries are low,

replace them as soon as possible.

9 When the E0 is not being used, let it automatically go into or

put it into Standby to keep the batteries charged.

0 Batteries Will recharge in 90 minutes.

The main batteries will not last forever. After they have been dis-

charged and recharged around 400 times the battery life Will

decrease gradually over time (starting at around 400 full charge
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cycles). If you note the battery’s life decreasing after a year or so of

use, you may want to get a new battery. To make sure you get the

longest possible life and operating time from the EO’s battery you

should completely discharge the battery at least once a month by

using it Lmtil the E0 goes into Standby mode.

Also, when recharging the battery try to completely charge it. If

you consistently charge the battery so it only has a partial charge,

you could shorten the battery life. Also, extreme temperatures can

effect how long the battery will run the BC. In a cold environment

battery life will be shorter.

The E0 also uses two lithium batteries to keep the EO’s RAM intact

when the main battery runs out of power. The life expectancy of

these batteries depends entirely on how you use your 130. If you

put the E0 into Standby and do not plug it in, the 1305 RAM will

remain intact for about two weeks, provided the main battery is

fully charged. At the end of the two weeks (or thereabouts) both of

the lithium batteries and the main battery will be dead and the con~

tents of the EO’s RAM will go to lost data heaven.

N0l'e In any case, it is not a good idea to leave the E0 unplugged for
days at a time (unless you’ve backed up our data and shut the
machine down by removing the batteries}. i you are leaving for sev-
eral days, leave the E0 plugged in to avoid losing data.

If your backup batteries need to be changed the EC) will tell you

so. Do not ignore this message. When you see it replace the back—

up batteries as soon as possible. You will need to get a battery with

part number CR123A which you should be able to find at a photo

or electronics shop.

The EC) also has a small coin cell battery that maintains EO’s clock

and parameter RAM settings. It is accessed from the back of the

E0 as shown in Figure 1.12.

It should be good for two to three years, but eventually it will

need to be replaced. To replace the coin cell battery you should

only use a battery with part number CR2032. See your EO’s man-

ual for replacement instructions.
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Figure 1.12

The coin cell

battery

RAM and ROM Cards

The EO’s RAM and ROMs are upgradeable. They are both on cards

which are accessible through a door on the back of the E0. Figure
1.13 shows the door and slots for the RAM and ROM cards.

Before performing either a RAM or ROM upgrade you should

always back up your information (see Chapter 7).

T0 upgrade your RAM:

1. Shut down the E0. The easiest way to perform a shutdown is

to use the Shutdown button on the Power page in the Settings

Notebook (see Chapter 4). If you are using a RAM—based sys—

tem you will have to remove both the back—up and main batter—

ies. Do not leave the AC adapter plugged in while upgrading
the RAM.

2. Remove the old RAM card (if your EO has one). The RAM card
is the card closest to the bottom of the E0.

Figure 1.13

Door and slots

for the RAM

and ROM

cords  
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3. Insert the new card.

4. If you have a RAM only system reinstall the back-up batteries,

plug in the EO’s power adapter, and install the main battery.

5. Turn the E0 back on.

When your EO reboots you’ll have additional RAM for running

your programs. A ROM upgrade can be more problematic. When

you upgrade the ROM you will have to reformat the EO’s internal

hard drive. This means that all of your data and any applications

you’ve installed will be lost. So do not try to do a ROM upgrade

while on the run. It is a procedure that will take some time.

To upgrade a ROM:

1. Shut down the E0. The easiest way to perform a shutdown is to

use the Shutdown button on the Power page in the Settings

Notebook (see Chapter 4). If you are using a RAM-based system

you will have to remove both the backup and main batteries. Do

not leave the AC Adapter plugged in while upgrading the RAM.

2. Remove the old ROM card (if your EO has one). The ROM

card is the card closest to the top of the EO.

Insert the new card.DJ

4. If you have a RAM only system reinstall the back-up batteries,

plug in the EO’s power adapter, and install the main battery.

5. If you have a RAM only system start the EO as you normally
would

Or

If you have a hard drive you will have to perform a ROM—only

boot and format the EO’s hard disk (see Chapter 10 for instruc'

tions for reformatting an internal hard disk).

6. Restart the EO.

7. Restore your information and reinstall your programs.

Once the ROMS have been upgraded you’ll have access to the new

features that a ROM upgrade makes available. EO built their per—

sonal communicators with the intent of providing ROM upgrades.

You can figure that ROM upgrades will be available about once a

year. There will be a charge for the new ROMs.
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Caring For Your E0

This is the section with all of the dos and the don’ts. There is always

a set of standard warnings that accompany any computing device.

Most people, especially experienced computer users, have a ten—

dency to ignore these warnings. What I’m trying to say here is that

although the cautions listed may seem like they are either a pain in

the neck or just plain common sense and too silly to be mentioned,

they all have a purpose and if nothing else can serve as reminders.

They are meant to protect your EC) from damage.

0 Always detach cables by pulling on the plug. Do not pull on the

cord to disconnect a cable.

0 Use a grounded power source. A grounded power source is

usually a plug with three prongs. However, not all three prong

plugs are grounded. If you have any doubts about the plug

being grounded check with an, electrician. A grounded plug

will help protect your EO if there should be power surge. If you

use a non-grounded plug and experience a power surge, the

extra power, instead of going down the grounded wire, will

make a home in the E0, possibly burning it out.

9 Keep cables in a safe location where they will not be pulled or

accidentally tripped over. If someone should catch one of the

cords attached to your EO as they are walking by, the E0 could

end up on the floor. The person could, also.

9 The EC) generates some heat so you need enough space for air

to circulate around the E0. Don’t bury it in paper on your desk

or stack books on top of it. Not only can you not use it while it

is buried, but anything stacked on top of it prevents the air

from circulating. If the EC) is consistently too hot it will shorten

the life of its internal components.

0 Don’t leave the E0 in direct sunlight. This will cause it get too

hot. Also try to avoid situations where it is left on the dash of a.

car, in an enclosed car, or in the trunk. Any of these places can

get very hot if the car is left in direct sun light.

0 Just as you don’t want to leave the E0 in the sun you also

should be careful when taking the E0 from places where there

are temperature extremes. Taking the EC) from a warm environ—

ment to a cool one can cause condensation inside the E0. If you

turn the E0 on with condensation inside it, it is possible for the
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E0 to short. In the same way that violinists let their instruments

adjust to room temperature before tuning them, you should

give the E0 ten minutes or so to adjust and acclimate to its new

environment before turning it on.

In the same vein, changes in humidity can also cause problems

similar to those in the last warning. If you ever notice conden—

sation on the outside of the E0 you can bet there is some inside.

Also, if you think there might be condensation inside the E0

don’t turn it on until the condensation has had an opportunity

to evaporate.

0 Do not open the E0. Yes, it possible to open the E0. If you do,

though, you will void the warranty. There is nothing inside but

a bunch of little black chips soldered to a printed circuit board.

And although they may look nice, there is nothing you can do

with them. If your E0 is not working properly, call EO Technical

Support.

Remember, opening your EO will void the warranty.

3 Avoid dropping anything on the screen. The screen is made of

tempered glass that is designed to survive mishaps. But it is not

indestructible. If you should drop your coffee cup on the screen

you will probably break the screen, not to mention giving your

130 an unhealthy drink. If the screen should crack or break it

will have to be replaced.

6 Avoid dropping the pen. If the tip gets broken it will not work.

It is the tip of the pen that works the magic on the EO’s screen.

Having a second pen as a backup is a very good idea.

a Don’t drop or bang the E0 around. The E0 has been thor~

oughly tested and can stand some banging and bumping. But,

it is not indestructible. If it should be dropped it can break. It is

possible to break the screen, crack the case, or damage its inter-

nal components. You should treat it with care. If you are in a sit—

uation where you might drop it, get the shoulder strap from

BC). This way if you should drop it, the strap can prevent it

from hitting the ground. '

0 Keep your E0 in as clean an environment as possible. Because

the E0 is an electronic device, dust has a nasty habit of sticking

to it. Also, don’t keep the EC) where you might spill food or

beverages on it.
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Cleaning Your E0

The E0 comes with a slip case that will protect it and keep it clean

when it is not in use. And if you use the slip case you will not have

to clean the 130 very often. However, the slip case can also be a

pain in the neck. I personally don’t use the slip case. The result is

that my EO often gets dirty and needs to be cleaned.

EO Inc., recommends that you use a cloth dampened with water to

clean the E0. Always put the E0 into Standby, unplug it, and

remove the battery before cleaning. Never put water directly on the

E0. Do not ever spray any cleaner, either aerosol or liquid, onto

the E0. Also, cleaners can damage the paint on the EO’s case.

Although the following cleaning technique is not recommended

nor condoned by EC (in other words use it at your own risk) I

have found that it works well on my EO. Use a lint free cloth and

spray some Windex or other mild window cleaner onto the cloth.

Then put the E0 into Standby, unplug it, and remove the battery.

Now wipe it down with the cloth. Remember, this is a technique

you use at your own risk.

Traveling with Your E0

The E0 Personal Communicator is meant to travel with you and

no doubt it will. When traveling you should add the following list
to the one above.

9 Carry the AC adapter. You’ll need to recharge the batteries. If

you forget your AC adapter you’ll find that your EO will

quickly become extra baggage. Never mind not being able to

access your information.

0 Do not run the 130 through the X—ray machine. Technically the

X—rays cannot hurt the E0, but some of the newer airport scan—

ning machines are magnetic scanners not X-rays. And magnetic

scanners can cause problems. Because the E0 is small and easy

to start up carry it through and have it physically inspected.

0 Do not check the E0 as luggage. Luggage handlers are equal

opportunity abusers, they don’t care what the bag looks like or

what it contains. If you check the E0 as luggage you should
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expect it to be returned in pieces. Also, how many times has

your luggage been lost?

' Do not put the E0 in overhead storage compartments when on

airplanes. Store it under your seat in your briefcase or whatever

bag you carry it in. Placing the E0 in the storage compartment

could result in it being damaged, especially if the plane should

fly through heavy turbulence. Putting the E0 in the storage com—

partment would be like sticking it in a box and shaking the box.

0 Turn the Cellular Module off and do not open the E0 Phone

Notebook while in the airplane. It is against FAA regulations to

use a cellular phone while on a commercial airline. It is really

important that you check the E0 before the plane takes off. It

would be real easy to leave the Cellular Module on and the

FAA does not take kindly to even accidental violations of their

regulations. Really, this is important, tum oflthe phone!

Comiusiaa

This chapter was only an overview of the EO’s physical attributes.

There is very little information about how the EC) works in this

chapter. The next three chapters will cover the basics for using an

EC). After you’ve looked over the next few chapters you might

want to come back and review this chapter.

Even though this chapter is about the hardware, it does contain a

lot of information that you will need to get the most from an E0.

So at some point take the time to reread it. You just might find

something that will make your EO more useful and increase your

productivity.
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Getting Ready
to Trayel

lntroduetion

My wife is not usually interested in the toys I bring home. I’ll set

up a new system and show it to her and she’ll say ”That’s nice” or

something equally enthusiastic. It’s not that she doesn’t care,

rather she works with computers all day and for her work is work

and computers belong at work. So when she is at home, unless

she can play a game on the computer she doesn’t want anything
to do with it.

So when I brought home an E0 I figured she would look at it and

say ”That’s interesting,” give it back to me, and continue doing

whatever she was doing. I was wrong. When I came home with an
EC) 440 Personal Communicator all I had done with it was look at

it for a few minutes. She took the Communicator, sat down, and

would not give it back to me. In about five minutes she was using
it to look at the tutorial and within an hour was able to use it. Now

I have to hide the communicator. It has become indispensable for a

lot of my work and I’m afraid she might run off with it. Then I’d

really be in trouble.

35
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Preparing an ED for use is a very straightforward process. All you

have to do is install the batteries and plug it in. Then you should

spend about fifteen minutes with the tutorial, after which you will

know enough to begin entering data. After a couple of hours, you

will have either imported all of your names and addresses from a

desktop computer into your E0, or you will have begun the

process of entering names and addresses, birthdays, and notes.

Within a couple of days your EO will have integrated itself into

your daily life, having become an indispensable tool.

This section will describe the process of taking the E0 from its

box, setting it up, and getting familiar with the 130’s features. You

will learn about the interface, how to customize the EO’s settings,

and how to use the pen and enter data. Everything you need to get

started is in this chapter.

The Initial Setup

You should already be familiar with the basic EO Communicator

from Chapter 1. If you have not read Chapter 1, go ahead and

open the box and review Chapter 1 with the E0 in front of you.

After you’re familiar with the Communicator and have found the

stylus (pen) you will be ready to start. This section will take you

through the process of opening the box, installing the batteries,

and starting your EO.

When You Open the Box

Once you open the box you will see the EC) Communicator in a

form—fitted bed of foam rubber inside an anti—static bag (a plastic

bag that protects electronic components and devices from static

electricity). Under the EC) is another box that contains all of the
EO’s accessories.

Getting the accessory box out of the main box can be tricky At the

top of the accessory box you will see two round holes. These are

not breathing holes for some small animal, rather they are finger

holes. To remove the accessory box, put your thumb and forefinger

into the holes and lift up the top of the box. The rest will follow.

Once you have the accessory box out you’re on your own again.
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Inside the accessory box you should find the following:

0 A slip cover for the E0 Communicator

‘9 A large battery

0 Two small batteries

0 Three instruction manuals: ”Getting Started,” ”Lookup Guide,”

and. ”The World of Messaging”

0 The AC adapter and power cable

0 A serial cable, also called the PC connection cable

0 A telephone cable (if you got an BC) with a built in modem)

0 A telephone duplex jack

0 A D1325 to DB9 serial connection converter

° An EO Utility Disk

If any of these items are missing, contact 130 Inc., so you can com—

plete your accessory kit. Just one more hint. After you have emp~

tied the accessories box, to put it back into the main box you need

to insert the accessories box into the main box at a 45—degree angle,

putting in the bottom first and then the top.

Plugging in and Turning on Your EQ

To plug in your AC adapter, you need to connect the power cable

to the adapter. The power cable has a three—prong plug that

requires a grounded AC power receptacle. The other end of the

power cable plugs into the AC adapter. The AC adapter has a

cable attached with a round plug that has three prongs inside the

connector. The casing of the connector is round with a flat side.

The power port on the EC) is next to the lithium battery cover.

When you insert the AC adapter cable, the flat side of the connec~

tor casing faces the back of the E0. Having a flat side on the con-

nector cable makes it easy to quickly plug the cable into the E0

because you do not have to fumble with the cable, twisting it until

it fits. As soon as you plug in your EO it will start. Install the bat—

teries when the E0 is in its Standby mode. (Standby mode is dis-

cussed later in this chapter.)
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The startup process takes about three minutes. While the E0 starts

up, you will see the E0 logo at the bottom of the screen and a pen

across the middle. The pen shows the startup processes by appear-

ing to fill up with ink as the E0 starts. Once the pen fills, your EC)

will have started and you will see a notebook screen like the one in

Figure 2.1.

To turn off your E0, depress the On /Standby button at the top of

the screen. This will place your E0 into its Standby mode (see

Fig. 2.2). If the E0 is on When you press the Standby button, it

will go into its Standby mode. Conversely, if you press the button

while the E0 is in Standby, it will. immediately come to life. Once

you have started the E0 and put it into Standby, you can install
the batteries.

 

Figure 2.1 i/‘/ Notebook: Contents < l
Dr:«:'imer;t Edit Cations it“ Create

The notebook ; L i . _ ‘
t Miami Darje-

screen L? Tap Page 2 For Tutorial ................................... 2
1 [21 Personal Perspective . . 13

i .x: Day-'F'iaririer . , .. . . . .. . Mi
'i5

i8  

  
  

Figure 2,2 Power light On/Stondby Battery Back light On/Stondby

The button light brightness slider button
Contrast

Orr/Standby slider
bufion
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installing the batteries

In the list on page 37 you will notice the E0 has three batteries you

need to install: two small lithium batteries and a larger recharge—

able NiCad (Nickel Cadmium) battery The two lithium batteries

are backup batteries that provide just enough power to maintain

your data when the rechargeable battery can no longer run your

EO. Figure 2.3 shows these batteries. The odd-looking battery is
the NiCad; the two smaller ones are the lithium batteries.

If you hold your EO so the end with the wedge is facing away

from you and the screen is face up, you will find a small round

cover about the size of a dime (see Fig. 2.4) on the left side of the

E0 at the bottom of the wedge. This cover slides off by placing

your thumb on the cover and sliding it toward the back of the E0.

Once the cover is off, place both of the lithium batteries into the

opening with the positive ends facing the opening or up. Now

replace the battery cover.

Nate Unless you know beyond a shadow ofa doubt that the main NiCad
battery is fully charged, do not install the batteries without plugging
in your EO first. Also, do not pull the batteries out of the EC unless it
is in Standby mode, otherwise you could lose all ofyour information

 

Figure 2.3

The EO's

batteries
 

Figure 2.4

The battery
cover for the

lithium

  

batteries

 
AC adapter Lithium battery cover
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On the opposite side of your E0, on the wedge, you will find the

cover for the NiCad battery (see Fig. 2.5). This cover is the same

shape and size as the wedge at the top of the E0. In the center of

the battery cover is an oval sliding button. To release the clasp that

holds the battery cover on you need to slide the button toward the

top of the E0 and hold it while sliding the cover toward the back

of the machine (remember the back is the side opposite the screen).

Slide the cover firmly but do not force it. Once you get the cover

off, you should put it back on and take it off a couple of times to

get familiar with how it operates. It is a little more difficult to

remove once you have installed the battery, but it loosens up after

it has been removed and put back on a few times.

To install the battery just slide it into the opening. There is only

one way it can fit, that is with the longest edge of the battery fac—

ing the top of the 130. Once the battery is in, you will have to hold

it down and slide the cover back on. When you have put the bat—

tery cover back on, make sure the button lock is in the down posi—

tion as shown in Figure 2.5.

"E'he EO’s Power Modes

Once you have installed the batteries your E0 is never really

turned off, it will either be on or in a Standby mode unless you

deliberately shut it down. (Shutting down your EO will be dis1

cussed later in this chapter). When the AC adapter cable is plugged

in, the battery light (the small round light on the upper left of the

EO’s face, with a plug icon below it) should blink on and off.

Charging the battery with the EO in Standby mode will take 90

minutes. To charge your battery your EO must be in Standby

Figure 2.5

The battery
cover for the

NiCod battery  Cover release
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The AC light is: The EC) is:  

 

 

 

On on and running off of the AC adapter

Blinking off and the battery is charging

Off off and the battery is charged or the E0 is on

and running off of the battery

mode or shutdown. The EO’s battery does not trickle charge while

the E0 is in use. Therefore, make sure you turn it off for 90 min—

utes before you go on the road, otherwise you could find yourself

out of juice before you make it to the freeway.

While the E0 is plugged in and in Standby, the blinking light

means that the battery is charging. When the light stops blinking

your battery is fully charged and the light will go off. The AC light

also remains off when your E0 is turned on and you are running

from the battery. Finally, the AC light is on when your EC) is on

and the AC adapter is plugged in. If you’re a little confused, check
out Table 2.1.

Up and Runawng
As mentioned above, when you first start your E0 you will see a

screen like the one in Figure 2.4. However, before we start using

the E0 you need to understand the EO’s various screen elements.

What you are looking at is called a notebook. A notebook can be

equated to a directory (if you are familiar with D08) or a folder

(for those of you with Macintosh experience). But these associa—

tions are only approximations.

EO’s Notebook is a metaphor, meant to represent a physical note—

book. It is a container that holds documents you create, but it is a

smart container. Figure 2.6 shows the default Notebook with each
of its elements noted.

The Notebook is a smart container because it automatically orga-

nizes your documents and provides easy access to what you need.

The Notebook would not be very useful unless you could quickly
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Figure 2.6 C/l Notebook: Contents
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and easily access its contents, so you should review the ”Explanation

of the Notebook’s Elements” on pages 44 and 45 and familiarize

yourself with the Notebook’s elements. Otherwise you might find

it difficult to understand what I’m talking about as this chapter

proceeds.

Under the Notebook you will see a series of icons across the bottom

of the screen (see Fig. 2.7). Each of these icons represents a special

purpose PenPoint notebook. (PenPoint is the E0 operating system.)
Under each icon is the name of the notebook. The notebook named

Notebook is the default Notebook shown in Figure 2.7. The area of

the screen that displays these notebooks is called a bookshelf

NQTE The rest of this section is designed to get you up and running, that is
using your EO, as fast as possible. The approach used is s stematic
and will build a foundation you can use to get the most rom your
EO. It is highly recommended that you fully understand this section
before continuing. This is information ou will need throughout the
rest of the book. Also, this section wifl/ provide you with the basic
terms and techniques used for all of the subsequent procedures dis-
cussed in the book.
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Figure 2.7

Them,“ E0 ‘3 «l o : a a o o o
Help Setting: Stationery Hooeszaoriea hit-cu (Hotbox; EC! Phone Notebook Business

bookshelf

Your First Taps

If you have not yet found the pen, it is located on the right-hand

side of the E0, inserted with the point just under the ear and the

top of the stylus at the bottom of the E0. When you are not using

the pen, put it back in its holder. This is especially true if you have

a habit of misplacing your pen or pencil. Without the pen you can-

not use your E0.

1 would strongly recommend you consider getting a second pen so

you have an extra one in case you lose or break the one you nor-

mally use. Once you start using your EO you will quickly become

dependent on it and being unable to use it could be more than an
inconvenience, it could be a disaster.

If you have not already done so, remove the pen from its hiding

place. You’ll use the pen for everything—entering data and com—

municating with your E0. When you are giving your EO com.-

mands, you will do so by tapping or by drawing gestures on the

screen in a specific manner, at specific locations. The primary

means of giving a command is called a tap, which will be anno-

tated with the following symbol Y. A tap is a quick action where
you touch the tip of the stylus to a specific spot in the screen. The

motion is very much like dotting an i or placing a period at the

end of sentence when writing on a piece of paper.

For the next few minutes the tap is the only gesture you are going

to use. If you tap or gesture in such a manner that the E0 does not

recognize you will see a starburst like this —>';<—. This is how the E0

talks back to you, it will either perform the requested action or you

will see the starburst. To begin, be very deliberate and do not get

frustrated and start tapping all over the screen. If you start tapping

all over without knowing why you are tapping or where you are

tapping you could quickly become lost and have several windows

or notebooks open at the same time.
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Some of these explanations include topics that have not been coveredyet. Don’t worry——-l simply want to introduce the most important ideas
and concepts that you will be using with your EO. Most of these concepts
will be used in this chapter and throughout the remainder of the book.

Close corner The area you tap V to close a notebook. When you are
working in a notebook, it you tap the close corner you will close the note-
book. ll you are working on a document and close the notebook, you will
also be closing your document. it you accidentally close it, top V on it and
it will reopen.

Contents Page A contents page tells you what is in a notebook. Each
notebook has 0 contents page. Also, each section page is 0 contents page
that details what is contained within a particular section.

 
l Stork Margin The Cork Margin is the area at the bottom at a page
E where you can embed documents and accessories so they are always
i available while you are using a specific page.

 
Documents These are the data tiles you create and use. A document is
normally kept in a notebook. Within the Notebook you may want to keep
your documents in sections so that your work and data can be grouped in
an order that is logical tor you.

 

 
lean Each type of document has a unique icon. By viewing your docu—
ments with their icons you can tell whether a document is a MiniText or
MiniNote tile. Tapping Von the icon will turn to the document associated
with the icon. Double tapping V on the icon will cause the document to
open in its own llloating page. Causing a document to Float is like tearing
a piece of paper from a notebook so you can work with it. lcons are also
used to represent tools in documents.

 

 
 

labels The label is the heading at the top of the contents page in the 3
notebook. iust beneath the menu line. The label details the visible elements

 
  

To get accustomed to tapping, tap Y in the close corner of the
Notebook window (see Fig. 2.8).

If you properly closed the notebook your screen will look some

thing like Figure 2.9.
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such as name, size, and page number tor each section and document con-
tained in a contents page.

Menu line The Menu line is where you will tind groups of commands
contained in a list that drops down when a menu name is topped The

Menu tine contains commands that apply to the document and/or the pro—
gram you are currently viewing or using.

Page number Every document and section contained in 0 Notebook

has a page number. The first page of any notebook is the main contents
page and is page number i. Page numbers can be reordered by moving
documents from one section to another or moving them around within the
same section. The page number is always visible in 0 contents page. By
tapping on a page number you will go to the document associated with
that page number. On either side at the page number in the Title line you
will see an arrow, < or >. By tapping on an arrow, you will move one
page in the direction the arrow is pointing.

Resize handles The resize handles are at the bottom center and bot

tom right-hand corner of a notebook or document window. By selecting a
resize handle and moving the pen, you can change the height and width
at a notebook or a document.

Sections A section is like a subdirectory on a computer, or a divider in a
physical notebook: it is a container tor holding documents within a note
book. Creating a section is like inserting a divider into a threering notebook.

Tabs A tab is used as a means for quickly switching from one docu-
ment to another within a notebook. The tab is very much like a divider tab

in a three ring or spirai notebook. Tabs can be set for any page.

Title line The Title line tells you the name of the document you are look—
ing at or working on. You can also execute specific functions by drawing
the appropriate gestures in the Titie tine.

 
 

Now tap Y the Notebook icon, and the default Notebook will open.

NOTE The first tendency most peop/e have is to double-tap an icon or other
screen e/ement. {This is especial/y true if you are used to using a
Macintosh or MS—DOS computer with Windows.) Almost a// com—
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Figure 2.8

Closing a
window

Figure 2.9

The E0 screen
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Close Window :1 M-‘v‘elcome: Tap Page 3 to Ellen ............................... 13:

:l "rapping with the Pen ............................................... 4
D "he Notebook ...................................................... 5

[j "urning Pages . .. . ..... 6

:l Collapsing 8: Expanding Sections .............................. 7 0'

:l Creating Documents _. ,. .. , .. , 8 g
:l Renaming Documents .. . .. ., ., ,c . . ,. .. 9 ,9:

3 Deletlng Documents ............................................... 10 El

1 Scrolling ..... ,V . ,, V ,. ....V m 11 g:
l: Learning More 12 33

 

  
 

 a 4005seeipp'v‘l.1 
 

rfi Perspective 13 Shot

‘2‘ «ll El 35 i. s. to El [l
Help Settings Stationery #3.C::ea:z~:orie:52 Innis: [Butts-co; ECI F'hone [Slotetnools Business

monds are delivered with a single top or esture. Double—topping has
a specific meaning and purpose which wi I be discussed later on.

looking through the tutorial

Now that you have the Notebook open again, tap on the number

two (2) under the label Page. When you do this, you will go to page

two of the notebook and see a window like the one in Figure 2.10.

The tutorial consists of ten pages, 3 through 12, and the tutorial is

a quick overview of the EO’s operating procedures. It is one place

where you can get the basic operating concepts and procedures

presented in an orderly fashion and practice using these proce-
dures in a safe environment. The tutorial takes about 15 minutes to
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figure 2- 1 0 3/ t-Jotebook: Tap Page 2 For Tutorial 3 ~

3 Daturem Etli‘ Ofifiors "r‘lev».-' Cred;
The contents “ ” ‘ ’ " ’ ‘ a"

page For the 1 \v’v‘elcorre: TapPage E: to Start , ‘3
tutorial :1 Tappingwith the Pen ‘ ., V. . 4

7‘ The Notebook r1 — r
lumm 3 F ........................ L

n Collapsing y. _,t;:xai'|::ilng Sedims . ,_ H , 7 .1
1 CreatingDocuments ,. V i ,. . ........ E :3:
1 Renaming Doom‘nents V ... . .i ,.. Q 3

I DeletingDocumerLs: . _. 1:3 ,W _ .
scrolling . , ,, _, .,. Mm

Leamlngl'aflcn‘e .W , 12

  

complete, after which you will have covered the basics for using

your E0.

The tutorial will, teach you:

e How to move through a notebook by using the page number

is? Tapping with the pen and opening documents

9 Using Notebook Tabs

9 Expanding and collapsing sections

9 Creating documents

W Renaming documents

@ Deleting documents

6 Scrolling

6 Learning more

As you go through the tutorial, remember that many of the concepts

associated with editing apply to working within documents, not

just the contents page of a notebook or section. This is especially
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true of the renaming, creating, and deleting sections. All of these

functions are consistent within the PenPoint operating environment

whether you are working with sections, documents, or words.

Instant Help

Your EO has a built-in help system that is very complete. The most

important sections of the user ’s manual are included in the Help

Notebook. The help system covers all of the information you

might need for both the PenPoint operating system and your EO’s

hardware. If you are ever at a loss you can access context—sensitive

help by gesturing with a question mark ? over the window ele—

ment, title bar, button, or command that you are curious about.

The Help Notebook is the first bookshelf item—it’s simply called

Help (see Fig. 11).

When you tap on the Help Notebook you will get a small options

sheet telling you to tap on the object you need help with (see Fig.

2.12). You will also have the option to open the Help Notebook.

If you tap on an object you will see a brief description and a list of

options for the object you tapped on Figure 2.13 shows what you

see after tapping on the Create menu command.

NQi'e An options sheet is a small page that provides you with options. In
this case if you drew the ? gesture or opened the Help Notebook

Figure 2.1 I Help Notebook icon

The Help /

 

N b k ' ‘3 «ll fill it :0. .u. it Biote 00 Icon _ _ _ . ‘ . i. a.
Help Settings: 5::te.t|orier‘;.-' HDZEBEHZII‘IEES lnlmjx; I.Jutl::cr>:: EL! Phone lI‘JCIlEliHjCIl‘i. BUSIt'IEZEtz-Z-

Figure 2. 1 2 Name of Document or Section

 
Each page of the Notebook holds ‘7’

The In ll'ICll Help either a document or a section.

Ophons Sheet 'Tap on the name to select a
document or section for a menu

operation. 

Heir: Naemclzt Carmell
_......:;::..__._J 
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Use the Create Menu to create new 49“

documents from template ‘
documents (stationery). Tap Create,
then tap the name of the stationery
you want.

 ""iC'C'B$.33”)leJauuegdflagL3}
The newlvcreated document J}

fietp Notetswoeézl gang .1
  

_—___.J

you were presented with the Help options sheet. You will see other
options sheets in subsequent sections and chapters.

Another way to bring up a help options sheet is to draw a ”?” on

top of the object you are curious about. This is the same as tap-

ping on the Help Notebook and then tapping on the object of

your distress. Using the ‘2 gesture is a little shortcut that can save

you some time.

If you want more information after you have looked at the infor—

rnation in the Help options sheet you can open the Help Notebook

by tapping on the Help Notebook button. You can then find more

detailed information on the subject you want. Figure 2.14 shows

the contents page of the Help Notebook.

When you use the Help Notebook, check out the index. It may be

faster than leafing through the different sections to find the topic

you want. However, you should also spend a few minutes brows—

ing through the different sections to become familiar with the rich

selection of topics that are available. All of the EO’s applications,

the EO’s hardware, and the PenPoint operating system are cov—

ered by the Help Notebook.
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e

to Tap, Brow, and Wrie

The concept or metaphor behind the 130 are real notebooks, pages,

paper, and pens. It is the pen and paper metaphor in conjunction

with its portability and communications capabilities that make the

E0 a personal communicator. This metaphor brings with it a new

way of interacting with digital devices like the E0. Drawing and

tapping are both a result of applying the metaphor to the E0 and

actions performed with the pen on its screen.

learn 

A gesture is a mark you draw on your communicator’s screen,

causing it to perform a specific action like converting text from

lower to upper—case characters. Tapping is the primary means for

selecting different objects such as letters, words, buttons, and doc-

uments and is performed by lightly touching your pen to the com-

municator’s screen (an action that is very much like dotting an i).

In addition to tapping and drawing, you will also be writing

(printing) on the screen of your EO.
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Note

Figure 2.15

A page with

both digital
text and

digital ink
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What makes all of this work is the EO’s built—in character recognition

engine. The character recognition engine converts the letters you

write into digital characters. If you do not want to have your writing

translated, the E0 will store your writing in a form called digital ink.

Figure 2.15 shows a page with both digital text and digital ink.

Add a sophisticated library of gestures that perform different

functions based on the context of the gesture and you have a very

powerful system that does not require a keyboard. (If this seems a

bit like Greek, just hang in there. It’ll be made clearer.) All of this
is controlled by a high—powered processor and an operating sys—

tem that can interconnect your data in ways heretofore only
dreamed of.

The Webster’s definition of writing is: i. To form (symbols, letters, or
words) on a surface, as with a pen or pencil. 2. To inscribe the sym-
bol, letters, or words of (write one’s signature). 3. To create and put
down on paper.

All of these definitions apply when interacting with your 130.

Although we often use the word writing to mean cursive or long-

hand writing, throughout this book writing refers primarily to the

first definition. Although you may truly write a gesture, the use of

gestures is called drawing. Writing will mean using or ”writing”

letters that are going to be stored as text and/or digital ink.

 
l / . V ‘
l l’v'lll'thOIE: 39t/

lDooumenl Edit Options Arrange Pen .7“
, i»

i

t

i xi_.—r7 "’2 J 5"" ..s r s~ «r ~ .,~— . a a“
t {,1 f, / ,: ,«' j (LIV {if Li Ll . v'“ r‘

/ / K  
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The E0 cannot automatically recognize all of the different styles of

writing and interpret them. We (humans) can sometimes recognize
what has been written because of the context in which the letters

and words occur, but there are cases when someone’s handwriting

is so unclear that even context is useless. To solve this problem,

you can train the E0 to recognize your handwriting, even if you
write in a non-standard manner.

The longer you use an E0 the easier it becomes for it to recog—

nize your writing. (After working with E0 for awhile, your

writing will probably become neater. My handwriting is far

from clear as you will see in some of the figures throughout this

book. Figure 2.16 is an example of my chicken scratch. Some

have said my writing looks nice, but it is also impossible to

read. They are correct.

When I started using the BC I was concerned because I knew that

my writing was not suited for character recognition. But while

learning to use the E0 I discovered that if I took just a little care,

the E0 would recognize my writing.

As a result my writing has became more legible overall, even

when I'm not using an E0. Also, the creators of PenPoint and the

E0 knew that we (the users of the E0) would not always be able

to take the time to make our writing legible and provided an alter—

Figure 2.16 iirhnitlme
Document Edit Options Arrange Pen

My sloppy

handwriting
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E used to use small yellow pads for iotting down notes while in my ottice
or at meetings. i had at least a halt a dozen around because l’m not

the most organized person in the world. So, when someone called and I
needed to write something down, l could never find a note pad. My solu-
tion was to get a new pad, grab an envelope from yesterday’s mail, or get
a piece of scratch paper out of the trash to write down that important
phone number, address, or message.

As you can imagine, i would often spend more time trying to Find my notes
than i would working. Now with the E0 i can take my notes without need-
ing to look For paper, and I can also doodle at the same time. Not only do
I know where my notes are, they can’t accidentally end up in the trash, lost
under my keyboard, or stuck between magazines.

Most of my notes are kept in digital ink and are very secure, since no one
can really read my writing but me. And it the note is really important 3 take
the time to translate it into real text and link it to the appropriate person,

company, or day [more about this capability in the chapter about Personal
Perspective).

native called digital ink. Anywhere you can enter data on an E0

you can also use digital ink.

The combination of character recognition and digital ink means

you can always put your data into your E0. When you are in a

hurry, and do not want to take the time to make your writing rec-

ognizable, you can use ink. Later, it you wish, you can convert

your ink writing into characters. Of course, you may also just keep

your data as ink.

Also, for you doodlers, digital ink makes working with a EO just

like using a piece of paper. You can write your notes and. doodle at
the same time.

By now you have probably guessed that this section is about train-

ing your 130 to recognize your writing, using some of Penl’oint’s

gestures, and tapping around your screen. This section will provide

you with the basic information you need to start using your E0.
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The only problem with this whole section is where to begin. What

should be learned first? Drawing? Tapping? Writing? Well, tap—

ping should be first (in my opinion, for what it’s worth). But the

question of drawing and writing is really a toss up. So read the

whole section before you start poking and tapping at your EO.

This section, along with the last tWo, should put you on the right

road and give you an understanding of the road signs.

Tapping About

Tapping is to the E0 what the mouse and clicking or double-click-

ing is to a desktop computer. Tapping is how you open notebooks,

select text or objects, and perform many routine tasks. The process

of tapping, as mentioned above, is like dotting an i: tap once and

lift the pen away from the screen. If you are performing a multiple

tapping sequence, such as a double or triple tap, tap the required

number of times in quick succession on the object of your desire,

barely lifting the pen from the screen between each tap.

The first thing to remember about tapping is not to double tap.

There is a tendency to tap twice when one tap will do. The reason

that you should not double tap is because a double tap tells the E0

to perform a specific action different from a single tap. There are

also some tapping associated actions called presses and tap

presses, and then there is the process of dragging. Although these

are not taps in the strictest sense of the action, they are more

closely related to taps than gestures.

The location of a tap or taps sequence also has a bearing on the

meaning of the tap. The following lists the different types of taps

and their meaning, depending on where they occur. This is a

beginning list, and because of the variety of ways to use a tap it is

incomplete. But the list does contain most of the different mean~

ings you will need to begin using your E0. The hieroglyph to the

left of each explanation is the symbol that will be used throughout

the book to designate that type of tap.

YTap

Openings The tap l’ is used to open notebooks and documents by
tapping on their icons on either the bookshelf or in a notebook’s

table of contents. You can also tap on a page number or tab to open
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a document. When you tap Y to open a document within a note—
book, the notebook will open to that document’s page.

Selections Depending on the type of document on which you

are working a tap can select a letter, word, a line of text, a name, or

open an editing pad. If you are in a notebook’s table of contents,

tapping on the name of a section or a document will select the
item’s name.

Menu Selection Tapping on. a menu name will cause the menu

to pop up. A subsequent tap on your menu choice executes the
menu command.

Button Selection Buttons appear in option and dialog sheets. A

single tap on a button will cause the button to be pressed, executing

the buttons command. If you are Viewing a notebook with buttons

instead of icons, tapping on a content button will cause the note

book to turn to the page associated with the item next to the button.

List Selection In option sheets an arrow means you can select

options represented by the label to the left of the arrow. Tapping

on the arrow or the choice to the right of the arrow causes a pop-
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up list to appear. A tap on. an item from the pop-up list selects it

and closes the pop~up list.

,l’ Double Top

Openings Double tapping on a document’s icon (or button), its

page number, or a notebook’s tab will cause the document to open

as a floating page like the MiniText document in Figure 2.18.

Double tapping on a document’s Title line will cause the docu-

ment to open as a floating document. Double tapping on a section

name (in a table of contents) will expand a closed section or close

an open one. If you have trouble with double tapping—if it keeps

happening when you don’t want it to——try turning off Float and

Zoom in the Settings Notebook. (This is explained in Chapter 4..)

Selection In most cases double tapping will select a word. The

reason I say most cases is that in some documents or sections of a

document, like the notes section in Personal Perspective, double

tapping will deviate from the general rule. (Deviations, when they

occur, will be discussed in other parts of the book).
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Pages You can use a tap in the scroll margins to move the display

on a page one screen width by tapping on either side of a Drag

Box. To move a page in this manner your 'EO has to be set to use

Arrows and Drag Box as described in the Fonts and Layouts pref—

erences section in Chapter 4.

3 Triple Tap

Triple tapping will select a sentence within most applications that

use a paragraph structure. MiniText, the word processing applica-

tion that comes with your E0, uses a paragraph structure. Triple

tapping on a word in a MiniText document selects the sentence

that contains the word you triple tapped.

gV Quadruple Tap

Quadruple tapping will select a paragraph within documents that

use a paragraph structure. Just like the triple tap, if you quadruple

tap on a word, the paragraph that contains the word you quadru-

ple tapped will be selected.

1 Press

A press is related to a tap, but rather than touching the object and

lifting the pen, you touch the object with the pen and continue to

hold the pen down. How long you hold the pen on the object

depends on what you want to accomplish. With a press you can

select a box in an editing pad, a previously selected object for mov-

ing, or set the insertion point in a line of text of a text document.

The most common use of the press is to select an object for mov-

ing. When you press an object (an object can be almost anything
from a document in a table of contents, a word in a line of text, or

a tool from within an application) a marquee will appear around

the selected item (see Fig. 2.19). You move the selected item by

dragging it to its new location. Because there are many different

ways to move an object, this topic will be discussed in various

places throughout the book.

4 Tap Press

The purpose of a tap press is to select an object for copying. The tap

press is performed by tapping and immediately performing a press
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after the tap. You can tell that a tap press has been performed by

the double marquee that surrounds the selected object. Once the

double marquee appears (see Fig. 2.20), the object can be dragged

to its destination. This action can be performed on any selectable

object such as a paragraph, an application tool, or a document.

NOi’e When you are tapping about on your screen you will see from time
to time a starburst €13 or a starburst with a .9 inside. When you see a
starburst happen your E0 is talking back to you and sometimes you
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will think it is lust downright uppity. Well, don’t slop it, that will not
make it understand you any better (there’s [ust no way to knock the
wax from its ears).

Instead you will have to rethink what you are doing. If you see a

square with watch hands going round it means your E0 is busy

executing the last command you gave it. If the starburst keeps

appearing the E0 is pretending to be brain dead (remember the

important word here is pretending) because you are tapping

someplace where taps are inappropriate or it is not recognizing the

gesture you are making.

Until you get the hang of tapping and drawing you will see a lot

of starbursts. Hopefully they will not get to fireworks proportion

because that would probably mean that you are frustrated and

ready to use your communicator as an expensive Frisbee. So, if

you are seeing fireworks (lots of starbursts), take a break, rethink

your steps, and try again.

Dragging is always associated with tapping because you have to

press or tap press an object before it can be moved or copied. After

the object has been selected for moving or copying (having a mar~

quee or a double marquee) place the pen inside the borders of the

marquee and, without lifting the pen from the tablet surface, move

the pen to the object’s destination. The object will move with the

pen. When the object is placed where it will be accepted (moving

text from one field to another field) and you lift the pen, the object

will reposition itself in the new location.

Drawing

As mentioned above, a gesture is the means of giving a command

to your EO by drawing a symbol with the pen. Several gestures

have multiple meanings depending on Where (on what object) the

gesture is drawn. Although the same gesture may cause different

actions, the meaning of the gesture usually remains constant.

An example is the caret gesture A. The caret gesture means insert.

But the meaning of insert is different when executed in the table of
contents of a notebook than when it is used in a MiniText docu—

ment. In the table of contents you want to insert a new document
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or section while in a MiniText document you would be inserting
new text.

The following list of gestures are the ten basic gestures (in addition

to the tapping gestures) you need to get started with your EO.

When you draw gestures your strokes need to be concise and

clean. You cannot curl the beginning or the end of the stroke and

most strokes are one continuous pen stroke. Each gesture is illus-

trated with a symbol. For each stroke of the gesture the fat end of

the stroke is the beginning and the thin part of the stroke is the

end. Start your stroke at the fat end and end on the thin. For those

gestures that require two or more strokes, barely lift your pen from

the tablet when you make the second stroke.

If you have trouble drawing your gestures or find them awkward,

you can use the built in gesture practice page that is described

after this list of basic gestures.

/\ Carat

The caret gesture as mentioned above is the insert gesture. When

used on the Bookshelf it will pop up a menu of insertable docu—
ments, including a notebook. When performed in a notebook you

will receive a pop-up menu of insertable items, including a sec-

tion. Within text fields the caret will. bring up an empty editing

pad. Also, various programs will insert objects specific to the pro~

gram by using the caret.

\/ Check

The check \/ gesture is used to display the options available for a

particular object. Many objects such as tools, menu lines, and other

configurable items will pop up a dialog sheet so you can change

the object’s attributes. When a check is drawn in the table of con-

tents of a notebook, you will get a dialog sheet like the one Figure

2.21. This is a gesture you should experiment with.

0 Circle

The circle 0 is the edit gesture. It is used in data and text fields to

open an editing pad. In some applications, such as Personal

Perspective, the circle gesture will open a profile sheet (record
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Figure 2.21
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form) for editing. If you want to change the name of a document,

notebook, or section, draw a circle over the name and an editing

pad will appear so you can change the name.

X Cross out

This is the delete gesture. A cross out X will delete just about any~

thing. You can use this gesture on selected text and other objects. If

you use the cross out gesture on a notebook displayed on the
bookshelf, it will delete the entire notebook and the notebook’s

contents, so be careful.

l Flick up

The flick up i gesture is used to move (scroll) a page up to

reveal what may not be Visible on the page. This gesture can be

used directly on some documents and/or in the scroll margin.

A flick up in the Title line of a document will zoom the page to

full size. And using a flick up on a letter in an editing pad will
delete the letter.
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l Flick Down

The flick down i gesture is used to move (scroll) a page down to
reveal what may not be visible on the page. This gesture can be

used directly on some documents and/or in the scroll margin. The

flick down moves the document in the opposite direction of the

flick up gesture.

.. Flick Right

The flick right .— gesture is used to move (scroll) a page to the

right to reveal what may not be visible on the page. This gesture

can be used directly on some documents and/ or in the scroll mar—

gin. The flick right gesture can also be used on options dialog
sheets wherever there is an arrow to select the next available

option.

.. Flick Left

The flick left ~gesture is used to move (scroll) a page to the left to

reveal what may not be visible on the page. This gesture can be

used directly on some documents and/or in the scroll margin.

This gesture will move a page in the opposite direction of a flick

right. Also, the flick left gesture can be used on options dialog

sheets wherever there is an arrow to select the previous option.

L. insert Space

The insert space L gesture is used with text to insert a space in

between characters. Use this gesture by starting the stroke

between the two letters where you want the space inserted and

complete the gesture.

gag Undo

The undo CQ gesture is used to cancel your last action. If you edit a

word and change your mind you can perform the undo gesture

and the word will be restored to its pre-edited condition. This

command only works within documents where the action you

want to undo is reversible (check the application’s user’s manual).

If a document supports the undo gesture it will usually have an

Edit menu with an undo option in the edit menu. The undo ges—
ture will not restore a deleted notebook or file.
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‘? Question Mark

The question mark gesture calls up instant help. When you gesture

a question mark on an object, context—specific help appears for the

object. If no help is available, the Help Notebook will still open

instant help and tell you that no help is available.

Some gestures can be difficult to master. 1 have problems with the

scratch out 2 and the caret tap /'\ gestures. (These will be discussed

in the chapter on PenPoint.) However, practice can make perfect,

and the E0 has a built—in program specifically for this purpose.

To access the drawing practice page:

1. Tap on the Settings Notebook.

2 Tap on the Contents tab if the contents page is not visible.

3. Under Installed Software tap on the Gestures button.

4 When the Gestures page appears, tap on the word practice.

At this point you will see a page that looks like Figure 2.22. This

page lists all of the PenPoint gestures you can use.

By tapping Y on a gesture a description of the gesture will appear
at the top of the page. If you want more information about the ges-

 

/ Gesture Practice
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ture double tap .l’ on the gesture and you will see a practice page
similar to the one in Figure 2.23.

On the practice page you will see the description of the gesture,

instructions on how to draw it, examples of what does and doesn’t

work, and a practice area. After reading the information about the

gesture you should practice drawing the gesture. When you prac-

tice the gesture the E0 will tell you if you drew it correctly.

Practice all the gestures until you have them all down and you feel
comfortable with them.

There will always be occasions where you did not draw a gesture

properly. Usually it is just a little frustrating. However, if you consis-

tently have problems, don’t forget about the gesture practice area.

Writing Practice and Customization

Although taps and gestures are used to tell your E0 what you

want it to do, usually you will be telling it to do something with

data you have written or that has somehow been input into your

EO. When you write on your EO you will either be using digital

ink or you will want the EC) to recognize your writing and then

translate your writing into text. If you want your E0 to recognize

your writing, you may have some work to do.

 

Figure 2.23 r/f Gesture Practice

l1 Scratch out. Deletes words in text Delete-3 one or moreT e Gestures trawl-rated chaiad ers in boxed pads. D :lfiE-Sl.1i'llf'EJ'>$lE:i€1CllB‘Xi in
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Your handwriting clarity is going to determine whether or not the

EU will easily translate what you write into digital text. I said in

the introduction to this section, my writing is far from perfect. As a

matter of fact, I have a hunch that my writing falls into a category

that is close to atrocious. Yet, even I have been able to get the E0

to recognize my writing.

If you have less than legible handwriting there are several ways to

increase your EO’s ability to recognize your writing And even if

your writing is good you will find that by following these suUgges—
tions your EDO’s ability to recognize youi writing will1mprove .

Statistically, the character recognition capabilities of the E0 have

been rated at about a 90% accuracy rate. But statistics often have

little bearing on reality. The reality of using the E0 is that you will

be entering data while on the go. Sometimes translating text will

take too long so you will use ink, at other times you will want

your writing translated.

Whatever you’re doing, translating text takes time, and if you are

going to take the time to have your writing translated statistical

averages won’t mean much. Regardless of the averages you will

still want the maximum character recognition capability your EO

has to offer just to save time and prevent frustration.

To achieve this goal you need to (a) align your pen, (b) practice

your handwriting, and (c) customize the recognition of any char—

acters that you write in a unique manner. Aligning your pen is

covered in Chapter 4 and will not be discussed here. This section

will, however, discuss practicing your writing and customizing

the EO’s recognition.

NGi'e The software your EO uses for character recognItion is only one
part of the PenF’OInt operating system, and at this time it is probably
the best character recognition software available. But, that does not
mean that better software will not be available in the future.

Currently there are several companies writing software that will rec—
ognize cursive writing.

Because the PenF’oint operating system is modular (object—orientecl)
you Wlll be able to easIsay upgrade the character recognition engIneas new and better han writing recognition software becomes avail-
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able. Also, it is possible that companies other than GO or E0 will
develop recognition software that you might want to use. in an
case, when new software is available you will be able to easié:
upgrade and enhance the EO/s character recognition, improving on
what you already have.

Before you start customizing letters you need to practice. Once

you have practiced writing all of the different characters you

should use your ED for awhile without customizing any charac-

ters. After you have used it for a while you will know which of

your characters the E0 has problems with. After you know which

letters are troublesome, you can train the E0 to better recognize

how you write the problem characters.

Just as the E0 has built-in software for practicing gestures, it also

has a page for practicing handwriting.

To practice handwriting with the E0:

1. Tap on the Settings Notebook.

2. Tap on the Contents tab if the contents page is not Visible.

3. Under Installed Software tap on the Handwriting button.

4. When the Handwriting page appears tap on the word ”Practice...”

At this point you will see a page that looks like Figure 2.24. This

page lists all of the letters.

5. Tap on a letter. Your BO will show you three different ways to
write a letter.

6. After you have seen how a letter is written, you can practice in

the editing pad on the right. When you practice a letter, the EC)

will tell you if it has problems recognizing it.

Remember, you should not rush into customization immediately.

This is because your writing will change as you learn to use your

EO, and you also need time to get feedback from the E0 to know

which letters are giving you trouble.

To customize letters:

1. Tap on the Settings Notebook.
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2. Tap on the Contents tab if the contents page is not Visible.

3. Under Installed Software tap on the Handwriting button.

4. When the Handwriting page appears tap on the word “Customi-
zation...”

At this point you will see a page that looks like Figure 2.25.

This page lists all of the letters.

5. Tap on the letter you want to customize. When you do, a

series of editing pads will appear in which you write the letter

you want to customize. Figure 2.26 shows the Customization

editing pad in which you write the letters. Each letter you

want to customize will be written eight times and then used

in a couple of words Be sure to scroll down to see all of the

text entry fields before you tap.V the Accept button (to accept
your customization).

6. After you have written each of the characters, tap the

Accept button. The E0 will process each of the letters, and

any letter that the EC) would not normally recognize is

selected. Your EO will remember your unique writing style
for each character.

It is really important to do this as little as possible. Each time you

add a customized character your EC) will have to work harder.

This is because the E0 will have to compare more patterns in

addition to its normal method of stroke or line pattern recogni-
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tion. And although your E0 is optimized to perform quick and

efficient letter recognition, customizing a lot of characters will
slow it down.

Nfi'l'e Once you have customized your characters the E0 will store the
customized letters and all of your preference settings {discussed
below) in the users profile file. The users profile file is mentioned
here so you will remember that you have one and that it needs to
be backed u if you have problems with your EO and need to
reformat the fiard drive or restore all its settings because the batter-
ies 90 dead you will not want to redo all of your training and pref-
erence settings. Backing up your preferences settings will be
dIscussedIn the chapter on PenPoint and file management.

Conclusion

From this chapter and Chapter 1 you should know enough to start

using your BC). In this chapter you have learned what to do to

setup an E0, from unpacking the E0 to installing its batteries. All
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of the steps you need to know for basic operations have been cov—

ered in this chapter.

You also now know where to find the on line help, how to use the

tutorial, all of the basic gestures, and handwriting basics. Also, all

major system preferences have been covered 50 here you have it

Everything you need to start using youi E0 The next major sec-

tion will discuss the 130’s softwaie indepth, p10V1d1ng you with

instructions, tips, and tricks on PenPoint and all of the EO’s built—
in software.
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The PenPoint

Operating System

introduction

Before you read this chapter you should read Chapter 2. It con—

tains the essentials for using the EC) and an introduction to

PenPoint. As explained in Chapter 2, PenPoint is an operating sys*

tem written by the GO Corporation specifically for pen-based

computers. PenPoint was created. for mobile computing devices
and communications. GO’s intent was to make PenPoint so it

would work with telephones, pagers, faxes, and electronic mail in

addition to traditional computing tasks, While using a pen as the

primary means for interacting with the device. The E0 Personal

Communicator is the only device on the market that was built to

use PenPoint and fully harness PenPoint’s power.

All programs that use PenPoint have consistent features including

gestures, selection methods, common menus, and dialog and

options sheets, to name a few. This chapter will look at PenPoint’s

gestures and other PenPoint interface features. Because of the con-

sistency that PenPoint provides for all applications the features

discussed in this chapter will work with almost any program.

7 1
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When a feature does not work, it will. be because the application’s

developer did not implement the feature, not because it is unavail—

able through PenPoint.

There is a lot of information to present in this chapter. It will start

with an overview of PenPoint’s gestures, because gestures are

essential to working with PenPoint and the E0. Then we’ll look at

PenPoint’s interface, which is based on a notebook metaphor.

Then, after browsing the Bookshelf and exploring the notebooks

we’ll look at other PenPoint features such as installing software.

And then the chapter will be finished with a technical discussion
about how PenPoint works.

Gestures

As explained in Chapter 2, gestures are how you give commands

to the E0. Although you will use the basic gestures already dis—

cussed more than any others, the gestures discussed in this section

will let you take full advantage of PenPoint’s power. So, this sec-

tion will look at the remaining PenPoint gestures, giving the ges—

tures and their meanings when used in different contexts.

The contextual use of gestures means that you don’t have to mem-

orize gestures for every action you want to perform. Instead, all

you have to do is remember the basic gestures and their meanings.

Since the meanings change with context just like words, it is easier

to remember which gestures to use.

An example of the contextual use of gestures is the cross out ges-

ture X. One way of remembering what it means is to think of the

cross out X as the delete gesture. Delete means the same thing

even though you will be using it on different objects, but the effect

is always the same. If you draw a cross out X on a document on
the Bookshelf it deletes the document. When it is used in a docu~

ment on a selected text, the text is deleted. In order to remember

what a gesture does, associate the gesture with the function.

Don’t be overwhelmed by the gestures. If you use a gesture that

will cause information to be lost, like the cross out X gesture, you
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will always be given a second chance to change your mind. The

result of any other gesture will always be reversible. If you

change the case of selected text with a gesture there is another

gesture that will change it back (if the Undo gesture :2? does not
reverse the action).

 

The gestures listed in this section are those not listed in Chapter 2.

Also, don’t forget about the Gesture Practice page in the Settings

Notebook discussed in Chapter 2. Finally, there is a listing of all of

PenPoint’s gestures in the Help Notebook. 80 without further ado,

let’s look at the rest of the PenPoint gestures.

NOTE Remember that a document is an applications page and that
some applications do not utilize all gestures. Also, in the descrip-
tion of gestures, writing refers to using digital ink or words writ-
ten in ink.

General Gestures

The following are called general gestures (by me, not GO) because

they do not fall into any specific category. Like many gestures,

some of these will have double duty depending on the gesture’s

context. When drawing a gesture you need to avoid hooks and cir-

cles at the beginning or end of the gesture. Remember that angle is

important when drawing a gesture. If the gesture has too much

slant it may not be recognized. When drawing gestures with mul-

tiple strokes, it is important to perform both strokes as separate

strokes. If the delay between strokes is too long, the gesture will. be

misinterpreted. Table 3.1 shows the basic gestures.

Hicks

Flicks are a category of gestures normally used for navigation and

selection, but they also perform additional functions, depending

on the context (see Table 3.2). All flicks must be drawn as a, single

action. You cannot touch the pen to the screen and pause before

drawing the flick or it will not be recognized. All flicks need to be

straight, without hooks at the beginning or the end of the gesture.

Finally, some slant of a flick is permissible, but too much slant will

result in an unrecognized gesture.
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Basic gjeswrésv ;: 
Gesture Name Description 

T‘ Arrow Up Used in documents on text depending on

the application writing. Increases the point
size of a font or the size of an individual

word or the selected writing or text. Arrows
must be drawn as two strokes and the arrow

tip must be drawn from the left to the right.

\l/ Arrow Down Used in documents on text depending on

the application writing. Decreases the point
size of a font or the size of an individual

word or the selected writing or text. Arrows
must be drawn as two strokes and the

arrow tip must be drawn from the left to

the right.

[ Bracket Left Used in documents on text depending on

the application writing. Selects text. If you

have selected text and draw a left bracket [

to the left or above the selected text, all of

the text between the selected text and the

left bracket [ will be selected. This gesture
will also work in documents that have line

items like Personal Perspective lists.

Brackets are drawn with a single stroke.

] Bracket Right Used in documents on text depending on

the application writing. Selects text. If you

have selected text and perform a right

bracket ] to the right or below the selected
text, all of the text between the selected text

and the left bracket 1 will be selected. This

gesture will also work in documents that

have line items like Personal Perspective

lists. Brackets are drawn with a single
stroke.

2 Scratch Out Used in editing pads, on text, writing,
selected text, and words. When drawn over

a word, or letter, the scratch out 2 gesture

deletes the letter or word. This gesture is

drawn like a very tight Z with all the lines

being drawn very close to each other, with

the same width and a single stroke.
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Gesture Name Description 

— Line Through Used in editing pads. Deletes two or more

translated characters in an editing pad.

7 Pigtail Used in editing pads, documents, or fill—in

fields. Used to delete a single letter. The

pigtail 9' is a single gesture and can be difficult

to master. Instead of the pigtail, use the Flick

up i to delete characters in an editing pad.
 

+ Plus Used in documents on writing or text. Used to

select writing, text, and objects. The plus +

gesture can also be used to perform a

discontiguous selection. A plus is drawn with

two strokes. If drawn as a single-stroked

gesture it will not be recognized.

  
 

 Tab|e32 3 '1‘ Basis flicks ,‘ ,
Flick Name Description 

.w Flick Right Used in a notebook’s title line. Turns one page

to the right or the next higher page number.

. Flick Left Used in a notebook’s title line. Turns one page

to the left or the next lower page number.

Flick Up Used in a notebook’s contents or a document

page. Scrolls or moves the page so you can

see what is below the current Viewing area.

Used on a notebook’s tabs. When drawn on

the tabs of a notebook that are hidden or

overlapped, the tabs below will be revealed.

Used on a Title line of an options sheet or on

an option with a selection arrow. Selects the
next available selection or menu item.

Used over translated text in a pop~up menu

or field. Deletes the letter and space so the

text to the right moves over and occupies

the box where the flick up l was performed.

Used on a document’s title line. Causes the

document to zoom to fill the EO’s screen.

(continued)
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Tclble 3.2 bBo‘sic‘H‘icks (continued)
  

Flick Name Description 

I Flick Down Used in a notebook’s contents or a document

page. Scrolls or moves the page so you can

see what is above the current viewing area.

Used on a notebook's tabs. When drawn on

the tabs of a notebook that are hidden or

overlapped, the tabs below will be revealed.

Used on a Title line of an options sheet or on

an option with a selection arrow. Selects the

available option that is before the current
selection or menu item.

Used on a document’s Title line. Causes the

document to zoom back to its original size.

This works only after a page has been
zoomed.

it Double Flick Up Used in a notebook’s contents or a docu~

ment page. Scrolls or moves the page so

you can see what is at the bottom of the

page.

Used on a notebook’s tabs. When drawn on

the tabs of a notebook that are hidden or

overlapped, the last (bottom) tab will be
revealed.

ll Double Flick Down Used in a note-book’s contents or a docu—

ment page. Scrolls or moves the page so you

can see what is at the tOp of the page.

Used on a notebook’s tabs. When drawn on

the tabs of a notebook that are hidden or

overlapped, the first (top) tab will be
revealed.

it Flick Up Down Used primarily in embedded documents,
but will work in some documents that are

not embedded. Alternately hides or displays
a document’s controls like the Title line,

Cork Margin, and borders. The flick up

down it strokes must be drawn adjacent to

each other, as two gestures in quick succes—

sion (not as a single gesture), and both lines
should be the same size.
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Carats

Carets are always used for inserting text, documents, or embedded

editing pads. The caret /\ gesture is discussed in Chapter 2. All

carets must be drawn as a single stroke starting on the left and

ending on the right. See Table 3.3.

Circles

Circles are always editing gestures. When drawing, you must start

the circle at the top and move the pen from the left to the right. If

you do not close the circle or overlap at the top too much, the ges—

ture will not be recognized. You do not have to draw a perfect cir—
cle, ovals will work. See Table 3.4.

Table 3.3 ‘ Carers 
Caret Name Desription 

 
/\ Caret Tap Used in documents. Opens an embedded

editing pad. (When used in a Perspective

field, the caret tap creates an extra

”instance” of that field, allowing you to

have multiple items for any field.)

>> Double Caret Used in documents. Displays the Create
menu to embed a document within another

document.

 
 

 
V'Tablev 35,4 Circles . ‘ 
Circle Name Description 

9 Circle Line Used on text. Selects the word and opens a

blank editing pad. Whatever you write in

the editing pad will replace the word on

which the gesture was drawn. The Circle
line can also be used on selected text where

more than a single word is selected.

Cd) Double Circle Used in documents, Cork Margins, and on
the Bookshelf. Creates a Reference button.

Select the text you want to use for a Reference
button, then draw the double circle 0:) where

you want the Reference button created.
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Figure 3.1

A single letter

POP'UP

editing pad

Cemer Gestures

Corner gestures are editing gestures used with text. However, some

of the gestures will work in applications with writing in addition to

text. The primary stroke of all corner gestures is performed as a sin-

gle stroke. The gestures must be drawn at 90 degrees and must be

started in the text line. Starting the gesture too far above or below

the line of text will result in an unrecognized gesture. Also the ges-

ture should be the same height as the line of text (see Table 3.5).

Letter Gestures

Letter gestures are usually drawn either in the Title or Menu lines

of documents or in the text they are meant to affect. Also, any let—

ter gesture that affects a page or text is a toggle switch, redrawing

the figure reverses the effects. All letter gestures should be drawn

as you would normally write the letter. If it is made either too far

above, or below, or outside the selected text, the gesture will be

misinterpreted (see Table 3.6).

Useful Applicetlen gestures

The following gestures are used in some applications, but are not

listed in the PenPoint manual. One application where these ges-

tures work is MiniNote. It is possible that some of these gestures

will work in other applications as well. The right, left, down, and

up gestures are all similar to the corner gestures above (see Table

3.7). You will have to experiment to see if the gesture works.

Making a Good Gesture

Drawing gestures takes a little practice. If your EO does not under—

stand what you want it to do, you will see a starburst with a .7 in

/' T‘KF’QS. Doc: tinted

Dclour’nem Edit Options View l n sen, Case

\VH ERE I 5‘ ALL THE- .IARGDN '1l ;.—._‘

 
 

;

lJzu'an pervades sofhvare docmnentaticm. Manl-
seem unable to escalt jargon because computed:
fascinate those who work around them and because

i the people who work with and write alxiut computers
' are. not afraid of computers or the jargon that goes
with them.

 1
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7'Tdblve‘3.5l , corner gestures.‘

Comer Gesture Name Description 

1‘ Insert Used on text in a document. Causes a

Character single letter pop—up editing block to

appear. Enter the character you want

inserted into the pop-up editing pad.

The letter drawn is immediately trans-
lated and inserted into the document.

Figure 3.1 shows a single letter pop—up

editing pad.
 

I. Insert Used on text in documents. Inserts one

Space space when drawn on text.

Used in editing pads (embedded or

pop—up). Inserts one or more spaces.

The number of spaces inserted will be

determined by the length of the trailing
stroke. The number of boxes it under~

lines will be the number of spaces
inserted.

gr. Insert Tab Used on text in documents. Inserts a tab
character.

J New Used on text in documents. Inserts a

Paragraph paragraph break into the document

where the gesture is drawn. This gesture

creates a new paragraph.

:1 New Line Used on text in documents. Inserts a line

break into the text without creating a

new paragraph.

"I Lower Used on text, either on a single word or
Case on selected text. Formats the selected text

as lower—case characters.

.1 Initial Used on text, either on a single word or

Caps on selected text. Formats the selected text
so the initial character of each word is a

capital letter.

.11 Upper Used on text, either on a single word or
Case on selected text. Formats the selected text

as upper-case characters.
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ire-blew. biwetgeauesr 
Letter Gesture Description 

5

TH

 N

Used on text or selected text in a document.

Changes the text’s formatting to bold.

Used on document and notebook pages.

Displays or hides the Cork Margin.

Used on almost any document. Causes the

Find dialog sheet to be displayed. When
drawn on the Menu or Title line the entire

document will be searched.

Used on text or selected text in a document.

Changes the text’s formatting to italics.

Used on document and notebook pages.

Displays or hides the Menu line.

Used on text or selected text in a document

Restores any formatted text to normal for—

matting, undoing any italics, bold, or

underlining.

Used in almost any document over a text

selection. Causes the Proof dialog sheet to

be displayed.

Used in almost any document or over a

text selection. Causes the Spelling dialog

sheet to be displayed When drawn on the
Menu or Title line the entire document will

be spell~checked.

Used on notebook contents pages. Creates
or removes a notebook tab when drawn on

a content’s item.

Used on text or selected text in a document.

Changes the text's formatting to under-

lined. lf performed a second time, the text

is underlined with a heavy underline. Used

a third time, all underlining is removed.

 
 

the middle. Simply try the gesture again. On other occasions you

will see just a starburst. The starburst means that the gesture was

recognized, but the context was incorrect and the command could

not be executed. Look in the beginning of this chapter to find the
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Gesture Name Description 

7 Right Down Used in documents, usually note taking or

graphics applications. Inserts lines or spaces

in the document starting where the stroke

from the right is drawn and inserts lines or

spaces for the length of the downward stroke.

In MiniNote, starting this gesture in the ges-

ture margin inserts new blank lines.
 

_J Right Up Used in documents, usually note-taking or

graphics applications. Deletes lines or spaces

in the document starting where the stroke

from the right is drawn and deletes lines or

spaces for the length of the upward stroke. In

MiniNote, starting this gesture in the gesture

margin deletes lines.

6) Circle Tap Used when writing in documents.

Translates the writing to text and immedi—

ately inserts the text into the document.

U U Used on writing or text in a document. Hus is

a special use of the U gesture to group text or

writing together. When used this way, items

to be grouped together are connected by each

side of the U, with the beginning of the ges-

ture on the word or writing on the left, and

ending on the word or writing on the right.

  
 

gesture you need to use. If your gestures are consistently being

misinterpreted or unrecognized you should do two things.

First, you should practice the gestures using the Gesture Practice

page in the Settings Notebook as described in Chapter 2. Next,

after you’ve practiced the gestures and you know that you are

drawing them correctly, you should adjust the Writing Timeout as

described in Chapter 4.

PenPoint’s Functions and Obiects

PenPoint offers a highly integrated system of features Where meth—

ods for performing actions such as storing, accessing, and working
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Aunique feature of PenPoint is that the differentiation between appli—cations and documents has almost been abolished. This makes

talking about PenPoint elements confusing when trying to describe
them. Usually, PenPoint elements will be referred to by their names,
such as Bookshelf, Notebook, and icon, rather than a generic appella—
tion like application.

To fully understand how PenPoint works, it helps to understand how the tra-
ditional computer distinction between applications and documents loses
meaning in the E0 environment. Although you install an application, you

will never see an application unless you go looking for it. In a desktop
computer environment, an application is specifically distinct from the docu—
ments that are created while using the program,

But when using an E0, the only access you have to the actual program
is through the application’s documents. Each document contains ali of
the elements and controls that are usually associated with a program (in
the desktop world), so you never use an application separate from its
document. in this sense, all PenPoint documents are applications. This
means that a notebook is an application that contains all of the other
documents or applications that are put into it. Each section in a note-
book is also a program. Essentially every icon, notebook, or document is
the application.

If you have a document that does not have a corresponding application
installed, you cannot open the document. This means that documents and
applications are separate in reality, but functionally they are not. The doc—
ument is the application because the document is the only way that you
have access to the application's features. For this reason, the words ”docu-
ment” and ”applications” will be used interchangeably throughout this
book. Once the application is installed, the only direct contact you have
with the appiication is to deinstall it.

with your information are consistent to the appearance of the EO’s

screen elements. The information in this section is primarily opera-

tional, meaning you’ll learn what the various PenPoint elements

are and how they work.

This section will look at each of PenPoint’s elements and discuss

the various ways they can be used.
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Icons

An icon is the most basic element of the PenPoint operating sys—

tem. An icon is a graphic representation for a notebook, a docu-

ment, or a tool. Figure 3.2 shows icons on the EO’s Bookshelf (the

Bookshelf is also a PenPoint element).

In Figure 3.2 all of the images across the bottom of the screen are

icons. Even though the items depicted by icons are called by dif—

ferent names, an icon is usually a picture for an application. The

only exception to this is an icon which represents a tool within an

application (see Fig. 3.3). 
The way an icon appears on a bookshelf and in some notebooks

can be altered. Figure 3.4: shows ways an icon can be displayed.

Figure 3.2 M if" lcons
The EO,5 thanr‘iecticii'it-

V .— ELL] ‘ ,r e». r=i g "I"!Bookshelic Q 4" H l‘ll "I“ '1' “ll“ U n "—‘
Help Settings: Ettatli:iner:,i .iii::::es-:s:i:irle.sz Int-cm: CZiLittzicci ECl Phone l“l:»tel:n:n:zli Tool Etna:

F ig U re 3 '3 ’/ _ tn lt'ii’ii‘ are NoteTaler ii E’ifii >-

 

 

  

 

- ~ i Doctimsi't Edit. UpllOl’lB mots” u 7 mi

Application T - »ool ICOHS\L!.r ,« p- l 5/ c? [3" J? 1:1“ "70 1:; ("3. H 53lOOIS CllSplCIYGCl ll: raiser Big Pitt? Hilirjgil’itei' Text Scissors / I: ‘4
05 icons ' it}?

i? l"
l a

Figure 3.4 E‘i:iol;::-.tieit' > Eeon

The lcon Style: D
options sheet WP

tor the

Bookshelt
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Changing how icons are displayed is done through an Options

sheet like the one in Figure 3.4 above. The selected View is the one
with the check mark next to it. Icons on the Bookshelf and in

some notebooks, such as the Accessories Notebook, use alterna~

tive icon views. To Change the appearance of icons on the book-

shelf, draw a checkmark \/ anywhere on the bookshelf to see an

options sheet. Each bookshelf can have different views.

An icon is used to quickly identify the application it represents, so

each application has a unique icon. Also, icons are meant to be

opened, revealing the contents of the container or causing the pro~
gram to open. To open an icon all you have to do is tap l’ on it.
When a document is in use, its icon will be grayed out like the

S-Shot icon in Figure 3.5.

The Bookshelf

Each disk that is connected to an EC) has at least one bookshelf.

And the Bookshelf is how the contents of a disk are displayed and

accessed. Each bookshelf is displayed as a row that runs across the

screen. In this sense, the EO’s screen is a bookcase even though the

entire area of the screen is called the Bookshelf. Figure 3.5 shows
an EC) screen with three different bookshelves.

In Figure 3.5 there are three bookshelves. The bottom one is the

main Bookshelf showing what is on the disk drive that is running
the E0. The second and third bookshelves are the contents of con—

nected disks. Also, a disk can have more than one shelf. In Figure

3.5, for example, the main Bookshelf occupies two rows, not one.

 
Figure 3.5 :D I I I

An EO Wll'l'] E D. B [E B‘
. é MISC: Data f'JIIITElZICIDl-‘I. EIMIII BU F'Er23:pedi~.~'e .'-.1'

multiple
bookshelves

E B ‘ ’ ‘ D NE fl
LE Shall: S-Eihat T‘r"PI13‘3.DIIiIC:fixed fulirliwljte aha! Ir‘nk\.|'n.-"r'itr3i

{5:}
Con r'l e-::ti I: r: 5:

?v’|lr‘illmmmfil_tm
Help Settings: Stationery Accessories lt‘leE’i Outta-w: ED Phone F‘-Jn:ntelrnu3c:l-L TDD! Bic»;
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When Viewing a bookshelf you will see a row or rows of icons that
are notebooks, documents, or buttons. Notebooks, documents, and

buttons are the only items that can be put on a bookshelf. You can

copy or move documents to a bookshelf or you can use the caret /\

gesture to display the Create menu and select a new document

which will be placed on a bookshelf.

The notebooks on the main Bookshelf, called Help, Settings,

Stationery, Accessories, Inbox, Outbox, and E0 Phone are called

auxiliary notebooks. These are special notebooks that are part of

the PenPoint operating system, and, as such, they will only be

on the main Bookshelf. Each of the auxiliary notebooks have a

special function that will be discussed in the Auxiliary Notebooks
section.

Document Menus and Options

In this section we’ll discuss features you’ll find in almost all appli-
cations. All documents have the same basic structure, and once

this structure is understood you’ll be able to quickly learn how to

use almost any program. on your E0.

Remember, this section will look at the items that are usually

shared by all documents. There will always be exceptions, and

some documents may have some of the items discussed. All of the

common elements that are discussed in this section are general

rules. If I tried to list all of the exceptions, this chapter would

never get written. It is quite possible you will run across a docu—
ment that does not share all of these elements; consider it to be one

of these exceptions.

Elements Shared by Most Documents

In this section we’ll use a contents page to look at the elements of

the page that are shared by all documents. The following items are

elements common to all documents. Each of these page elements is

identified in Figure 3.6.

Close corner Tapping Y in this area on any document will close
the document. If you are working on a document page in a note~

book and tap Y on the close corner you will close the notebook.
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Cork Margin An area at the bottom of a page where you can

embed documents, accessories, or place buttons so they are

always available while you are using a specific page. The Cork

Margin for any document can be displayed or hidden by draw-

ing a C on the document’s Title line. The Cork Margin can hold as

many documents as you want to place in it. However, the items

in the Cork Margin are only accessible while the page is Visible.

if you turn away from the page, any open documents in the Cork

Margin will close until you turn back to the page.

Menu Line Contains the menu commands that are used to

manipulate a document. The menu titles are general categories

which when tapped ‘1’ display a list of specific commands that
pertain to the general category and the document or parts of the
document.

Resize Handles Specific spots at the bottom center or the lower

right—hand corner of a document, which when selected by pressing

i can be dragged to change a page’s size and will also affect the
page’s Viewing area.

Title Line The top of any document where the document’s name

is displayed along with its notebook page number if the document
is contained in a notebook.
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When a document is in a notebook, it will have a page number. If
the document is embedded or on the Bookshelf it will not have a

page number.

Page Number Every document and section in a Notebook has a

page number which is displayed in its Title line.

Common Menus

Each document has menus and menu items that are the same.

Because there are common menus for all documents, each appli-

cation will have commands and features that are the same. By

learning the features common for every application, when you

use a new program you will only have to learn its specific fea—

tures. This consistency among applications makes it much easier
to use the E0.

 

Menus are a major part of any document. Although most menu

commands can be executed using gestures, the menus offer a sec-—

ond way to perform commands. Every application also has com-

mands that cannot be accessed using gestures, which means that

you will have to use menus on some occasions. The menus that are
common to all documents are:

The Document Menu Contains commands that apply to the
document as a whole.

The Edit Menu Contains commands for altering items such a

text or writing that you have selected.

The Options Menu Contains options sheets that control the

appearance and attributes of a document and the items in a
document.

Menu Selection

All menus are accessed in the same manner.

To select a menu command, use these steps:

1. Tap Y on the menu name.

2. When the menu drops down, select the menu command you
want.
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Some menus list options. A menu that lists options will have the

selected option checked. Otherwise, the command selected will be
executed.

To select an option or command from a pop-up menu, you can

use any of these selection methods:

1. Tap on the arrow or the displayed menu item. The text field to

the right of the arrow will display the menu item.

2. Tap Y on one of the pop—up menu’s items to select your choice

Or

Draw a right flick .— or flick down l on the text field to the right

of the arrow to select the previous option in the pop-up menu

Or

Draw a left flick — or flick up l on the text field to the left of the

arrow to select the next option in the pop—up menu.

The Document Menu

For each of these menus there are commands that are usually com—
mon to all documents. For the Document menu the common com~

mands are:

Checkpoint This command only appears in documents where

you can alter information. When information is altered, the

changes you have made are not saved until you either turn to

another page, close the document, or select this menu command.

Revert This command only appears in documents where you

can alter information. If you have made changes to a document

that you want to discard, you can use the Revert command to

restore the document to the condition it was in when first opened

or when you performed the last Checkpoint.

Print Prints a document.

Print Setup Determines the printing parameters such as mar—

gins, paper size, and other features that are specific to the type of

document you are printing.

Send Allows you to send the document as an E—mail enclosure
or a fax document.
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About Provides a Document sheet that contains information

about the document (see Fig. 3.7), including the created and last

modified date and time, the document’s file size (how much disk

space it occupies), and the active size (the additional memory a

document occupies when it is in use).

Accessible from each Document sheet is an Application sheet that

contains information about the document’s program (see Fig. 3.8)

including the application’s name, version, publisher, copyright,
and the document’s icon.

The Edit Menu

The Edit menu is used to manipulate selected writing, text, or

objects within a document. In the Edit menu you will usually find
these common elements:

Undo This will reverse the last action performed if it is undoable.

Most documents that allow you to edit writing or text will also

allow you to undo the last change you made to a document. This is
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especially handy if you delete a word or some writing. The gesture

equivalent for the Undo menu is the undo CS? gesture.

Select All This command will select all of the text, writing, and

drawing in a document. It is usually used if you are going to

change an attribute like the font type or the line weight. It is also

used if you want to copy everything in a document. The gesture

equivalent would be to select the very first item in a document,

usually by tapping Y on it, scrolling to the bottom of the document,
and drawing a right bracket ].

Move This command prepares a selected item for moving. When

an item is selected and ready to move, a single marquee appears

around or in the selected item. The gesture equivalent for this

command is a press 1. You complete the command by dragging
the selected item to its new location.

Copy This command prepares a selected item for copying. When

an item is selected and ready to copy, a double marquee appears

around or in the selected item. The gesture equivalent for this

command is a tap press -1. You complete this command by drag-
ging the selected item to its new location.

Delete This command will remove a selected item. The gesture

equivalent is the cross out X gesture.

Clear This command is similar to delete. It removes the selected

contents by clearing a line or a field.

Edit This command opens a pop~up editing pad that contains

the text selected to be edited. The gesture equivalent is the Circle ca.

Translate This command will translate and insert the selected

writing directly into a document. lts gesture equivalent is the circle

tap 6).

Translate 8: Edit This is a cousin to the Translate command.

Rather than inserting the text directly into the document, you will

be presented with the translated text in a pop—up editing pad

before inserting the text into the document. The gesture equivalent
for this command is the circle 0.

Proof This command can only be used on selected text. It pre-

sents you with an options sheet that contains alternative spellings
for the selected word. You can choose an alternative word or dis—

miss the options sheet. The gesture equivalent is a P.
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Find This command presents you with an options sheet so you

can. search a document for specific text. You can usually select an

Advanced Find options sheet from the Find options sheet. The

gesture equivalent for this command is an F drawn on the Title
line of the document.

Spell This command is used to check the spelling of a document

or a word. It can only be used on text items. The gesture equiva-
lent is an 6. If the 6 is drawn on the Title line, the entire document

will be spell—checked. Otherwise, draw the 5 over the word you
wish to check. 
The Options Menu

The Options menu contains a list of commands that present you

with options sheets. The options sheets are used to set a docu-

ment's attributes. Options are universal to all PenPoint items.

Sometimes you will only have a single options sheet that you can

access, but all items, including bookshelves, have some options.

Since items like bookshelves do not have menus, you will have to

use the check mark \/ gesture to access some items.

To see the options available for any selected item:

1. Tap Y on the object you want to see.

2. Draw a check mark 1’ on the selected item

Or

Tap l” on the Options menu.

All selected options are indicated either with a check mark to the

left of a selected item, or with a text description to the right of the

Option label and an arrow between the text and the label.

Any option that has an arrow to its left is a pop~up menu and can

be selected using the steps described in the Pop~up Menu section.

When you see a label which has text to the right without an arrow

or a check mark, you are looking at an information label. The text

to the right of the label is there to show you some type of informa—

tion, identified by the label. This is not a selectable option.

To change a check—marked selection, tap l’ on your selection choice.
When you have multiple options all indicated by check marks, the
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check mark acts as a toggle switch. Tapping Y on a selection will
either select or deselect the option.

The options you will usually have for all documents are:

Controls All documents have controls. The Controls options

sheet usually looks like Figure 3.9.

The choices you will have depend on the type of document, but you

will usually have the following controls available for a document:

0 Show Controls By selecting this option, the document will
show the items checked in the Controls section below. When

you are showing a document’s controls, its borders are fixed

and not selectable. Usually the controls will be turned off and

Borders only selected when the document is embedded. The

gesture equivalent to switch between Controls and Borders

only is a flick up—flick down ll.

9 Borders Only Selecting this option hides all of a document’s

controls and only shows its borders. When this option is

selected you will have the choice of borders styles.

e Controls This section lets you determine which page controls

will be Visible in your document. You have the choice to show

any or none of the following controls:

—— Title Line

—‘ Menu Line Drawing an M in the title line will either hide
or show the Menu line.

—— Scroll Margins

— Cork Margin Drawing a C in the Title line will either hide

or show the Cork Margin.

 
 
 

 

Figure 3.9 // Example ) Contmls _

A Control Show: v’

options sheet

Con ttcl s

Borders only 
Controls: «l Tltle Line

v’ I lllleT'lU Line
‘4‘ Scroll l'v'l arg l ns

l Corlr lull argln
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0 Borders Borders are visible only if the controls are turned off.

The types of borders you can choose are: Single, Double, Dashed,

or None. As mentioned above, the borders are usually used for
embedded documents.

 
Access With the Access options sheet you determine whether or

not a document can be deleted and what type of access speed it

has. The Access options sheet usually looks like Figure 3.10. 
There are two options that are usually available from the Access

Options sheet:
”may

° Deletable Setting this option determines whether or not the

document can be deleted. The default setting is Yes, but if you

change it to No, then drawing a cross out X on the document

in a contents page will not work. This setting only works if

you try to directly delete the document. If the document is in a

section and you delete the section, the document will be

deleted with the section. Your choices for this setting are Yes
or No.

“mewawwk

 

9 Access Speed This setting determines how the 130 will work
with the document. Your choices are:

— Standard This is the default setting. When you turn away
from a document in a notebook, the document is closed and

all changes are saved to the EO's disk. This is the safest
mode to use. 

w— Accelerated If you choose accelerated access, the docu—

ment is kept open and changes are not written to the disk

when you turn away from the document. Using accelerated

speed will make accessing your documents quicker, but

there is a danger in using accelerated speed. Accelerated

 

Figure 3.10 f/ Example ? fibre? l

An ACCESS Deletable: D Yes i

options sheet Access Speed: > Standard
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speed requires more RAM, and changes are not saved

unless you close the notebook containing the document or

use the Checkpoint menu command.

If you have too many documents using accelerated speed,

you risk overloading the EO’s memory and losing all of

the information you have not saved. The E0 could suffer

from a malfunction because too much RAM is being used

to maintain accelerated documents. (The malfunction is

also called a crash.) Accelerated access speed should only

be used if you have lots of RAM, and then only with a few
documents.

Comments The Comments options sheet displays and allows

you to edit a document’s title and author. It also has a space where

you can enter text comments about the document. The Comments

Options sheet looks like Figure 3.11.

The following are additional options you will often find:

Layout When information is presented in a list format, you will

usually have a Layout options sheet that lets you select what infor—

mation you will view and how it will be displayed. Figure 3.12 is

an example of a Layout options sheet.

Your layout options will vary depending on the type of list you are

looking at. Each list Will have its own characteristics.

Paper Paper options are only available for some documents. With

the paper options you will select the style of paper and other attrib—

utes such as font, line spacing, and paper size. The actual choices

 

 
 

 
 

 

Title: ExampleA Comments

options sheet Author: rm Nsunel
Comments: 

Enter any thing you wish in this81“.?“ ,

  
 

 
 

Figure 3.1 1 Eviampte D Oji‘ni’nems

l

l

l
I
I
t
[

Kyocera PX 1046_1 12



Kyocera PX 1046_113

 THE PENPOINT OPERATING SYSTEM l4;

 

 
Figure 3'12 1/ Contents t Layout/ .

 
A Layout

options sheet   
i ;‘ ab Barr

~/ ! Coturnn Header

Sort By: r Page 
for the paper’s options will be determined by the application you

are using. Each application that has paper attributes also has its

own settings. Figure 3.13 is an example of the Paper options sheet.

Pen The Pen options are used to control the density and width of

a pen when using ink on a document. Some applications give you

extensive options for a pen’s attributes, while others give the basic

choices shown in Figure 3.14.

 
Embedding Documents

I previously mentioned that every PenPoint document is also the

application. Another feature of PenPoint that might clarify this

strange concept of documents being applications is its ability to
embed documents inside other documents. The technical name for

this ability is recursive embedding. When a document is embedded

in another document, what is embedded is not just the text or

image from the embedded document, but the entire document. In

other words, the embedded document is a fully functioning page

that has all of the capabilities and attributes of a document created

in a notebook’s contents page.

 

 

Figure 3.13 i/ txtinttwte > Paper r i
 

 
 
 

 

i A Paper i Page ayie:

options sheet
       

 
 

   4‘tit-Ht      
Font: r Roman {U P W] 
Line Spacing: > Standard (24 mints]

Paper Width: } Sfilfltnones  
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Flgure 3.14 /‘i i (iv-Mime > Fan

A Pen options Pen Style: « ,m/

sheet * /
my

  
It is possible to embed as many documents as you want, so you

could have a series of documents one inside of the other. This is just

like those wooden dolls where you open one and another is inside;

open that doll and there is another, and another, until you have over

a half—dozen dolls. The number of documents you can embed is

determined only by what is practical and the physical limitations of

your EO, such as how much disk space and memory it has.

There are a couple reasons embedding is important. One reason. is

because notebooks and contents pages are applications that con—

tain other applications or documents. A notebook’s sole function is

to hold all of your other documents, but a notebook is more than a

folder or a directory you find on other computer systems. A

Notebook has some of the attributes of a directory, but it is a

PenPoint application or document

The other reason embedding is so important is because it elimi—

nates the need to have large applications that perform many func—

tions. Instead, you can embed a MiniNote document inside a

MiniText document to show the picture that goes along with the

memo. So graphics capabilities are not needed in the MiniText

document because you can always embed a MiniNote document.

Another example would be embedding an E0 Calc document into

a MiniText document so you can show how you derived the num—

bers you’re presenting to your boss. Likewise, you can embed an
E0 Sound document to add a voice note to the same document.

The possibilities are endless. Figure 3.15 shows a Perspective doc—
ument embedded in a MiniNote document.

The document in Figure 3.15 is used as a tutorial, but you could

just as easily do the same thing with your daily schedule and fax

it to your secretary so he or she will know what you are doing.
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Figure 3.15

An embedded

Perspective

document
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Embedding opens all .kinds of possibilities for creative uses of the

E0. It is a capability that just screams to be taken advantage of.

To embed one document inside another document:

1. Open the primary document, the one that will have a docu-
ment embedded in it.

2. Draw a double caret A to get the Create menu

Or

Select for copying the document you want to embed using the

tap press -_l. gesture, and drag it to the primary document, placing

it where you want it embedded. The Spot where the document is

embedded will be the upper left-hand corner of the document; If

the document is in the wrong location, move it by pressing l on

the document’s icon and dragging it to the proper location.

3. Tap l’ on the embedded document to open it. When the docu—
ment opens, all of the controls will be Visible.

4. Use the embedded document’s size handles to set the docu-

ment’s Viewing area.
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5. Scroll the document to make what you want seen visible.

6. Select the Controls Option by drawing a check mark x/, and

select the Borders only option to hide the document’s controls

and set your border options

Or

Use the flick up-flick down it gesture to hide the controls and
display the document with a single black line as a border.

Remember, even if you have hidden the document’s controls

you can still View its options by drawing a check mark \/ on

the document’s page.

The document is now ready to be printed, faxed, or even sent to

someone else. The embedded document will print on the page just

as you see it.

Reference Buttons

PenPoint has provided the E0 with a very interesting feature

called Reference buttons. Reference buttons are a hypertext func-

tion built into PenPoint. Hypertext is a means for linking informa—

tion, so all you have to do is tap on a button to move from one

document to another or to another place within the same docu—

ment. With Reference buttons it is possible to access information in

a non-linear manner, by going from one point in a document to

another without moving through it page by page. In Figure 3.15,

the buttons in the Cork Margin are all Reference buttons that move

you through the tutorial.

One way to use Reference buttons would be to create a presenta—

tion where you have several documents in a notebook. You could
then create a MiniText document that contains a series of

Reference buttons that you could use to control which documents

are displayed and their display order.

Another example of how Reference buttons can be used is

included with the E0 in the Help Notebook. The index for the

Help Notebook is a MiniText document which contains nothing

but Reference buttons which open the document. Figure 3.16

shows the index for the Help Notebook.
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The number of ways to use buttons is limited only by your imagi—

nation. In Figure 3.17 you will see a document that contains but—

tons and an open notebook. The buttons can be used to control

which document will be displayed in the notebook. In a sense, the

Reference buttons are like notebook tabs, only they happen to be
in a MiniText document.

Reference buttons can be created and placed almost anywhere. A

favorite place to put them is in a Cork Margin. You can also use a

Reference button in one document to open another that may con—

tain related information. Basically, the following is a list of
Reference button uses:

0 To View a specific section of a document

0 To open a document

° To move from one section of a document to another

To create a Reference button:

1. Determine where you are going to create the Reference button,

whether it is a Cork Margin, the Bookshelf, or in a document.
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F'gure 317 532MB: Contents < 1 > '
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If you are placing the Reference button in a document, open
the document.

2. Select the document you want the Reference button to open by

selecting its title in the notebook’s contents page

Or

Select a word, or even a space character in the area of the docu-

ment you want Viewed, when the Reference button is tapped.

3. Draw a double circle as where you want the reference button
created.

4. Repeat steps two and three for each button you want to create.

After you have created the Reference button, or buttons, you can

alter the button’s name and appearance by opening the button’s

options sheet. To open a Reference button’s options sheet, draw a

check mark \/ on the button. Figure 3.18 shows the options sheet
for a Reference button.

Besides displaying the name of Reference button’s target docu~

ment you can also set the following options:

Kyocera PX 1046_1 18



Kyocera PX 1046_119

W‘was”.gateway”:Wmacwflsas“....
cigsmszswl..

Figure 3.18

A Reference

button's

options sheet

THE PENPOINT OPERATING SYSTEM Wl i!
 

/ t‘iiniText r Refer-ems E-uiion  
 
 

 

 

Button Label: To Do List

Button Borden r 8qu are
H o u n d
H aif— Round

2 Target Document: To Do Listi
E 

Button Label This is the button’s title. Once the button. is made

you can name it anything you want.

Button Border From the Button Border you can choose any of

the border options displayed in Figure 3.18. If you chose the None

option for the button it will appear as a line of text like the buttons

in the Help index, shown in Figure 3.16.

Reference buttons are a fantastic device. Hopefully, the examples

above will give you a few ideas about how to use them. You will

need to experiment with them to discover their full potential.

Using Notebooks

All of your information will usually be stored in notebooks.

Notebooks always reside on the Bookshelf and can be created by

drawing the caret /\ gesture on the Bookshelf. The last item in the

Create menu will be a notebook. Every notebook has a single page

when it is created. This page is the main Contents page.

The Contents page is used specifically for managing and accessing

the documents you create. You determine which documents will be

put in the notebook and how they will be presented on the Contents

page. The tasks that you can perform from the Contents page are:

0 Creating documents

0 Creating sections

0 Placing documents into sections

0 Turning to specific documents

0 Deleting documents

0 Rearranging documents and sections
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Besides a Contents page, every notebook can have tabs. In Figure

3.19, you will see tabs at the side on the side of the notebook. Tabs

are used to turn to the page associated with it. So you know

which page the tab will turn to, the tab always contains the docu—
ment’s name.

If you have a document that you want to access often and quickly

you can create a tab for the page by drawing a T on the document’s

title. This will cause the document’s title to be placed on a note—

book tab. The T gesture is a toggle switch and will also remove a

tab. Once the tab has been created, you can access the tabbed doc-

ument while viewing any page in the notebook by tapping l’ on
the tab. Any tab can also be removed by drawing the cross out X
over the tab.

A Notebook’s Contents Page

Every document has its own function, and the page elements that

are not common to all applications usually reflect these functions.

The Contents page of a notebook is specifically for storing and

ordering documents, so the contents page shows the all of the doc—

uments contained in the notebook. Another page will show an

area where text is entered or writing is done. The Contents page

has the following items:

Documents These are the applications you create and use.
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Labels Provide identification headings for the contents page

such as name, size, and page number for each section and docu-

ment contained in a Contents page.

 

Sections A divider in notebook that holds documents.

Create Menu This is the menu that is used to create new docu—

ments or sections.

View Menu Contains commands to show or hide the contents of

a section as well as commands to turn to a selected document.

The appearance of the Contents page is determined by its layout

options. Figure 3.20 shows the Contents page’s layout options.

vaprWWMmew-fiflafiw(M«M¢m\aw.w,.W7”Wata_,W...“.3»
Using the layout options you can set the following options:

Show You can show the document’s icon or a Square button
instead.

Columns These options determine what will be shown in the

contents page.

Type Shows the document’s type, that is, MiniText, MiniNote,
Section, and so on.

Date & Time Shows the date and time the document was created.

Size Shows the size of the document or section.

Tab Box Shows the tab box. The tab box is a check box. By tap-

ping ? the tab box, a check mark appears and a tab for the docu«
ment or section is created.

Column Header The column header labels each column with its

type name.
 

  
 

 
 

 
i Size

FIgUI‘e 3.20 4/ Content: t Lay'ow
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page layout _
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Sort By Gives you the option to sort the contents page by any of

the View types. If you wish, you can View your documents sorted

by name instead of page number.

Figure 3.21 shows the Contents page sorted by name and display—

ing the name, page, type, size, and tab box in addition to the
labels.

How you View the Contents page is completely up to you. Each

person will have their own preferences. Personally, I prefer to have

my information sorted by name rather than page number.

Creating Documents and Sections

Documents and sections are both created in the same way, using
the Create menu.

To create a new document:

1. Tap Y on the Create menu

Or

Draw a caret A on. the Contents page.

2. Select the type of document you want to create from the Create
11181111.
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Figure 3.22 Shows the Create menu as it can appear in a note—

book’s Contents page.

Usually your documents will be categorized and stored in sec—

tions. Each section is also another page in the notebook. Sections

are dividers that act like tab dividers in a real notebook, except

that you can put sections inside of sections and create a hierarchi—

cal filing system for your documents. Figure 3.23 shows a sec—
tion’s contents.

 

Displaying a section’s contents is called expanding the section,

and it is done by double tapping ,l’ on the section heading. When a
section is expanded like the one in Figure 3.22, it can also be col—

L lapsed; then, the section’s contents are no longer Visible by double
tapping ,l’ on an expanded sections heading. In Figure 3.23 you can
see the expanded E0 section which contains additional sections

and one document. Figure 324 shows the section page for the

expanded section in Figure 3.23.
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Notice that the page number for the section page corresponds to

the page number in the table of contents shown in Figure 3.23. All

documents in a notebook have their own page numbers and you

can turn from page to page using either gestures (described in the

preceding Gestures sections) or by tapping on the arrows (< or >)

on either side of the page number.

Menus Specific to Notebooks

There are two menus specific to a notebook’s Contents page. One
is the Create menu which is used to create a new document or sec—

tion, placing it in the Contents page. And the other is the View

menu which is used to expand and collapse sections. In this sec—

tion we will take a quick look at the View menu.

The View menu works on the Contents page as a whole or on

selected sections or documents. The View menu has just the four
choices listed below:

Collapse Causes the selected expanded section to collapse so its

documents can’t be seen. If no section is selected, all expanded sec-
tions will be collapsed.

Expand Causes the selected section to expand showing the docum
ments in the section. If no section is selected all of the Visible sec-

tions will be expanded. This command can be repeated until all
nested sections are Visible.

Turn To Turns to the selected section’s or document’s page.
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All notebooks have pages. Some of the pages are indicated by note—book tabs on the righthand side at the notebook. Only some of a
notebook’s pages will be tabbed. All tabbed pages have the page’s name
on the tab. To select a page you can use any of the toilowing options:

0 Top 1’ on the tab with the name of the page you want to choose.

0 Tap l’ on the page’s name in the Contents page it its icon is a check
box.

0 Tap l’ on the page’s icon or check box.

0 Tap l’ on the page’s page number.

0 ti the accessory or notebook has page numbers in the Title line, you can
use either a left ~— or a right .— tlick on the Title line to turn one page to

the left or right.

Performing a double tap _l’ instead of a tap l” will open the page as a Float»
ing page rather than turning to the page in the notebook. This convention

also works on a notebook’s tabs. Double tapping I will not work it the
Floating Page option in the Float & Zoom page of the Settings Notebook is
not turned on.

Bring To Opens the selected section or document as a floating
Window.

Double tapping _l’ on a section’s title is the same as selecting a sec-
tion and choosing either the Collapse or Extend menu. The Turn

To menu item’s equivalent is tapping l’ on a document’s page
number or icon, and the Bring To menu item’s equivalent is dou—

ble tapping .l’ on the page number.

Organizing Your Information

Since the purpose of the notebook and the Contents page is to

organize your information, it might be nice if we looked at how

you can organize or reorganize your information.
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When you create documents and sections you can either create

them, then move them to the section you want, or you can plan

ahead and actually create the new documents and sections where

you want them in the first place. First, we’ll look a moving your
data about.

To move a document from one section to another:

1. Open the section in which you want the document to reside.

2. Select the document you want to move by pressing i on the

document’s title. A single marquee will appear around the
document.

Or

Select the document by tapping Y its title and select the Move
command from the Edit menu. A single marquee will appear

around the document indicating it is ready to be moved.

3. Drag the document to the section you opened in step one.

4. Repeat steps one through three for any other documents you
want to move.

The same steps will also work for moving sections. When you
move a section, all of the documents in a section are moved. When

you move a document, its page number will change to correspond
to its new location.

To create a document or section inside another section:

1. Open the section in which you want the new item to reside.

2. Select the section’s title and use the Create menu to create the

new document

Or

Draw a caret A directly under the section’s title where you
want the new document created.

These techniques will place your new documents in their proper

sections. You can also copy documents listed in a Contents page
and move them to other notebooks or the Bookshelf, or embed

them in other documents.
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To copy a document:

1. Open the section, notebook, or document in which you want

the copied document to reside. If you are moving the docu—

ment to the Bookshelf, make sure you can see the Bookshelf.

2. Select the document you want to move by tap pressing i on its

title. A double marquee will appear around the document

Or

Select the document by tapping Y its title, and select the Copy
command from the Edit menu. A double marquee will appear

around the document indicating it is ready to be moved.

3. Drag the document to its new home, the section, document, or

notebook you opened in step one.

4. Repeat steps one through three for any other documents you

want to copy.

Any time you either copy, create, move, or delete a document, the

page numbers in your notebook will be renumbered.

To delete a document:

1. Select the document to delete.

2. Draw a cross out over the selected document or section

Or

Select the Delete command from the Edit menu.

E

l
i
.

 

When you delete a document it is gone forever. Unless you have

copied it to another location (made a backup, see Chapter 10) the

information contained in the document is lost and there is no way

to retrieve it. Remember, if you delete a section, documents that

, have been set as undeletable will still be deleted. Always make

sure you back up information you do not want to lose. Chapter 10

has instructions for backing up your data.

Auxiliary Notebooks
Auxiliary Notebooks are special PenPoint notebooks that appear

on the main Bookshelf. Each of these notebooks has a special func-
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tion and is used to store specific types of documents. The

Auxiliary Notebooks are:

a Help

«‘9 Settings

6’ Stationery

e Accessories

9 lnbox

0 Outbox

6* BC) Phone

EO Phone is the only Auxiliary Notebook that is not a PenPoint note‘

book, This is a special notebook that will be found only on an E0.

When an application is installed, additional help files can be

added to the Help Notebook. These enhance the EO’s Help func—

tion. Several of the packages currently available for the E0 do an

excellent job of providing auxiliary help files.

"the Settngs Notebmk

The Settings Notebook contains pages that are used to set your

EO's system preferences. Figure 3.25 shows the Contents page for

the Settings Notebook.

There are three sections in the Settings Notebook. The first section

is the Preferences section and the subject of Chapter 4. The next
section is the Installed Software section, and the final one is the

Status section. The next two sections will look at the Installed

Software and Status sections.

installed Software

The primary use for the Installed software section is to look at

what software is installed on the E0 and to perform the installa-
tion and deinstallation of software. When software is installed on

the 130 it is always put on the disk drive that is running the E0, or

the same disk that is represented by the main Bookshelf. No disk

space is saved by installing software onto another disk drive.
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Normally, when software is installed you install it from a floppy

disk or by using a PenCentral file server (see Chapter 7).

Regardless of the source of the software being installed, you will

usually use what is called a Quick Installer to install the software.

A Quick Installer is an automatic installation program that

PenPoint uses to make sure all software is properly installed.

Figure 3.26 show what a Quick Installer looks like.

There may be times when the Quick Installer is not included with

the software you want to install. When this happens you will have

 

Figure 3.26

A Quick

lnstoller
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to install the software manually. Before we look at manually

installing software, let’s look at the software categories. To view

the software that is installed for any category, tap Y on the cate~
gory’s title in the Settings Notebook’s Contents page. For each cat—

egory you will see a page that looks like Figure 3.27.

The software categories are:

Applications These are the programs that are installed on the

130. Each of the applications usually has a corresponding section

and document(s) that are placed in the Stationery Notebook.

Services Services represent a class of software that is used by the

E0 at a very low level. They are commonly called device drivers.

They control hardware functions and provide capabilities like

printing and modem access.

Handwriting This is the software that recognizes your handwrit~

ing and translates what you write to text.

Gestures This is the software that recognizes the gestures you

draw and tells the E0 what to do when you draw a gesture.

Dictionaries This is the dictionary that is accessed when you

spell check or proof a document or a word.

Fonts The fonts are the various typefaces you can access from

other applications.
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User Profiles This software stores the preferences you set from

the Preferences section of the Settings Notebook.

If you have to manually install any of these types of software, the

procedures for doing so are the same, regardless of the category

The only caution about installing software is that you should

always follow the software publisher’s instructions. If the software

publisher has instructions that are different than what you find
here, follow their instructions rather than mine.

To install software:

2; 1. Open the page for the type of software you want to install.

2. In the Installed page, tap Y on the Install... menu. You will see a
page similar to Figure 3.28.

3. The icons across the top of the page are disks that are con~

nected to the E0. Tap Y on the disk icon for the disk that con—
tains the software you want to install.

4. The installable software on the disk will appear beneath the disk

icons, and the disk that you opened will be grayed out. Figure

3.29 shows the Installable Software page with an open disk.

5. Tap Y on the Install check box. You will receive a message say—
ing that the software is being installed.
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When the software is installed it will be copied to the disk drive

that is running the E0, which is the same drive that creates the

main Bookshelf. Once the software is installed, you will see its

icon in the list of software from the Installed Software page.

There are two ways to deinstall software. Before you deinstall any

software make sure you know why you are deinstalling it. If you

deinstall an application, any documents that belong to the applica—

tion will be inaccessible, so you will not be able to use the docu~

ments. If you deinstall Service, Gesture, or Handwriting software,

the EO will not work properly, if at all. You could even cause

enough software damage that you might have to reformat your

hard drive. Or, if you are using a RAM—based EO, you could lose

all of your information.

To deinstall software:

1. Open the page for the type of software you want to install.

Tap Y on the name of the software you want to deinstall.
9’!“

Select the Deinstall command from the Edit menu by tapping l’
on the Edit menu, and then tap Y on the Deinstall command.

4. You will receive a dialog sheet asking if you really want to

deinstall the software. Tap l’ on the Yes button.

These steps will cause the E0 to remove the software and erase it

from your disk.
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The alternative method for deinstalling software will not erase it

from your disk, but it will work only on some items. The alter-

native method is:

1. Open the page for the type of software you want to deinstall.

2. In the Installed page, tap Yon the Install... menu. You will see a
page similar to Figure 3.28.

 
3. The icons across the top of the page are disks that are connected

to the E0. Tap Y on the disk icon for the disk BOOTVOL, which
is the disk that runs your E0.

4. The software you can deinstall this way will appear beneath

the disk icons. Figure 3.30 shows the deinstallable software on
the disk BOOTVOL.

5. Tap Y on the Install check box.

6. You will receive a dialog sheet asking if you really want to

deinstall the software. Tap Y on the Yes button.

i

5,,$2

i

k

 

Deinstalling software this way makes the software inactive, but it

is left on the disk so you can reinstall it. Remember, be careful

when deinstalling software. If you do not know why you are dein—

stalling software, don’t do it.
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Figure 3.3%

The Storage

Summary

page

Status

The Status section of the Settings Notebook provides you with

information about your E0. The three pages you can access are:

9 Storage Summary

3 Storage Details

e PenPoint

All of these pages are information pages only. They contain no set—

tings or options. These pages can be useful for diagnostics if your

EC) is not acting properly And the information can be useful for

determining how much disk space and memory your system has

available. Otherwise, you won’t be looking here very often.

The Storage Summary will tell you how much disk space and

memory is being used and how much is free. The Storage

Summary page looks like Figure 3.31.

In Figure 3.31 you can see that almost all of the hard disk space and

memory on this E0 is being used. With so little memory available I

would be wise to consider getting a memory upgrade. This is

because the more RAM that the ED has to use, the happier it is.

Insofar as the hard disk is concerned, I might consider removing

some of the applications or documents from the disk. If you have

less than 1 MB of free RAM, you should consider increasing your

EO’S RAM. You can also delete documents you are no longer using.
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To get at better idea of how the disk space is being used you can

look at the Storage Details page. On this page you get a configura-

tion summary and a breakdown of how the E0 is using hard disk

space. Figure 332 shows the Storage Details page.

 

This page breaks down how your RAM is being used if you are

using a RAM-only system or how data is stored on your hard

drive. What is interesting in Figure 3.30 is that there are very few

documents that l have created on the hard drive. Although it says

that 1332 megabytes are used for documents, most of those docu-

ments are support documents for the applications that are
installed and not documents like MiniText or MiniNote docu—

ments.

Also, since the PenPoint operating system is in ROM, it is not

using any disk space, which means I have full use of the hard disk

for applications and documents. This is just something that is nice

to know It does not affect how your E0 works at all.

The final page in the Summary section is the PenPoint Page. On

this page you see information about the version of PenPoint that

your ED is using and the version number for your ROMS. Figure

3.33 shows the PenPoint page.

Your PenPoint page will not look like the one in Figure 3.33. It

may be similar but it will not, nor should it, look like the figure.

The PenPoint page is Where you will look to make sure you have
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properly installed any ROM updates that you might get from E0

Inc. Because the ROM versions can quickly change, I’m not going

to provide any numbers here about what you should have. If you

have any questions about whether or not your system is up to

date, you should contact E0.

The Stationery Notebook

The Stationery Notebook is another auxiliary notebook that is

required by PenPOint. The Stationery Notebook contains all of the

documents you can create when you access a Create menu. When.

you install software, the installation process always makes a sec—

tion for the software and places at least one document into your

Stationery notebook.

The document that is placed into the Stationery Notebook is a tem—

plate. When you use a Create menu, the document you create is

actually a copy of one that is in your Stationery Notebook. In

Figure 3.34 you will see the contents of a Stationery Notebook.

NOTE Many people make the mistake of editing documents in then
Stationery. Doing this will p etuate these changes throughout a//
subsequent documents createcfhom the Stationery document It oyu
make this mistake, simp/y open the Stationery document and delete
your changes

In the Stationery Notebook there is a column labeled Menu which

has a Check box. Any document that has its menu box checked will
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appear in your Create menu. By selecting the documents you want

included in your Create menu, you can essentially customize it.

And to take the customization one step further, you can also cus~

tomize the documents in the Stationery Notebook.

You can add your return address and maybe embed your company’s

logo into a MiniText document. After you have created a document

that you want to use as a template, you can copy it to the MiniText

section of the Stationery Notebook, check its menu box, and it will be

available as a menu item every time you invoke the Create menu.

Using this technique, you can make specialized stationery that meets

your specific needs, including personal and business stationery, fax

covers, weekly report templates, or any other special purpose docu—

ment. You’ll never have to write your return address again. The only

drawback to adding lots of documents to your Create menu is that it

could take longer for the Create menu to pop up.

The Accessories Notebook

The Accessories Notebook is a special purpose notebook that

holds utilities. When you first get your E0, the Accessories

Notebook has the following items in it.

Clock Displays a digital clock that shows the date and time.
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Connections Used to access additional disks and set up your

printers. This utility is covered in depth in Chapter 10.

Keyboard Displays a Virtual keyboard so you can enter letters

and numbers by tapping Y on the keyboards keys, thereby enter-
ing the characters into a documents.

E0 Lock Prevents unauthorized access to your E0.

PenTOPS Modem Connects to a PenCentral file server using the

EO’s modem. This utility is also discussed in Chapter 10.

Each of these are special~purpose applications or utilities. Utilities

are small programs that do not create documents but instead are

designed to fill a very specific need. All utility programs are stored

in the Accessories Notebook. You can copy a utility and place it on

the Bookshelf, in a Cork Margin, or a notebook, but you cannot

put anything into the Accessories Notebook.

The only way additional accessories find their way to the

Accessories Notebook is if that is where they end up when they are

installed. Figure 3.35 shows an Accessories Notebook that has SEV“

eral additional utilities which you can read about in Chapter 12.

To open an accessmy:

1. Tap Yon the Accessories Notebook which is on the Bookshelf.
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2. Tap Y on the accessory you want to use.

When the accessory you selected opens the Accessories Notebook

will close unless you have turned off the Auto—Close feature in the

Accessories option sheet.

To access an option for any application on the E0:

1. Tap Y on the Options menu

Or

Draw a check mark \/ on the application’s page or over the

item whose options you want to View.

2. Tap Y on the Options menu item you want to select

Or

To select an option using the pop—up menu in the Title bar see

pop—up menus below.

After you have opened an accessory, the Accessories Notebook

will automatically close. The Auto-Close is a feature of the

Accessories layout options.

If you do not want the notebook to close automatically:

1. Open. the Accessories Notebook.

2. Select the Layout option from the Options menu by tapping Y
on the Options menu and then the Layout option

Or

Draw a check mark \/ in the open Accessories Notebook.

3. Set the Auto-Close setting to No by tapping Y on the word Yes
and selecting No from the pop—up list.

The Inbox Notebook

The lnbox is the notebook where all incoming E—mail and faxes are

placed. You cannot put anything into the Inbox unless it comes

into your EO through the modem. All you can do is set its options.

The lnbox is discussed in Chapters 8 and 9.
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The Qutbox Notebeek

The Outbox is the notebook where all outgoing E—mail, faxes, and

documents to be printed are placed. You cannot manually put any

thing into the Outbox. All you can do is set its options. The

Outbox is discussed in Chapters 8 and 9.

Technedl Overview

This section is a brief description of PenPoint from a more techni~

cal viewpoint. It is intended for those who want a more technical

understanding about how the E0 and PenPoint work together.
Because the E0 is so new, there is a lot to learn about it and

PenPoint, and this brief section will not do justice to either. But it

should be enough to get someone with a technical bent started.

PenPoint is a priority—based, pre—emptive multitasking operating

system. The impact of this is two—fold. The multitasking environ~

ment allows all applications to perform background tasks. This

can result in the automatic updating of documents which are

linked, even though the documents are open or currently running.

One application, Numero, takes full advantage of this feature.

(Numero is discussed in Chapter 11.)

Another advantage of PenPoint’s multitasking capability is that it

allows the E0 to perform several tasks simultaneously. If for some

reason one of the tasks being performed should fail, the failure

will not cause the other tasks taking place to stop. This ability

alone is something that Macintosh and Windows users have been

dreaming of and begging for, but at the moment it is only available

on the little E0, or on large work stations running operating sys—
tems like UNIX.

For all this power, you do have to pay a small price. You will need

more memory if you load the E0 up with applications. If you have

too many applications installed, it is possible you may see some

erratic results because too much memory is being used to maintain

applications that you are not currently using. Each application has

a sliell or kernel that is constantly kept in memory at all times. So it

is possible to have an application installed that is not being uti—
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lized, but it is still using both disk space and memory, when the

memory could be better used by applications you are actively

using at the moment.

PenPoint also uses an object—oriented architecture. This allows for

a consistent implementation of the user interface. Being object-ori-

ented allows the EO’s applications to access, share, and reuse com-

mon or pre-existing programming code. Also, applications can

share code with each other and with the system.

The benefit that this technology provides to the user is that pro—

grams can be written which are smaller, requiring less disk space,

while at the same time having more features. When combined

with PenPoint’s ability to embed documents, programs can offer a

greater versatility and power without the need for larger hard

disks, more memory, and larger machines.

One of the 130’s strongest features is its ability to run without a

hard drive. This is because the entire operating system is ROM—

based, and its memory management is so efficient that some peo—

ple, even when they have hard drives, are running their EOs using

their RAM only. Running an E0 in this manner conserves battery

life and increases the EO’s speed because it does not have to use

power or wait for the hard drive to spin up.

Another feature of PenPoint is how it protects itself from inadver—

tent problems caused by the user accessing system files. With

PenPoint there is no way to look at the boot volume’s directory

structure, so there is also no way of accessing the operating system

other than with the utilities provided in the Settings Notebook

where preferences can be set. Although some of you, who really

like to see the guts of the operating system and like playing with

computers by dissecting the system, may be disappointed, this is

really a life saver for the average user. They cannot accidentally

cause an E0 to malfunction because they deleted some essential

system file.

Other features of PenPoint include power monitoring and the

automatic shutdown of processes to conserve battery life and to

safeguard information, transparent networking from a system

level, and modular extendibility. If new features are developed for
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PenPoint, you will not necessarily need to upgrade your ROMS.

You will have an opportunity to take advantage of the new fea-

tures through patches to the operating system that will be made

available by EC Inc., on a quarterly basis. You do not have a

machine that will be out—of—date because it can’t be easily

upgraded or because it does not have the power to take advantage

of the upgrades.

Conclusion

Some of you who read this chapter will be disappointed because it

was not technical enough, while others will read it and say, “Oh,

my Gosh! I can’t remember all of this.” Either way I lose. What I

hope is that there was a little bit for everyone and that this chapter

will give you the grounds for doing some very creative things

with your E0.

The E0 is not just some little, but expensive, electronic address

book. In its little package you have an operating system and hard-

ware that can shame a desktop computer. By now, if you are read—

ing this in sequential order, you can see why the E0 is a personal

communicator and not just a computer that uses a pen. There is no

operating system that integrates how everything operates as com~

pletely as Penl’oint, and. there is no a computer that takes advan—

tage of Penl’oint like the E0 Personal Communicator. Combined,

they are more than the sum of their parts.
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Customizing
Your E0

To get the most from your EO, you should customize some of your

EO’s settings. The Settings Notebook (see Fig. 4.1) is Where you

can set up all of your hardware and software preferences.

Although the Settings Notebook does not have the same layout as

the default Notebook or the Help Notebook, it is still considered a

notebook. The preferences you set apply to all documents and
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Distinguishing bemeen restate pennant: " ‘  
Ail of the settings in the Settings Notebook are PenPoint system settings, lPenPaint is the operating system that controis the E0 Personal Com— t
municator. The company that created PenPoint is the GO Corporation, and l
although they work with E0 inc., they are not owned by or part of EC).
There is a version of the PenPoint operating system made for computers i
that use an Intel processor; these are machines that could run MS~DOS or
the PenPoint operating system.

 

 

 

Just because a computer uses the PenPoint operating system does not nec»
essarily mean it’s a Personal Communicator. To get a Personal Communi-
cator, you need a device that was designed for personal and business
communications from the beginning, and not added to a computer as an
afterthought. All of the lntel—based computers that can run PenPoint can
also run MS—DOS; they are designed first as computers, with their commu~
nications capabilities being add‘ons rather than the basis of their design or

the inspiration for their creation.

What you have in the E0 Personal Communicator is a device that is the
resuit of two vendors who worked together to bring you a highly sophisti-
cated product. The PenPoint operating system is very complex and powern
ful and requires a sophisticated device to take full advantage of its

features. Likewise, the E0 is also a complex and powerful device, ,
designed specifically to use GO's PenPoint operating system. Because of i
the EO/GO relationship, the E0 Communicator is more than iust another ’7
computer that uses the PenPoint operating system.

 
 

in addition to the EC) being designed to take full advantage of Pen»

Point, there are also features of the E0 that were designed specifically
for the EC) Communicator that wiil not be found in any lntel—based com
puter even if it is running PenPoint. Some of these features are the E0
applications like EO Phone, EO Sound, EO Lock, Personal Perspective,
and E0 Calc.

The PenPoint operating systems uses a set of standard conventions for
selecting and indicating selected items. Because this chapter is about set-
ting the EO’s system preferences, these conventions will be listed here

rather than repeated over and over again for each preference setting
discussed.

First, we’ll iook at how PenPoint tells you what is currently selected. All
selected options are indicated in one of two ways:
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0 A check mark to the left of a selected item,

Or

0 A text description to the right of the Option label with an arrow between
the text and the label.

Any time you see a label which has text to the right without an arrow or a
check mark you are looking at an information label. The text to the right of
the label is there to show you some type of information, identified by the
label. This is not a selectable option.

Before you can change an option you have to open the Settings notebook
and select the options page you want.

To open the Settings notebook and select an options page:

i . Tap l’on the Settings Notebook which is on the Bookshelf.

2. Tap l’ on the label or the box to the left of the label of the options page
you want to open.

To change a checked selection, tap on your selection choice. in Figure 4.2
you would change the Pen Cursor from Off to On by tapping l’ on the
word On.

To change an option with a text description:

0 Tap Y on the arrow to the right of the option label,

Or

0 Tap Y on the text field to the right of the arrow.

Either of these actions will cause a menu to pop up From the pop~up menu
tap l’ on select your option choice. The text field to the right of the arrow
will display your choice.

' Draw a right flick .. on the text field to the right of the arrow to select

the previous option in the pop-up menu

Or

0 Draw a left flick ._ on the text field to the left of the arrow to select the

next option in the pop—up menu.

(continued)
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Either at these options will work on any option that uses a pop-up menu.
All options that have a pop-up menu can be identified by the arrow to the
right at the option’s label and a text Field to the left. The Writing and Pen
Timeouts as well as the Title line in Figure 4.2 are examples at options that

have pop-up menus. The two bulleted selection methods can be used to
flip from one Settings option page to another when the action is performed
on the arrow or text field in the Title line.

There is one other selection method you might see in 0 Settings Notebook’s
options page. This is a button. It an option has a button it means that the
option is really a command, and tapping Yon the button will execute the
command. A button can always be distinguished from an option variable
because there wiil be no check mark or arrow between the label and the

text to the right. Aiso, the button’s text will have a border around it.

Finally, at the bottom at each settings page you wiil find an Appiy button.
Any changes you make will only take effect otter you tap l” on the Apply
button. it you make a change and then leave the page your setting
changes will be canceled and won't take ettect.

  
 

 

 

 

 

Figure 4.2 1/ Preferences. > F‘en

The Pen Tap to Align Pen: El

preferences Pen Cursor: CH] O
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applications on your EO. To open the Settings Notebook, tap l’ the
Settings icon on the Bookshelf.
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Figure 4.3

The Settings
Notebook

contents page

In this section, each of your EO’s Preference settings will be looked

at and explained. The Status Notebook is a system notebook that is

used to set your EO’s system defaults. The Status Notebook con"

tains three sections: Preferences, Installed Software, and Status. The

Installed Software and Status settings will be discussed in detail in

Chapter 3. The remainder of this chapter will examine the Prefer-
ences Section.

The Preferences Section

In the preferences section of the Settings Notebook you will find

all of the user—definable settings for your EO. These are system-

level settings and apply to every document. There are some occa—

sions when a document will allow you to override one of the

system settings, but to do so is a deliberate act, a setting that you

change as an option within the document itself. Figure 4.3 shows

you the Settings Notebook contents page.

Under the Preferences section you will see that there are eight

preferences settings. The first four on the left determine how your

EO’S screen will look and feel. With these four settings you will be

personalizing your E0 to meet your needs and desires. The four

settings on the right are system settings for date, time, sound, and

power conservation. These settings do not affect how you interact

 
/
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with your BO, but they are important to set anyway. If any terms

in the list below are unfamiliar, don’t panic, they will be explained

in this section. From within the Preferences section you can select

any of the following system options:

Writing Selects the writing style, the type of writing pad, the

writing pads box size and shape; sets the character for unrecog-
nized characters.

Pen Aligns the pen, selects the pen cursor and the default pri-

mary input, writing, and press time-outs.

Fonts and Layout Selects the PenPoint font, the field font, font

size, the 130’s orientation, hand preference, and scroll margins.

Float and Zoom Allows or disallows floating and zooming docu-
ments.

Date Sets system date and format.

Time Sets system time and format.

Sound Turns the system warning beep on or off.

Power Puts the E0 into Standby, shuts it down, sets the auto

Standby, sets the auto shutdown from standby, turns on or off the

wireless module, sets the device auto power off, checks the battery
level.

All of these settings are important because they determine how

your EO will behave and what it will do under specific circum~

stances. The system settings are also how you will set your per—

sonal preferences for your document’s appearances. The following

sections discuss each of the preference settings in detail.

The Pen Settings Preferences

Because the first preference you should set on your EC) is pen

alignment, we’ll look at the Pen preferences first. To set the pen’s

preferences, open the Settings Notebook and turn to the Pen pref—

erences page. The Pen preferences page looks like Figure 4.4.

The Pen preferences you will be setting are:

0 Pen Alignment

0 Pen Cursor
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Figure 4.4 : waif , Pg ,,i.____

i The Pen Tap to Align Pen:

i preferences Pen Cursor: g Q”

Sel'lings Q
Primary Input:

 
Writing Timeout: t 0.5 Seconds
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0 Primary Input
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a Writing Timeout

9 Press Timeout

Each of these preference settings will be discussed in this section. 
Adjusting the Pen’s Alignment

The pen’s alignment is one of the most important settings you can

make. The alignment will affect how the EO reacts to your com~

mands, your writing, and the EO’s character recognition capabili~

ties. If you do not adjust the pen’s alignment you will find strange

things happening when you tap l’ and try to select various objects.
You will end up being very frustrated because the pen will not be

tapping where you place it, your writing will not translate cor~

rectly, and you will wonder why your ED is not working properly.

 

 

To align the pen:

1. Hold the pen and the EC) as you will when you are using it.

2. Press i the pen to the center of the cross hairs where it says

”Tap to Align Pen.”

3. Continue to press until the entire box highlights.

g
l
i
ii

i.
t

l
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Figure 4.5

The pen cursor

CHAPTER 4

This process aligns your pen for the angle at which you will be

holding it. You should realign the pen when there are radical

changes in how you are using the E0. If you are cradling it in your

arm and writing while standing up, you should align the pen for

that position. Likewise, if you’re using the E0 at a desk and

you’ve aligned the pen while standing up, it should be realigned.

The Pen Cursor

The next setting is for the pen cursor. When the Pen Cursor is

turned on your EO displays a small cursor like the one in Figure

4.5. I think this can be helpful, especially while you are learning to

use the E0, for determining where your pen is while writing on

the E0. However, EO does not recommend using the pen cursor.

They say it seems to screw up pen alignment (causing the pen to

drift out of alignment) and slow down performance. The pen cur-

sor is really intended for use with the E0 880 While doing presen—

tations on a VGA monitor. If you want to use the pen cursor, turn

it on by tapping Y ”On.”

Setting the Primary Input

You can connect a keyboard to your EO at those times when you

need to type a long document. If you do, you may want to change

the primary input from the pen to a keyboard. The Primary Input

setting makes it easier to find the insertion point (where the text

 

Preferences > Pen
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will appear when you type) while using the keyboard. Experi—

ment to see if you really want to change this setting when you

connect a keyboard. (Attaching a keyboard to your EC) is dis—

cussed in Chapter 1.) It is not necessary to change this setting if

you do not want to.

The Writing and Press Timeouts

The last two settings in the Pen Preferences are the Writing and

Press Timeouts. A timeout is how long the system will wait before

performing a task. In the case of the Writing Timeout, the amount

of time you select tells the system to wait six tenths of a second

before interpreting the letter you wrote if your setting is the same

as that in Figure 4.6.

If your EC) is not recognizing your characters and you are sure that

you are properly drawing them, then you might want to increase

the Writing Timeout. On the other hand, if after you write a ges-

ture or a letter the E0 takes too long to recognize the command

you may want to shorten the Writing Timeout. To begin with, use

the system with its default setting of six tenths of a second then

adjust the Writing Timeout to suit your needs.

The Press Timeout controls how long the E0 waits before selecting

an object after you have tapped, pressed, or tap pressed on an

object. When an object is selected it is highlighted, and when you

/f Preferences: > Pen 

Tap 10 Align Pen: _l_

Pen Cursor: On
  
 

Primary input:

WritingTimeoul: >1:

Press Timeout:

 
 

1.0 Seconds
12 Seconds
1.5 Seconds
20 Seconds
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want to copy or move an object it gets a double or single marquee,

respectively. Figure 4.7 shows a document with a double marquee,

meaning that it is now possible to copy the document.

Adjusting the Press Timeout will determine how long your EC)

waits before the marquee appears around the objects you select.

The system default for this setting is a half second. If your taps are

being interpreted as presses (a single marquee appears around the

object) or tap presses (a double marquee appears) you should

increase the Press Timeout. Likewise, if you are waiting too long

before getting a response you may want to shorten the Press Time—

out. This is another setting you should experiment with after you

have some experience with your EC).

Adjusting the Writing Preferences

After you adjust the Pen Preferences, the next set of preferences

you want to look at are the Writing Preferences. (But then again

you already knew that by this section’s title.) When you open the

Writing Preferences page it will look like Figure 4.8.

 

  
Figure 4.7 / t-totezzm 3 «T 7 2x

if)=tu;:i,,ir !r:‘r'i Exili’ Ci! :uiigr'g a», ._,.; rir:
A document I F ' ,

selected for l Pi”:D T ap Page 2 For Tutorial . 2

COpying [D E‘ersonal Perspective. , V ., . , ,, . . ., 13
33 Day F'Iarmer, ., . . W HI“.
 

  
‘mi.

I_L _

 
 

 _L (c: gszlu'ip'fi'j12:1”ng.iiQI‘jjzjlquijlgfj
was 

 

Kyocera PX 1046_152



Kyocera PX 1046_153

Figure 4.8

The Writing
Preferences

page
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/ Preferences > Writing

Writing Style: » Mixed Case

Writing Pad: > Boxed

Box Size: » tw‘iediurn

Box Shape: b Medium

Fiuled Height: > Medium

Unrecognized > 3
Character:  Shrewenzymes19‘eisuisajiiaieiaisuiawm V3iIi _id‘_   

The Writing Preferences are used to set the following PenPoint
attributes:

9 Writing Style:

0 Writing Pad:

9 Box Size

6 Box Shape

0 Ruled Height

9 Unrecognized Character

Each of these settings will be discussed. in the order that they

appear.

Writing Styles

The Writing Style is where you tell PenPoint how you normally

write, whether you use all upper—case letters or mixed—case letters.

If you normally use all upper—case letters when you write and

choose to use this option, your E0 will automatically mix cases by

using basic capitalization rules, capitalizing the first letter of each

sentence and proper nouns.
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Also, if a word’s case is incorrect it is very easy to fix with Penw

Point gestures. (These gestures were covered in Chapter 3.) Should

you tell the E0 that you are going to use mixed—case writing (the

default setting) it will represent your words as you write them or

as it interprets what you write.

Nfifi'e As we look at these different settin 5 I’m going to tell you to experi-
ment with them. I’m not trying to ie redundant. I really mean that
you should experiment with different PenPoint settings. If you take
my word for what is best without taking the time to see if something
works for you, you will be cheating yourself in the long run.

Something as simple as changing the Writing Style might make

the difference in your EO experience being fun and productive

rather than frustrating. But you won’t know unless you try the dif—

ferent settings. You should use the alternate settings long enough

to get a real feel for how they work, I would say at least a day.

And, if you really don’t like how the change functions, you can

always change it back.

Writing Pads

A writing pad is a pop-up or embedded pad that you write on.

There are three types of writing pads: boxed, ruled/boxed, and

ruled. After you are finished writing or you fill up the pad, the E0

translates what you have written, turning it into text. Each of these

options operate differently and can dramatically alter how you

work. Figure 4.9 and 4.10 show the types of writing pads.

When you use a writing pad with E0, the process of translating

your writing occurs in either two or three steps. With a ruled writ”

ing pad, translation happens in two steps, you write the letters,

and when you tap OK, what you have written is translated and

immediately inserted into your document.

If you are using either boxed or ruled /boxed pads you will write

your letters and press OK. After tapping OK the E0 translates the

letters and places the translated letters into a boxed writing pad

for editing. After you edit the translated letters and tap OK, they

will be inserted into your document. Figure 4.11 shows the steps

that occur when using a boxed or ruled/boxed writing pad.
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Figure 4.10
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The ruled writing pad should Only be used by those who have

very clear and precise writing because you do not get a second

chance to edit what you have written.

If your writing is like mine you will probably want to use the

boxed writing pad. My writing is getting better, but I have to edit
at least 10% of what I write. If I were to use a ruled pad I would
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3. Edited 4. Inserted

end up editing everything I wrote. By selecting the text after it is

placed in the document and editing it, I would actually be adding

an extra step to the editing process.

Of course you will have to decide which writing pad you want to

use, and again you will have to experiment to see what works best

for you. Before you settle on any specific writing pad, you should

do some writing practice, as described in Chapter 2.

Box Size

The Box Size setting determines what size the boxes will be in

your writing and/or editing pads. The default size is medium, but

you have choices from very small to very large. Where this setting
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will have the most impact is in applications like MiniText (one of

the 130’s built in applications). Figure 4.12 shows MiniText’s writ-

ing pad with very large boxes, medium boxes, and very small
boxes.

The size of box you choose will depend on how you write, pro—

vided you do not choose a ruled writing pad. Remember, when

you write your letters they must fit within the boxes and should

not touch the edges on either the right or left. Also, the only part

of a letter that should go below the bottom line of a box are

descenders like the tails on lower-case letters such as a p, y, g, and

so on. If you find that you are having difficulty writing within a

box and your letters are consistently being misinterpreted, you

should try a larger box.

Box Shape

The Box Shape preference works in conjunction with the Box Size

preference setting. Your choices are short, medium, and tall. These

attributes apply to the height and width of the box edges. When

writing, your letters should not be taller than the tops of the boxes.

If they are, you should select the tall setting. Likewise, if your let-

ters are wider than the boxes, choose a shorter setting. Once again,

you should choose the setting that is most comfortable, which

means you will have to experiment to find out which you like best.

Figure 4.12 /Very small 
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Ruled Height

The Ruled Height preference is similar to the Box Size setting, and,

as its title indicates, it applies to width between the lines in a ruled

writing pad. The height has some bearing on the size of your let—

ters. If the height between the lines of the writing pad is small,

then your letters must be written small as well.

Unrecognized Character

Your final preference setting for the Writing preferences is the

unrecognized character setting. For this setting you have your

choice of a black circle with a question mark @ or an underscore _

character. If you use the @, a word with a character that your EO
could not translate, it will look like th@s. With the underscore

character the word will look like th_s. Once again, the choice is
vours.

 Whenever you change a preferences setting the change will go into
effect as soon as you press the Apply button. However, if the prefer-
ence you are changing is a writing pad or some other item that is
currently in use, the changes will not affect the object you are using
until you close and reopen the object. An example would be if you
change your Writing Pad preferences from boxed to ruled while
you have a boxed writing pad open. The change will not take effect
until you close the writing pool and reopen it.

The preferences you set for the writing pads apply to PenPoint’s

pop—up writing pads. If you are editing text by gesturing with a

circle 0 on characters that have already been translated, the charv

acters will always appear in a ruled box writing pad.

Year tents and Layout Preferences

All the Fonts and Layout preferences determine how your screen

will look or how you will interact with the E0. The Fonts and Lay—

out preferences are for setting the following:

PenPoint Font This applies to any text that is required by the

PenPoint operating system, such as page titles.

Field Font This is the font used wherever you place data within
a document.
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Default Font Size Sets the font size for all system and user field
areas.

Tablet Orientation (Top Edge) Sets the screen orientation of

your EO.

Hand Preference Where you tell your EO if you are right or left—
handed.

Scroll Margins Determines what type of scroll margins you
will use.

When you change these settings and press Apply, your EO’s

screen will blank out and you will get a message saying that Pen—

Point is updating your screen changes. It takes about 30 seconds

for the changes to take effect.

As with all preference settings, these are supplied for your conve—

nience. You should experiment with the different settings to find

one that will work for you.

PenPoint Font

The FenPoint Font is the font used for all system displays. Your

system displays are page elements like the Menu line and com-

mands, the Title line, the text in option sheets, content pages, and

other system screen displays. You can choose any installed font

that pops up when you tap on the arrow next to the current sys—
tem font.

Figure 4.13 shows the available fonts installed on a demonstration

system. These will be different from the default fonts on an E0 out
of the box.

When you get your E0, the San Serif font will be the system default

for PenFoint. It is customary, but not necessary, to assign different

fonts to the PenPoint and Field font settings. This is to avoid confu-

sion, by using different fonts for different types of data.

Field Font

The Field font is the typeface that will be used in your documents

and data fields like those in Personal Perspective. You will have

the same choice of fonts as you do with the PenPoint Font choice.
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Figure 4, I 3 ” MiniTem
Document Edit C‘ifiifflfl‘i: ‘~.«’iew insert I13 are

Example of . .
_ This is Courier font. F

fonts avallgbie This is Roman font.
This is San Sem tom. 0

for the Each of the above fonts are displayed i1112 point text. g.
PenPoint This is Courier font. :7

 

 
system Tn

... :4 form: are displayed in 10 point text.

310-3322a:ups);481M?Id.l‘   
Other than this, there isn’t anything else to say that was not said, in
the PenPoint Font section above.

Font Size

The Font Size is the display setting for both the PenPoint and Field

font settings. The default size is 10 points, which can sometimes be

a bit small and hard to read. EO Inc., recommends switching the

font size to a 12 point font. It makes your communicator easier to
read and also increases the size of some fields. The increased field

size, Item lines in Personal Perspective for example, makes data

entering easier. If you change the font size to 12 points you will

find your display easier to use, although you will not be able to

see as much of a page.

Top Edge

The Top Edge sets the orientation of your EO’s screen. In Figure

4.14 you will notice that the top edge is defined by an arrow point"

ing up. This means the orientation for your EO'S screen is set so

the top of your pages are oriented in the same direction as the

arrow. Also, your EO’s bookshelf will be positioned on the screen.

corresponding to the bottom of the arrow.

Although there are two basic orientations, portrait and landscape,

you can set the top edge of your EO screen in any one of the four

directions of your EO’s screen. This is useful because you might
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Figure 4. 14 Preferences > Fonts B: Lay-out

TOP Edge PenF'oint Font: b Sans Serif [URW‘T
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Font Size: > 10
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want to have weight of the battery compartment at the bottom

while you hold your EO and write. Or, you may find a landscape

orientation more comfortable with the battery compartment to the

right or left, depending on the hand you use to hold the E0.

Whenever you change the screen’s orientation, realign the pen.

 

NOfi'e if you discover you are often switching between Portrait and a Land—
scape modes, but find using Top Edge to change orientation a pain,
there is another way to accomplish this. Another way to change the
settings is by using multiple User Profiles. if the default profile is set
to portrait, a second User Profile with the orientation set to land-
scape can be created. Then when you change profiles you will also
be changing orientations. Also, ou would not have to realign the
pen since the pen settings are ago stored in the User Profile. More
about User Profiles can be found in Chapter 3.

Hand Preference

The Hand Preference setting determines where the scroll margins

appear on your pages. The scroll ttzargins are an area at the edge of

a page where you can move your documents about if the entire

document cannot fit in the visible area of the page. Figure 4.15

shows the scroll margins in a Personal Perspective document.

In Figure 4.15 the scroll margins are on the right. The Hand Prefer-

ence sets the scroll margins to either the right or the left side of a

page. Supposedly, the setting is for right or left—handed people,

but in reality you can use whichever orientation is comfortable for
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you. It is quite conceivable that a right-handed person might want

the scroll margins on the left-hand side. Whichever orientation

you choose, the statement on experimentation at the beginning of

this section applies.

Scroll Margins

The Scroll Margins setting determines what type of scroll margins

you use. There are two types of Scroll Margin settings. One is called

Arrows and Drag Box. The Arrows and Drag Box setting sets the

scroll margins so they appear like those in Figure 4.15 (a).

The other type of scroll margin is called a Tap and Flick Area. The

Tap and Flick Area scroll margins look like the scroll margins in

Figure 4.15 (b).

The Tap and Flick Area scroll margins represent areas where you

can use taps and flicks to move your document about instead of

dragging the small boxes or touching the arrows. Tapping and

flicking, as described in the basic gestures section of Chapter 2,

will work regardless of the type of scroll margins you select.

 

Figure 4.15 / AdclressBmla ‘ p . ma;
Document Edit Options Actions Create A

(a) Scroll - ,
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A floating
document
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Float & Zoom

The Float & Zoom settings are attributes that control how your

documents and notebooks behave when they open. Floating occurs

when a document is opened with a double tap ,l". The double tap ,Y
can be performed on a document’s tab, its page number, or icon.

Figure 4.16 shows a document floating on top of a notebook.

In order for a document to float, the Floating attribute must be

turned on from the Float & Zoom preferences. The default settings

for the Float & Zoom options are on Allowed or Not Allowed.

Basically, you can either float documents or you can’t. If you turn

off the floating document (Not Allowed), double tapping ,Y on the
title line, page number, icon, or tab will not work. The purpose of

allowing floating documents is so you can have two or more docu~

ments open at the same time and switch between them. When you

have multiple floating documents such as those shown in Figure

4.17, you can switch between the open documents when you tap l’
on the title line or the border by the scroll margin of the document

you want to bring to the front.
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Once you have selected a document to work on, you might want

to zoom it so it fills the screen. To zoom a document, you have to

have the Zooming preference allowed in the Float & Zoom prefer—

ences. The gesture you use to zoom a document is a flick up l in

the title line of the document. To return the document to its origi-

nal size you need to perform a flick down gesture l in the Title line.

In order for either of these gestures (the flick up or flick down) to

function, the beginning of each gesture must be in the title line,

When you zoom a document, any floating documents will continue

to float in front of the zoomed document, and the floating docu-
ments will have to be closed to work on the zoomed document.

NOfi‘E Althou h this may seem like a fine distinction, it is important to
remem er that an open floating document will float in front of a
zoomed document. lfthe zoomed document from a notebook is

floating, closing the notebook will cause the document to close also.
To prevent this inconvenience from occurring, you will have to zoom
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the notebook first and then zoom the document you want to work
on. Zooming a document contained in a notebook will make the
other contents of the notebook unavailable until you shrink the
zoomed document. While you are starting out, you might want to
turn these settings off.

If zooming is not allowed in the preference settings, then all pages

will act as if they are floating. You will only be able to change their

sizes by using the resize handles at the bottom or the lower right

corner of the page. And if floating is not allowed, you will only

have access to one notebook page or document at a time. The Float

and Zoom options are a bit complex, so you should experiment

with these options to get a full understanding of how they work,

even if you plan on leaving both the Float and Zoom options on.

Date

The Date preference page is where you set and format your EO’S

current date. Figure 4.18 shows the Date preference page.

To set the month, tap Y on the month’s name or the arrow next to
the month’s name. Setting the date and year is just a matter of

writing the proper numbers on the pads provided. If you write an

incorrect number, just write the new number over the old one.

Selecting the date format is done the same way as selecting the

month. There are ten options. Select the date format you want to

use. The date format you select is the one that your 130 will use in

 ,

/ Preferences > Date _'

snreigianemia;DQHCIS‘UI[SKIN-9.193914t:«tLl‘atlJer‘tf
Current Date: 15 Jun. 1993

Format: b 15 Jen 1990

Month: > June

Day: 1 ,5

Year: 9% 3   
F

Kyocera PX 1046_165



Kyocera PX 1046_166

CHAPTER 4 

every instance where the date is displayed, unless the program

you’re using allows you to override the system date format. Until

you change the format by tapping Y the Apply button, the current
date display shows you the system date and format currently in
effect.

Time

The Time preferences page is similar to the Date preferences page.

The Current Time at the top of the page shows your systems time

and the time format (see Fig. 4.19).

The Time Zone setting lets you tell your EO what time zone you

are in. This way if you travel, you can quickly and easily change

the system time to correspond to your current time zone without

resetting the time. The Time Zone setting must be correct before

you set the system time. If you set the time and realize that the

time zone is incorrect, changing the time zone will also change the

system time. So be sure to set the time zone first.

Setting the time zone is done by selecting a city in your time zone.

Each of the cities in the pop—up menu has a positive or negative

number preceding it. These numbers represent the number of
hours difference between Greenwich Mean Time (GMT) and the

time zone represented by the city. City names are used because it

is easier to associate a city with a time zone than trying to figure

out the difference in hours from Greenwich to wherever you hap—
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pen to be. Unfortunately, PenPoint did not provide a daylight sav-

ings setting to go along with the time zones, so you will have to

change the time whenever daylight savings time changes.

Your Time Format options are either a 24~ or 12—hour clock. If you

use a 12-hour clock, the format will display AM. and PM., while the

24—hour clock uses standard military time. The last format option is

whether or not you want the seconds displayed. Whichever format

you choose Will be the default system time for all of your applica—

tions unless a program lets you set a different time format.

To set the time, write the time you want your EO set to in the

Hour, Minute, and Second boxes, and tap Y the Apply button.
There is a one or two-second lag between tapping the Apply but-

ton and the time being set, so if you are trying to make your EO

accurate to the second you will have to take this into account.

If it is important for your E0 to be accurate to the second you will

have to practice a little bit to get the time exact. I’ve found the best

way is to sort of guess while you have the mechanical time person

on the phone. (The phone number for time in most areas is POP-

CORN.) Tap the Apply button as the mechanical voice finishes

announcing the time and just before the ten second tone. Unfortu-

nately this will have to do until someone writes a program that

will call a national observatory and precisely set the EO’s clock.

Sound

The Sound Preferences setting is simple: you can turn the EO’s

Warning Beep on or off. If you turn on the system sound, your EU

will beep each time your BO displays an error or system message.

If you are going to be using your E0 to take notes at meetings, in

class, or in places where beeps and noises will disturb other peo—

ple or draw attention to you, you will probably want to turn off

the system beep sound.

As far as I’m concerned the most useful service the system beep

can provide is the warning it will give when the E0 gets ready to

go into Standby mode (discussed in the next section). Just before

going into Standby, your EO gives you 15 seconds to cancel the
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descent into Standby mode. Having the E0 beep at the beginning
of this 15 second window can be convenient.

IU'I

Setting Your Power Preferences

The E0 is a battery-powered device, and you need some way to tell

it when to go into a state where it is using as little power as possi-

ble or even shut off. The Power Preferences page is where you set

your EO’s power options. You get to the Power preferences page

just like you do the other preference pages. The options you can set

or information you can get from the Power Preferences page are:

0 Manual Standby

0 Manual Shutdown

0 Auto Standby

9 Shutdown from Standby

0 Wireless Module

6 Auto Power Off Devices

0 Battery

' Screen Back lighting (E0 880 only)

Not all of the options in the Power Preferences page are system

settings. Some of them are system functions such as the Manual

Standby and Shutdown. The Battery Gauge serves as an informa—

tion—only function, providing a graph that tells you how much

power your battery has left. The remainder of this section will dis—

cuss each of these settings in detail.

Manual Standby

The Manual Standby button is a feature of PenPoint and not really

needed with the E0 because of the On/Standby button. However, if

you have the Auto Standby turned off (see below), you can use the

Manual Standby button (from the Power Preferences) to put your

EO into Standby instead of depressing the On/Standby switch.

There is another use for the Standby switch. This use of the

Standby button is a convenience and not necessarily recom-

mended by EO Technical Support. If you wish, you can copy the
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Standby button and place it in the Cork Margin of any page or on
the Bookshelf.

To copy the Standby button and place it in the Cork Margin:

1. Open the page onto which you wish to place the button.

2. Choose the Controls selection from the notebook or document’s

Options menu to show the Cork Margin if it is not visible.

3. Open the Settings Notebook to the Preferences Power page.

4. Resize the Preferences Power page so you can see the Cork

Margin of the target page.

5. Tap press 4 on the Standby button and wait for the double

marquee to appear.

6. Without lifting your pen drag the button with the double mar-

quee to the Cork Margin of the target page and release the but—

ton by lifting your pen.

7. You will see the clock symbol that indicates the E0 is process—

ing data, and a copy of the Standby button will appear in the

Cork Margin of your page.

8. To copy the Standby button to the Bookshelf, follow the same

procedures as above, only copy to the Bookshelf instead of the

Cork Margin.

Once you have copied the button you can put your EO into

standby at any time by tapping Y the Standby button. This will
have the same effect as pressing the On/Standby button.

Manual Shutdown

NOfe If your EO does not have a hard drive, you will not see the Shut
Down button. This is because shutting down your EO would lose all
of your data.

The Manual Shutdown button is the only way you have of shut~

ting down your EO. The Shutdown button operates in the same

way as the Standby button except that it completely turns off your

EO. Usually you will not want to use this button because you will

be using your E0 or will want to have it handy and accessible.
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Remember that it takes about three minutes for your E0 to

startup when it has been turned off.

The only time you will need to shut down your E0 is during the

installation of RAM or ROM cards. If you are not going to be using

your EO for an extended period of time (hopefully, you will go on

vacation sometime), the EO’s batteries will only keep the E0 in

Standby for a few days. So don’t lose your data by letting the

power run out while your E0 is in Standby mode. Instead, back

up your data, shut your EO down, and have a great vacation.

(Unless of course you are taking your HQ with you. If you do

make sure your spouse won’t divorce you.)

Auto Standby

The Auto Standby feature controls if or how long your EO waits

before automatically going into Standby mode. If you set your EO

not to go into Standby mode, it will stay on until you put it into

Standby with either the On/Standby switch or the Manual

Standby button. When you set the Auto Standby time your EU

will go into Standby after there has been no activity for the num-

ber of minutes specified.

As you work with your E0 you will probably adjust the Standby

minutes a few times until you find a setting that works for you.

This is a battery~saving feature. Even though the E0 has a good

battery life, you can improve that battery life by making sure your

EO does not stay on when it is not in, use. Remember, the battery

will only recharge while the E0 is on Standby.

One of the problems you may discover is that your E0 may seem

to be going off just before you are ready to use it again and you are

always starting it up. It this seems to be what happens when you

use your E0, try lengthening the Auto Standby time. Conversely,

if your batteries do not last as long as you would like and you

think that your E0 is on but not being used, you should try short—

ening the Auto Standby time.

Shutdown from Standby

The Shutdown from Standby setting is used to turn your EO off if

it is left in its Standby mode for a predetermined length of time.
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Your EO will be able to retain its data while in standby for two weeks.During those two weeks your main battery will run out alter tour days,
provided you started with a lull battery charge. During the remaining ten

days your EO’s data is being maintained by the backup lithium batteries.
These times are estimates and will vary depending on how much RAM is
installed in your EO.

Also, it you are using an E0 880 you will have a shorter battery lite cycle
than it you are using a 440. The 880 has a battery life at one to two
hours. The E0 880 has a back-lit screen and a taster processor; both

require more power to operate. Also, other options like PCMCiA cards,
additional RAM, disk drives, key boards, and serial connections all use
additional power. So the actual lite ot your batteries will depend on how
you use your EO and what is attached to it.

One more very important consideration you must keep in mind is that your
EO’s battery will not recharge unless the EC) is in shutdown or in Standby
mode. Since the battery does not trickle charge, you must make sure that your
EO goes into Standby to charge. it takes 90 minutes to charge your battery.

Because you have to have a charged battery to use your E0 on the road,
extra batteries are a must. Also, you may want to consider purchasing an
external battery charger so you can charge your battery while you work.

The battery lite tar your E0 is detailed below:

Operating Condition EC 440 E0 880

Standard Battery Hours Hours

On w/no activity 3.75 1.5

H3096 CPU activity w/no hard drive 2.5 l.O

TOO% CPU and hard drive activity 2.0 20«30 min.

Cellular talk time i .0 l0

Extended Lite Battery:

On w/no activity 6.67 Not available

TOGO/<5 CPU activity w/no hard drive 4.42 Not available

TOO% CPU and hard drive activity 3.25 Not available

Cellular talk time l.5 Not available
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The default for this setting is off. This setting can be very useful if

you know you are not going to be able to connect your E0 to an

AC power source. Rather than have your EO use battery power in

Standby mode if it is not going to be used for long periods of time,

you might as well let it shutdown automatically.

The default setting if you turn on the Auto Shutdown feature is

five hours. I think five hours is probably too long to wait. If you

are going to use this feature, I would recommend a shorter time
interval of one to two hours.

Just as there is no manual shutdown button on EOs without hard

drives, there is no shut down from Standby option. Again, this is a

feature to save your information, since information on EOs with-
out hard drives is stored in RAM.

Wireless Module

The Wireless Module is specifically for when you have the Cellular

Module attached. If you do not have a Cellular Module attached

you can turn this option off. Otherwise, you should use the ”On if

system On” option if you want to receive calls on your EO. Also, if

you are not going to receive calls on your EO’s cellular phone you

can set this power option to off, turning it on when you use the

phone. Off is the best option because it uses the least power. You

can always open BC Phone to make a call, and if you use the EO’s

fax or E—mail, the Cellular Module will wake up for your call.

The Cellular option uses a lot of power. If you are not using the

phone, you do not want waste battery power when it is not in use.

To give you an example of how much power the phone uses, an

E0 440 with standard batteries will run for two hours with a fully

charged battery and constant use during the two hours. With the

cellular phone, you will have one hour of talk time on a fully

charged battery.

The Cellular option can cut your operating time in half. This really

makes it important to set the Wireless Module properly. If you are

on the road a lot you might want to pick up the cigarette lighter

power option for your EO so you can use the power from you car

to run the phone and/or recharge your battery while you are

going from place to place.
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Auto Power Off Devices

The Auto Power Off Devices option is to save power by turning

off the power to any attached device when it is not in use. The

only reason to turn this option off is if you are using a device

(maybe a network PCMCIA card when they are available) that

requires power at all times. Currently, there is no device that I

know of that requires power all the time. If you have such a

device, you will know because its manual will say so.

The Auto Power Off Devices selection also controls the automatic

backlight dimming for the BO 880. When Auto Power Off is on,

the backlighting will automatically dim after two minutes. It will

turn on again when your pen approaches the screen. Turning off

this feature will result in the backlighting remaining on and dra—

matically reducing your battery life.

Battery

The Battery display is very simplewit’s a bar graph that shows

how much power your battery has left. It is not 100% accurate,

having an error factor of i10%, but it is close enough to give you

an idea about how much time you have left on your current bat~

tery. Needless to say, if the battery is almost empty you need to

charge it.

Concusion

As I said at the beginning of this chapter, you will have to experi~

ment with your EO’s system settings. Customizing these settings

is just one part of making your EO yours. Without customizing its

system settings you will not be getting the most from your EO. So

experiment and have fun.
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Using Personal

Perspective

Introduction

Of all the applications built into your E0, Personal Perspective is

the most powerful and useful. Personal Perspective is a personal

information manager that you will use to keep track of all your

names, addresses, and phone numbers, plus a sophisticated plan-

ner and a note taker. All of these separate functions are integrated

so you can schedule a meeting with someone from the address

book and interconnect the meeting, the person, and any notes you

have regarding either the person or the meeting. Not only are all

of these functions interconnected, but by viewing any one of the

three (appointment, person, or note) you can quickly View other
individual entries.

It’s amazing that all of the descriptions for products like Personal

Perspective are so inept. Programs that function as organizers are

all described by their capabilities and lumped into a generic cate—

gory called personal information managers. These products are

also called electronic phone books, organizers, datebooks, and so

on. The problem is that none of these names really do these pro-

] 57
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grams justice, nor does a brief description of their capabilities con-

vey what you can accomplish with them.

I keep asking myself as I write this, ”How can such a complex

product be simply and clearly explained?” The conclusion I have

drawn is that it cannot. Personal Perspective is easy to use, but

what it does is complex. It is a tool that can simplify one’s life by

providing an organizational format for all of your people and

company contacts, meetings, phone calls, and informational notes

so you will always have the information you need.

I have either looked at or used a number of these programs on all

kinds of computers: palmtops, notebooks, laptOps, desktops, and

electronic notebooks. There are only a couple that I have used that

come close to having the power and flexibility and are as easy to

use as Personal Perspective. And those packages that work the

best require a desktop computer to use most efficiently, so they are

only somewhat useful on the road.

Throughout this chapter I will refer to information transactions.

Information transactions are any actions that you perform where

you are exchanging or using information with or about another

individual. Just as data transactions are what usually happen

when using a desktop computer, with E0 you will be performing
informational transactions because of its orientation toward com—

munications. Personal Perspective is the program that will be at

the core of most of your information transactions when you use an
E0 Personal Communicator.

The example that is used in this chapter to illustrate how Personal

Perspective works represents only an overview of what you can

do with Personal PerSpective. The example does not show every—

thing you can do with Personal Perspective. However, I hope it is

enough of a glimpse so you can begin to grasp the power behind

this program. An entire book would be needed to do Personal Per-

spective real justice.

The E0 manual provides you with some basic instructions for

using Personal Perspective, however, this chapter will go beyond

those basic instructions. By using the detailed example, which also

can be used as a tutorial, most of Personal Perspectives features
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will be illustrated. Also, you will find in this chapter additional

information that can make other features, such as importing infor-
mation, easier to use.

An Overview ef Persena Perspective
An example involving a single contact might go something like
this. You attend an out-of—town conference and meet lake Doakes

of ABC Widget Company. You realize that an information exchange

with Mr. Doakes would be beneficial for both of you. You have

obtained his business card and want a simple and efficient method

of scheduling phone calls and appointments, exchanging informa—

tion via fax and modem, and keeping track of everything regarding

your informational transactions with Mr. Doakes and his com—

pany—with a minimum of time and effort expended.

Later in. this chapter will be a step-by-step illustration of how Per—

spective and your EO can set this up with a total time expenditure of

about 20 minutes. It will take you longer to read about how to do all

of this than it will. for you to accomplish it. All of your COMLmica—

tions with and notes about Mr. Doakes will be linked, and you will

be able to view any note, document, or scheduled event in seconds.

What Personal Perspective provides is a structured information

manager that allows you to access all of your information in a

nonstructured fashion. You have an instant record of every infor-

mational transaction you may make. The relationships between

notes, names, events, and documents are not constrained by the

structure of the program, rather you determine what information

is to be interconnected and how, all according to your needs. You

are not constrained by the structure of Personal Perspective in the

viewing or accessing of your information.

So you can understand. how Personal Perspective works, the rest

of this chapter will first provide you with conceptual information

about Perspective. Then I will use the example from above and go

through it step by step. By the time you reach the end of the chap—

ter each step that was described above will have been discussed.

The example will be interspersed between discussions about Per-

sonal Perspective’s functions, options, and general use.
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There is no information manager available (that i am aware of} that issuitable for both office and on—theroad environments which can per-
form these functions as quickly and easily on any computing platform,
while leaving you in total control of how you will access your information.
The only improvement you can make to Personal Perspective is to upgrade
to the full version of Perspective, of which Personal Perspective contains the
most essential elements. And all EO owners can upgrade to the full Per-
spective package for less than a hundred dollars. (The full version of Per—
spective is discussed in Chapter l l .l

The motor difference between Personal Perspective and full Perspective is
that full Perspective gives you the capability to create new categories and
their corresponding data forms (profiles). Personal Perspective is not as
customizable, although you can create lists that present different views of
your information. {This will be discussed in a later section).

Personal Perspective’s Components
and Information Linking

Personal Perspective is a single application composed of several

pieces; it has a Day Planner, Address Book, and Note Index as its

major elements. This section will look at each of Personal Perspec—

tive's components so that you have an overview of What they are

and how they are all integrated. Figure 5.1 shows the default Note—

book that opens automatically when you first start your BC.

In this notebook you have five Personal Perspective documents.

They are:

0 The Day Planner

0 The Address Book

0 Notes Index

0 Country Codes

0 The Profile Book

Each of the above documents represents a category used by Per-

sonal Perspective to group the information you enter, with the
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exception of the Profile Book. The Profile Book is the information
file that Personal Perspective uses to store all of the information.

There are four main category groups: Calendar Items, Name

Items, Note Items, and Misc. Items. Table 5.1 illustrates the basic

structure of how information is grouped in Perspective.

The category groups are based on a specific type of data. The cate~
gories themselves are actually forms with specific data layouts
with information pertinent to that category These forms are

referred to as profiles.

Each profile is made up of detail fields which contain information
associated with each item in that category.

The headings in Table 5.1 are my own because I find Pensoft’s (the
creators of Personal Perspective) description of how Personal Per~

spective confusing. Pensoft calls everything 1. labeled a category,
making all Appointments, Persons, and Notes categories. And
each category contains several details, so any information such as
appointment time, an address, or the note itself would be a detail.
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Category Category Special Explanation

Group Category

Calendar The category for all date and time—
Items sensitive information forms.

Appoint— Form for entering Appointments

ment and meetings. Intended for all infor—

mation that is date and time—specific.

Event Events are special days, confer—

ences, or any information that is

date—specific but not time—specific.

To Do The To Do form is for entering
items and reminders that are usu~

ally date~specific, although they can
have a duration as well.

Phone Call A Phone Call is a type of To Do
item that has its own form.

Name The category under which all name
Items based information is stored.

Airline A form that is specifically set up for

listing Airline companies.

Company This form tracks companies only.

Employees of a company are linked

to the company but stored as Person
entries.

Grou A cIrou is for Gatherino any Name0 P o o ,

Item under a separate category such .
as clients, friends, distributors, etc.

Person A form for recording information [
on individuals.

Note The category for all note—based
Items information.

Note A generic note that can be attached

to any other item.

Misc. This is a miscellaneous category for

Items information that does not easily fit in

the other categories.

Country Code Listing of long distance access codes
for 100 different countries.
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Finally, every occurrence of a category, or each Appointment, Per—

son, or Note you enter into Personal Perspective, is an item.

The reason I find Pensoft’s description confusing is that they have

tried to present standard database concepts in a new way. Stan-
dard. database structure would make distinctions between differ—

ent types of information according to its organization, using a
structure like Database, Pile, Record, and Field. A database would

contain all of the information with various files defining the major

categories (Calendar, Name, and Note Items from the table), Where

each file would be composed of records (Appointment, Person,

and Note), and a record would be a collection of fields (name,

address, and phone numbers). When information is entered into a

record, a record form is used that shows the fields.

What Pensoft has done is call the files Groups of Categories with

names like Name Items. Then they call the different types of records

categories (Person, Company, Appointment, etc). Each occurrence

of a category is an item and each item contains details. It all gets

really confusing because "category” has two meanings and “item”

is used when talking about major categories and records.

Because I find Pensoft’s description confusing and cumbersome, I

hope to keep things clear by using the following conventions.

Category A category will be. used. to distinguish collections of

different types of information. Name, Calendar, Note, and Misc.

Items will be Categories.

Profile A profile will mean a record. An Event Profile means an
Event Record.

Profile sheet A profile sheet is the record form for the different

categories. (Sometimes profile will be used to mean profile sheet.

You shouldn’t get confused if you keep the context in mind.

Item An item will be an information field within a profile sheet.

Explaining collections of different types of information and how

they are connected can be complex. I hope the above list will help

you, so you will understand What I’m talking about as using Per-

sonal Perspective is described.
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Perspectives Lists
Nfififle All of the EO’s programs are also called documents, and all docu—

ments are viewed as———and called—pages. So, talking about a doc-
ument is synonymous to talking about a computer program. The
reason for the difference in terminology is due to the E0 being a
Personal Communicator and not a computer. The E0 is a computing
device, but the word computer is reserved to mean devices that use
or can use the MS—DOS, Macintosh, or UNIX operatin systems.
There is also a distinction to be made between noteboolz and sub—
notebook computers and Personal Communicators. You will find dis—
cussions about this distinction throughout the book.

This is just a brief section to introduce you to Personal Perspective’s

lists. When you view your information in Personal Perspective, you

will be looking at it in a list format. Figure 5.2 shows pages from an

Address Book, a Day Planner, a Notes Index, and Country Codes.

Notice how all of the pages contain a list called Item Rows.

Personal Perspective comes with five different documents. Four of

these documents are for viewing information: the Day Planner,

Address Book, Note Index, and Country Codes. The fifth docu—

ment is the Profile Book which is where your information is

stored. When you open a Perspective document, you see a page
that contains a list of different detail fields.

You can modify how the information is viewed on each page.

Although you can enter new information into any of the different

documents without turning to the document’s page, to see your

information you will have to turn to the page the contains it. The

actual mechanics of manipulating the various pages will be cov—

ered later in this chapter.

NO'BB The Country Codes page will not be discussed in this chapter. Basi-
cal/y it is a list of long—distance codes for 700 countries and their major
Cities. This can be useful for those who do business internationally.

Profile Sheets

There are two methods for entering information into Perspective.

The first method is to open a blank profile sheet using the Create

menu on any Perspective Page. To use the Create menu you must
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be turned to a Perspective page. Figure 5.3 shows Perspective’s
Create menu.

In Figure 5.3 you can see the four main choices of Note, Person,

Company, and Other. To create a new name item, for example, you

would tap Y on the Create menu and then tap Y on the Person
menu selection. Tapping the Person selection will open an empty

Person profile, as seen in Figure 5.4.

When you View a profile, you will only see part of it. You will

have to use the scroll margins or use the flick up I or flick down l

gestures to see the entire profile.
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Each profile contains a set of default items into which you enter

information. If a profile sheet does not contain an item you need, it

is possible to add a detail item from those already defined in Per—

sonal Perspective or to create a new one. Adding and creating detail

items will be discussed in the last major section of this chapter.

The second method for entering information is to turn to the page

on which you want the information entered and write it directly

onto an item line. If you want to enter an appointment you can

turn to the Day Planner, for an address turn to the Address Book,

and so on. Once you are on the correct page, you’ll have to scroll

to the first blank item line on the page or insert a blank line (using

the Insert Row command from the Edit menu) and write your

information directly on the line in the proper detail items.

When entering information, either in a profile or on a blank line,

you can choose to use ink or text. If you want to use ink you do so

by turning on the ink well. Each page and / or profile sheet has an

lnk Well icon in the upper right-hand corner (see Fig. 5.5) that acts

as a toggle switch between ink and text. Tap on the Ink Well icon

to toggle to text or to ink.
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Some cautions about using ink. Personal Perspective cannot auto»

matically link an Ink item, nor can it sort Ink items. When you create

an Ink item you have to link the information manually. If the item

you entered would normally be sorted if it was written with text,

Perspective will not sort the item until it has been converted to text.

Ink items either stay where you put them or they are put onto a

page containing ink-only entries if the primary item (a name in a

Person profile, for example) is written in ink. Address Book entries

are usually sorted alphabetically and ink entries are put on a sepa—

rate Address ink—only page when the Name item is written in ink.

However, if you schedule a meeting with someone in the Day

Planner, and it is written in ink, the item will stay where you

placed it, because the date and time which are automatically

entered as text are the Day Planner’s primary items.

The Profile Book

The Profile Book, as mentioned above, is the information file that

contains all of the information entered in your various profile

sheets. The Personal Perspective Profile Book cannot be accessed

except as a page in your notebook. Although the page is less than

exciting, without a Profile Book the Personal Perspective will not
work. You will find a little more information about the Profile

Book towards the end of the chapter.

Linking Your Information

When you enter information in Personal Perspective you will

want to link it. You will want appointments linked with person

and company profiles, persons linked to company profiles, and

notes linked to all of your other profiles. In addition to linking

profiles to each other you will also want to embed documents in

your profiles. Without its linking capabilities Perspective would
not be worth a whole lot.

Linking takes place automatically under certain conditions. Auto-

matic linking is controlled by a Perspective function called ”The

Associate.” You can also manually link data using a function

called general linking. In addition to linking you can also attach

(embed) documents into your Perspective profiles. This section
will look at three of these functions.
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The Associate

The Associate is Personal Perspective’s behind—the-scenes infor-
mation linker. Whenever information is entered into linked detail

items, the Associate will attempt to link the information to a corre~

sponding item. If the Associate cannot find a corresponding item,

it will ask you if you want to create a new one.

The Associate links everything back to a Names ltem profile. If

you are scheduling a meeting with someone named Bob and enter

”Bob” into an Appointment profile, the Associate will look at all of

the people named Bob in your Address Book. Should you know

several Bobs, the Associate will pop up a list of the different Bobs

and ask which one you want linked to the Appointment item or to

create an new Person profile. If the Associate can not find a profile

to link, it will ask if you want to create a new one. Figure 5.6

shows the Associate asking which Bob to use while an appoint~

ment is being scheduled.

After you have chosen the correct Bob, he is entered into the

Appointment profile and the name Bob is displayed in bold text.
Bold text indicates that the name is linked to an item in the

Address Book. By double tapping ,l’ on the name Bob, the Person
profile for Bob will automatically open. Figure 5.7 shows the name

Bob in the Appointment list with Bob’s profile floating in front.

Also notice that Bob's profile is linked to a company. In Bob’s pro—

file his company, Sundisk Corp, is in bold text. Double tapping ,l’
on the name Sundisk will bring forward the Company profile for

Sundisk (see Fig. 5.8).
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in the Person profile in Figure 5.4 you can see that the label for the

company detail item is in italic. Whenever a label is in italic the

detail item is automatically linked by the Associate unless the

Associate has been turned. off. Turning off the Associate will be

discussed later in this chapter. If you will go back and look at Fig»

ure 5.4 (a complete but blank Person profile) you will also see that

Calendar Items, General Links, Members Of, and Spouse are all in
italic text. Each of these items is a linked detail item.

The Calendar Items shows any link with Day Planner profiles such

as Appointments, To Do’s, or Events. General links are links to
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notes and other associations you intentionally create. With a Gen,—

eml link you can link Bob to another person even though there is

no obvious relationship between the two records. Members Of

shows the links to any Group profiles you may have attached to

Bob. And of course Spouse would be Bob’s significant other, should

his significant other be entered in the Address Book.

In any of these linked detail items you can enter information that

is not linked. If you wanted to have a Person profile for Bob and

list his company, but not link Bob to an existing company or create

a new Company profile, you could enter the company name, and

when the Associate asks you to link the information tell it not to

link it instead. In this case you would have an item field with an

entry that is displayed in plain text rather than bold text.

General Links

When you have items that the Associate will not automatically

link, you can use Perspective’s general linking feature. In the

upper right—hand corner of each profile you will see a Stick Pin

icon (see Fig. 5.9).

The Event profile above is not linked to anything. If you wanted to

link an airline to this Event you would have to use a general link.

In this instance, let’s link the airline by turning to the Address
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Book and selecting an airline (supposedly the one that you’ll fly
out on).

To create the link:

1. Turn to the Address page that contains the airline.

2. Open the profile for the airline by selecting the profile (tapping

if on the item’s line) and drawing a circle 0 on the line number.
(See Fig. 5.10.)

3. Once the profile is open, press 1 on the profile’s Stick Pin and

' drag it to an area like the page banner as seen in Figure 5.11.

NOl'e When making a general link it is important to make sure you place
the Stick Pin somewhere it will not accidentally create an uninten—
tional link. By dragging the Stick Pin to a line item you will create a
link between the item on the line and item that the Stick Pin belongs
to. To prevent the Stick Pin from accidentally attaching itself to a
profile other than your intended target, place it an area where it
will not come in contact with another item.

4. Now return to the Day Planner. If you did not close the Event

profile sheet before going to the Address Book, the profile
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sheet will still be open. The Stick Pin will be in the same loca—

tion it was placed while in the Address Book.

5. So you know what the Stick Pin belongs to, the profile’s name

will be connected to the Stick Pin while you are dragging it

about. Now that you are back to the Event profile, drag the

Stick Pin to the Event profile. When you do this the Associate

will ask if you want to link the Name item to the Event item

(see Fig. 5.12).

6. Tapping l’ the Link button will link the Airline profile to the
Event profile. Although the link will not be visible in the

Description detail item, it is Visible as a Name Item field. By

double tapping on the linked item you will open its profile in a

floating window. Also, the Event will be Visible in the Airline

profile as a Calendar item (see Fig. 5.13).

Other than being manually created, a general link operates like an

automatic link. The linked items are reflected in each profile, and

double tapping ,Y on either link will call up the profile of the
linked item. When you link a Perspective Note item to a profile, an

icon will appear in the Note’s item box.
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Figure 5.12

Confirming
the link

Figure 5.13

The Airline

proiile linked
to the Event

profile

CHAPTER 5

 

 

 

 
 
  

  
 

 
 

/’ D1 F‘i ev‘iner' < 14:»
Dooui‘neni Edit Citations Aofione Create

, ii in: Ti”?

F; / ' Extent: Cairnpuier Conferer'ioe .J Lil
'l Profile Edit

} Ext-em

Stick pin from

Airline profile
, V

_l Description mm~¥ '0
Computer (3011firon 03

  

Al 5‘[tetefizTime Duration .=~

glun 11.93 3 day's E
Alarm Notes Documents
)

.1
fit-am items   
 

 
 

; ——~~~Wm ll4:;- "4‘3; ‘

/'/ E‘.v'E‘:i'ii; [Leimther COI‘iierenog -_‘Ul'i 1" ‘ 7 .
Pmii ie Edit  
 i

lapt-a:inpp'T'liauugid:‘l'ogl::;u;quo
 

Link: "Mast-aAirline-,3"

  
 

 
To: “Computer Lonierence Jun 1‘, 9E:

  
) hasme He
 

 
 

Although these steps were more complicated than they needed to

be, they covered everything you need to know to manually link

records. However, the whole process could have been completed
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by using the stick pin from the Event profile and moving it to the
Airlines item line. That would have been more economical but

would not have resulted in a complete explanation.

Embedding Documents

A document from any program. that is installed and included in

the pop—up menu (see Chapter 3) on your EO can be embedded.

into any Perspective profile. Each profile has a Document item box

which will display an icon whenever the profile contains an
embedded document.

You can embed as many documents as you want into a profile.
Once a document is embedded, the Document box will have an

icon. When you tap Y on the icon, a list of the embedded docu—
ments will pop up. Once the list of documents pops up, tap Y on
the document you want to open. The document will be opened in

a floating page for you to work on or look at.

To embed a document:

1. Draw a caret /\ in the Document item box,

Or

Draw a double caret A anywhere on a profile sheet or item line.

2. You will get a pop—up menu from which you can select the

type of document you want to embed.

3. Tap Y on the document you want to embed. A new document
will open.

Figure 5.14 shows the documents that are currently available for

embedding. (Remember, your EO will have different documents.)

If you want to embed an existing document into a Perspective pro-

file, you can either copy or move the document.

To embed an existing document:

1. Press 1 on the document you want to move,

Or

Tap Press -i on the document you want to copy.
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2. When the marquee (move) or the double marquee (copy)

appears, move the document to the Menu or Title line of your
notebook.

3. Open the Perspective document that contains the profile in

which you’re going to embed. the document.

4. Drag the document from the Menu or Title line to the row con-

taining the profile you want the document embedded in,

Or

Open the profile that will contain the document and drag the

document onto the profile sheet.

NQ'E'E A warning: Documents stored in the Perspective Documents column
{with c: person, for exam le} are deleted when the profile in which
they are embedded is de eted. There is no other way to access these
documents. This will be corrected in future versions of Perspective.

Using Perspective

Phew. It’s about time. Rather than describing each component of

Personal Perspective and hoping you will come away with an over-

all conceptual understanding, an example will be used to illustrate

how Personal Perspective works as a whole. The example will

include discussions about each of the profiles used, more on how

information is linked, alternative information entry methods, plus

how PenPoint, Perspective and the E0 all function together.
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You meet Jake Doakes of ABC Widgets company at a conference andexchange business cards. During the conference you realize that an
information exchange with Mr. Doakes will be beneficial for both of you.
That night in the hotel you enter his information into your EO. You also cre—
ate a note that is attached to Mr. Doakes' address record. To make sure

you will call Mr. Doakes, you also schedule a phone call for the following
week. Now you can forget about him for awhile.

You need to remember that many of the individual operations per—

formed in this section are universal to Perspective. In many

instances, functions performed on a specific profile are actually

functions that can be done with any profile. This is especially true of

the linking and embedding functions. Also, this is just an example

on one information transaction. If it seems limiting in any way it is

because I’ve been inept. Personal Perspective is not limited. Your

imagination is the only limitation when using Personal Perspective.

The Initial Contact

In this example, the first entry into Personal Perspective will be to
enter Mr. Doakes into the Address Book. Then a note will be made

regarding Mr. Doakes, and a phone call will be scheduled.

Entering the Name

To create a new Name profile you can either use the Create menu or

enter the information directly onto a line in the Address Book. I pre—

fer to use the Create menu because I find it easier. Also, I rarely

(more like never) use ink in my Address Book. So for these reasons,

the most important being personal preference, I use the Create Menu

option. You will have to determine yourself what works best for you.

To create a new person entry:

1. Tap Y on the Create menu and then tap Y the Person selection.

2. When the empty profile appears, either write the name (in this

case Jake Doakes) onto the first line of the profile sheet,

Or

Tap Y on the first line and an empty editing pad will pop up.
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3. Enter the name.

4. To fill in any of the other detail items repeat steps 2 and 3 for
each detail item.

In the Short Name field enter Mr. Doakes’ nickname if it is differ—

ent from his first name.

Note The Short Name detail item is used by the Associate to create links.
If you use a name that is in the Short Name detail item when sched~
uling a Calendar item or in a note, the Associate will automatically
link the erson or company if the name you use is the only one in
your A dress Book. If there are duplicate names the Associate will
offer you a list of names to link.

The Associate will find the first name from any Person profile

when you enter the name in a linked field. If you want to link a

Company profile you either need to use a short name or the entire

company name. The Associate will not link a partial company

name. You may want to use abbreviations or some unique identi-

fier for company names so they can be linked easily.

A useful shortcut when entering links is to use a ”.” as a wild card.

For example, if your company name were Apple Computer, you

could enter ”Ap.” on the Company field. If more than one name

matches, you’d get a list to choose from. You can also do this when

entering an Appointment or a To Do. (For example, enter ”Meet

Den." instead of ”Meet Dennis.” ) ‘

The purpose of the Person profile field is to store an individual’s

information. Although you can keep business information in a Per-

son profile, if you have more than one person associated with a

company you will probably want to create a Company profile and

link all. of the people to the Company profile so you do not have to

repeatedly enter the company information. Also, the company pro-

file provides two lines for an address while the Person profile only

has one (another reason to use the Company profile for companies).

NOfi'e It is possible to have multiple phone number entries in a single
detail field—if, for example, a person has two business phone num—
bers or two home numbers. To enter the second number, enter the

first number as described above. After the first number is entered,

draw a caret tap on the phone number detail field. A pop-up edit-
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ing pad will appear; enter the second phone number and then tap Y
on the OK button.

The Phone Number detail field will now have two phone numbers. To
show that there is a second value in the field ou will see an ” ”

appear in the detail field under the phone num er. Double tap ,.V on
the ”... ” to see the hone number. You can also draw a D on the per—
son’s name when fdoking at it in a list other than the Address Book
(the name must be linked), and a dialog sheet will appear that will
contain all of the person ’5 phone numbers including any multiples.

When you enter the phone number, the default editing pad is in

the North American format shown in Figure 5.15.

As the figure also shows, you have another choice for the Phone

Number editing pad called General. If you need to enter a country

code or an extension you can use the General pad shown in Fig
ure 5.16.

To access the General phone pad, tap Y on the arrow next to North
American and then tap Y on the General label.

When you write Mr. Doakes’ company into the Company detail

item, the Associate will ask if you want to create a Company pro»

 
 

 
 

 
 

Figure 5.15

The default

Phone Number

editing pad
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file for Mr. Doakes. Remember, you can enter a name and not asso—

ciate it with a company. Entering a company name into a Personal

Profile can be frustrating if you are not going to link the name.

This is because the Associate prompts you as soon as you have

written the first part of a company name. Figure 5.17 shows the

Associate’s prompt before a company’s name has been completely

entered. This feature of the Associate is another reason why you

would want to use one—word abbreviations in the Company pro-
file Short Name detail item.

NOfe How you use the various detail items is up to you. You should keep
in mind that you can create new fields for your special needs. You
are not confined to the list of predefined fields present in Personal
Perspective. Be aware that if you start to use a predefined field for a
type of information other than the type intended you will have to
remember how you are using the field.

If you use the Home Phone number for someone’s car phone num-
her in a specific record it is quite easy to forget what the Home
Phone number is being used for, especially if you do not often
access this particular item. You will probably be better off creating
new fields for special purpose information. Creating new detail
items will be covered later in this chapter.

Mr. Doakes works for a company called ABC Widgets. Since ABC

Widgets has not been entered into Personal Perspective, we'll cre-

ate a new Company profile for this company. As you can see from

Figure 5.17, we only got ABC written into the Company detail
item before the Associate asked to create the link. Because ABC is

a new company we’ll tell the Associate to create the profile. If you

do not want the Associate to ask you if you want to create profiles

you will have to turn off the Associate’s "Let the Associate ask for

Help” feature. This is accessed through the Options menu from
the Associate selection.

 

 

figure 5- 1 7 nitrite iron? the. gramme

The Assocrate Text ABC
wanting to There is no profile named 'ABC‘.

create C1 Create a new profile?

Company Cream 2 go No! Cr‘eflrlMmmmwml mmmmmmmmm ii 
profile
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Perspective will create the Company profile putting ”ABC” into

the Name detail item. Once the Company profile sheet is opened

you can enter in the company information and edit the company

name. When you are finished you will have a profile that looks

something like Figure 5.18. As you can see, the Company profile is

linked to Mr. Doakes’ profile. 50 now we have Mr. Doakes and his

company entered in Perspective.

Creating and Attaching a Note
Our next task is to attach a note to Mr. Doakes’ Name profile. To

do this, draw a caret A in the Notes box on Mr. Doakes’ Name pro~

file. A Perspective Notes profile will float in front of the Name pro—
file and have the current date as its title. You can write in ink, have

what you write translated, or use a combination of both ink and

text. Figure 5.19 shows the note after some inane nonsense has
been written. (Please remember I’m not an artist.)

When text is entered into a Perspective note you either have to write

very clearly or use an editing pad. The note pad does not really han-

dle text well, and it is difficult to use PenPoint editing gestures.

To edit the text:

1. Toggle to text by tapping Y on the Pencil icon.

2. Tap l’ on the writing you want to edit or translate.

3. Draw a circle 0 over the selected writing. An editing pad will

pop up and you can then edit the text (or translated writing).

D (:Ionipar'l’j.-’: ABC: E’i/idgets dd}

l Profile Edit
l t C»: me am"

:1)

  
165571200

|

l
x

l: Business F'é'a~:il‘.e [

Fay: r, i ,
 
 ‘1 c 55-1250

Address. 1234 tartan: St.l

l 7‘ ‘ '1
I buitr: 51L

l City Ci‘aliland ,

l State CA ZIP 94500
l Notes Dcoun’er‘as

l Ernfie‘ofifi
Jake Doakes
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When the Associate is active in the notes page it will automatically

link with any name that matches the first or last name in a Person

profile, a company name in a Company profile, or the short name

from any Name Items profile. If you enter text that does not auto-

matically link, the Associate will ask if you want to create a link

for the text you enter. Having the Associate constantly ask to link

can be annoying, and you might want to turn off the Associate’s

“ask for Help” feature in the notes page.

Notice that ABC in the note is in bold text (see Fig. 5.19). This

means that the note is now linked to both ABC company and Mr.

Doakes. It is linked to Mr. Doakes’ Person profile because the note

was created from that profile, while the link to ABC was created

automatically because ABC is the short name for ABC Widgets.

To see the note’s associations you can look at its profile. To View a

note’s profile, tap Y on the Show Profile menu in the note. You will
then see something that looks like Figure 5.20.

From the profile View you can see all of the information associated

with the note, including a reduced picture of the note itself. Notice

in the note’s profile that you can attach both notes and documents

 

to notes.

Figure 5. [E 9 ,x/ Fine June it , i 9‘93
Note Edit flittitans Show Profi|e

The note I k t IH 0 6
attached to 99

Mr. DOGkES ABC izzfzz’iui‘achres disk widgets for ejecting l‘v‘lac disks.
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When naming your notes, you may want to use a name that is more
descriptive than the note's creation date. If you wont to change the
name of a note you do so from the profile view or by gesturing a
circle 0 on the note’s title.

In Figure 5.21, take note of the links in Mr. Doakes’ profile. First,

there is the link to ABC Widgets in the Company field, and in the

General Links detail item you can see the link to the note as well.

To View the note you can double tap l’ on the note’s name, or tap Y
on the Note icon in the Notes box and then tap Y on the note’s
name after it pops up.

Scheduling a Phone Call

NOW that a profile for Mr. Doakes has been created, the next task is

to schedule a phone call. To schedule a phone call it is usually easi—

est to use the Create menu, although you can write directly on an

item line in any of the Day Planner’s lists.

To create the Phone Call reminder:

1. Tap Y on the Create menu.

2. Tap Y on the Other menu selection. You will see a pop-up
menu that looks like Figure 5.22.
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3. Fill in the Phone profile’s details.

When filling in a profile sheet for any Calendar Items category,

you have several options for linking your information. First, you

need to fill in the Description item. If you enter a name, the Asso-

ciate will automatically link the Calendar item’s profile to the

proper Names profile. When filling in the description item, if the
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”Let the Associate ask for help” option is on, the Associate will ask

to link anything you write if you use any of the following descrip-
tors before the text.

@
About

appointment

appt

at

breakfast

brkfst

call

dinner

lunch

meet meeting

mtg

phone

re

regarding

with

W/

If you do not use a descriptor and the name does not exist, a link
will not be created.

Once you have the description entered you need to set the Start

and Finish By dates. The profile’s creation date is automatically

entered into these detail items, but they are easy to change or edit.
If you tap Y on the small dot to the left of the date you will see a
pop—up menu like the one in Figure 5.23.

The pop-up menu lets you enter one of the options listed for your

target date. You can edit the detail item by tapping Y on the Edit
choice or by tapping Y on the Date detail item. Either action will
cause an editing pad to appear.
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Figure 5.23
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After you have entered your Start and Finish By dates, you can

assign a priority. The priority is assigned by tapping Y on the
arrow in the Priority detail item and selecting the priority from the

pop—up list. Your choices are ASAP, High, Med, and Low.

The priority detail fie/cl contains a pop-up list.

To aclcl a new category to the list such as Personal or Business:

7. Draw a caret tap /\ in the Priority detail field. A pop-up editing
pad will appear.

2. Write in the new category and tap .V on the New Value button.

The new category will be inserted into the Priority detail field as

the lowest priority. It will also appear in the pop—up list anywhere

the Priority detail field is used. This technique will work for any

field that uses a pop-up list.

Once the Phone Call profile is complete, your To Do list will dis—

play the phone call on the date scheduled. The other detail items—

time started, finished, or canceled—will be automatically filled by

actions you perform from the Day Planner page. Once the sched-

uled day arrives, the Day Planner will present you. with the phone
call reminder.

On the day that the reminder appears you must do something

with it. It will not go away but appear on your To Do list every

subsequent day until you delete, cancel, or finish the phone call.
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It is now next week and you are out of the office making client calls [oryou could be in the office, for that matter), looking through your To Do
list as you start the day. You see the reminder to call Mr. Doakes. By clou-
hie tapping on Mr. Doakes’ name you recall his address record, and
attached to his address record is the note about his company.

You decide that you want Mr. Doakes to have additional information
before you talk to him, so you fax him a note directly from your EO. Then
you convert the phone call reminder to an appointment reminder and set
the alarm so your EO will notify you in a couple of hours. Two hours go
by, the alarm on your EO goes off, and you call Mr. Doakes (from your
EO if you have the cellular option). While you are talking to him you are
creating a new note that details your conversation. This note is also at-
tached to his address record, you get the information you need, and he

promises to fax you a response.

To the right of the Phone Call item you will find a box that is

labeled Status (see Fig. 5.23).

When you tap l’ the Status box next to a To Do item in a list you
will get a pop—up list like the one in Figure 5.24. If you tap the In

Progress option, the date on which you tapped the option will be

entered into the Date Started detail item in the Phone Call profile.

Likewise, the Completed and Canceled options also enter the

appropriate date in their detail items. Your To Do items will auto

matically be forwarded. to the next day until they are either com~

pleted or canceled.

The Following Week

The purpose of this section is to show how you can embed a docu—

ment and convert a Calendar items profile from a To Do to an

Appointment. The actual mechanics for faxing a document are

covered in Chapter 9.

Creating and Faxing the Note
A week or more has passed. You turn to your Day Planner and see

that you need to call Mr. Doakes. But first you want to fax him

some information about your requirements regarding his com~
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pany’s product. So you double tap ,l’ on his name in your To Do
list to call up his profile.

To create the document that you are going to fax:

1. Draw a caret /\ in the Document box or a double caret A any—

where in the profile. You will see a pop—up list of the docu~

ments you can create.

2. Select your company's stationery document, or whatever sta~

tionery file you wish to use, by tapping on the Stationery selec-

tion. Figure 5.25 shows a list of available stationery documents.

(Instructions for creating stationery are in. Chapters 3.)

3. Write your letter /note in the MiniText document.

4. From the Document menu in MiniText select the Send option
and fax the letter to Mr. Doakes.

There are a couple of things to note here. One is that if you copy

Mr. Doakes' record to the MiniText document you can copy all of

his address information. This way you do not have to manually
enter the information.
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To enter all of the address information:

1. Go to the Address Book and tap press 4. on the Item line for

ABC Widgets to copy it.

2. Move the copied record to the banner of the Address Book so

you don’t copy the item to another Item line.

3. Return to the Day Planner. Your MiniText document will have

closed, but Mr. Doakes’ profile will still be open, and the copied

item will be in the Day Planner’s banner. (See Fig. 5.26.)

4. Move the copied record to the MiniText document by dragging

it to the place where you want the information to appear. All of

the address and phone information will be copied. You will

have to massage the information just a little bit by turning the

tab characters into returns. In Figure 527 you can see the

copied Address item just as it was copied.

5. Quickly edit the address and it will look like Figure 528.

N01? The other note of interest is that the Address Book from Personal Per-
spective can be used as a system-wide address book so all phone
numbers, including Fax numbers and AT&T Mail addresses are
available to the built—in fax and Email software. This means that you
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do not have to create duplicate phone books for each of the EO’s
built-in functions.

For more information on using MiniText, see Chapter 6.
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Changing the Phone Call to an Appointment

According to our scenario, after you have faxed the document you

will want to change the Phone Call into an Appointment. You

have the ability to change any category item, such as a Calendar

Item or a Name Item into a different item type. This means that

you can change a Person into a Company and Vice versa. The prin~

ciples are the same for any profile that can be changed. Now we

will continue with our example.

To change the Phone Call into an Appointment:

1. Open the Phone Call profile.

2. Tap Yon the arrow to the left of the words ”Phone Call.”

3. You will see a pop-up list of the available profiles. Tap Y on the
Appointment selection.

4. Perspective will ask if you really want to change the Phone

Calls profile. (See Fig. 5.29.)
 

Figure 5.29

Perspective

GSking if YOU ' Change category.»r from ’Phone Call’ to ’Appointment’?
wont to

change the

.-‘m‘i:nte titlin- F‘esweie ..

  
profile

Kyocera PX 1046_209



Kyocera PX 1046_210

i.

i 192 CHAPTER5

5. Tap Y on the Change button. The Phone Call will be changed to
an Appointment.

Once the profile has been changed you will have to enter in the

alarm information and set the appointment time. This is done by

tapping Y on each item and making the appropriate changes.
Scheduling an alarm will cause the E0 to beep at you when the

predetermined time arrives.

When your EO beeps you can either use the E0 Phone program and

have the E0 dial the number, or you can recall Mr. Doakes’ profile

and dial the number yourself. The E0 Phone program is discussed

in Chapter 9. If you are using an E0 with the cellular phone

attached you will have to use the HO Phone program because the

EO controls the phone. Regardless of your dialing method, you con-

tact Mr. Doakes and he promises to fax you a document.

Finishing the Transaction

The final part of this information transaction is receiving a fax on

your EO and scheduling another call. You can receive the fax on
the E0 if it is attached to a fax line (and has a modem), via the cel-

lular module, or you can have the fax sent to your AT&T EasyLink

mail box. Using the EO’s fax and Email capabilities are described

in Chapters 8 and 9.

Once you have received the fax, it will be in the your EO’s InBox.

After Viewing the fax you can print it. (Printing is discussed, in the

PenPoint chapter.) If you want to retain the fax, attach it to Mr.

Doakes’ profile. (This makes it easier to keep track of the fax.)

To attach the fax to Mr. Doakes’ profile:

1. Open your Address Book and turn to the page with Mr.
Doakes' Address item.

2. Open your lnBox.

3. Select the fax from the lnBox by pressing i on it in the InBox

contents page.

4. Move the fax document to Mr. Doakes’ Item line and place it in

the document box. Figure 5.30 shows the fax after it has been

moved to Mr. Doakes’ profile.
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Fifteen minutes later you receive the fox, again on your E0. After read-ing the fox you attach it to Mr. Dookes' Address record ond print the
fox. if you’re on the read, your EC) will wait until you return to the office
and print the fox when you connect your E0 to the printer. Finally, you
schedule another cell and you’re done.

Figure 5.30

The fox otter it

has been

moved

The above steps can be used to attach any document to a profile.

These steps do not pertain only to faxed documents. The docu-

ment box of any Perspective profile can contain multiple docu—

ments. This feature makes it easy to keep track of and back up all

documents pertinent to a specific person or company. Although

you can keep your documents in a notebook and keep every one

separate by sections, it is just as easy to attach the documents to a

Personal Perspective profile. The choice is yours.

Special Functions

Personal Perspective has special functions that will make it easier

to use. In addition to the special functions, there are also some
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tricks you can employ to add to Personal Perspective’s versatility.

This section will quickly cover these functions and tricks.

Because there are quite a few items to be covered, their descrip—
tions will be brief, but accurate. The functions that will be covered

are not covered elsewhere in this chapter. They include shortcuts

for sorting columns, creating special lists, printing tricks, finding
information, and more.

Column Sorts

Although it is possible to specify sort criteria with the Sort selec—

tion from the Options menu, there is another way to perform a

quick sort in a list. You can sort any list by double tapping ,l’ on the
column title of the column that you want the list sorted by. This

will cause the entire list to be sorted in ascending order, alphabeti-

cally or numerically, by the contents of the column.

Reclaiming Extra Space

The Profile Book uses disk space very efficiently. But after

extended use it is possible for it to be using more disk space than it

really needs. Also, if for some reason you have information—that is

not appearing in your Perspective lists properly, your Profile Book
could be the cause. (In a sense, it could be confused.)

To reclaim lost disk space or to perform minor repairs on a Profile

Book, draw a capital R on the Profile Book page. Although this is
called a “Reclaim” function, it is also a ”rebuild” function. The

Profile Book is rebuilt so that all associations are double~checked,

and any extra space, usually caused from deleting items, will be

recovered. This feature should be used sparingly.

inserting instance Details

There will be times when a profile does not contain a field for the

information you want to display or include in either a profile or a

list. When this happens you can use the Edit menu in the profile

sheet and select the Insert Instance Detail. Figure 5.31 shows the

open dialog sheet with a list of detail categories that you can insert.

With the Insert Instance Detail options sheet you can also create
new detail items.
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Figure 5.31 AlarmBusiness F’i'ione ii
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Stan. ESE.”
Started
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To create a new detail item:

1. Open the profile to which you want to add the Instance Detail
field.

Tap l’ on the profile’s Edit menu.

Tap l." on the Insert Instance Detail item.

Tap Y on the arrow next to the label Type.9799”!“
From the pop—up menu select Note Title item. (Tap Y on the
Note Title item.)

6. Tap Y on the Insert button. Do not press the Insert and Close
button. After you have inserted the Note Title detail item, the

Insert Instance Detail dialog sheet will look like Figure 5.32.

7. Tap l’ on the arrow next to the label Type. Tap Y on the type of
field you want to create.

Figure 5.32 // Insert instai’ice Detail

The Insert Name: v

Instance Detail Type: > Text

dialog sheet. . Formal: D As‘v‘v’riiten

otter inserting
 

0 Note Title insen‘ 3513);: 
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8. Tap Y on the arrow next to the Format label to choose your for—
matting options for the new field.

9. Write the item’s name on the line next to the Name label, or

tap l." on the Insert or Insert 8,: Close button.

Once you have given the field. a name and inserted it into your

Profile Sheet, you will have access to the field from any Profile

sheet (using the Insert Instance Detail), and you will also be able to

insert the detail as a column in any list.

Something you should note: once you have created a new detail

item in Personal Perspective there is no way to delete it. It will

always appear in any list that contains your detail items even if

you delete the detail item from every profile that contains it. So be

careful and do not make a new detail item until you are sure you

need it. Otherwise your list of available detail items will get very

large and difficult to manage.

That Which Was Lost Will Be Found

Sometimes it can be difficult to find the specific profile item you

want. You may have used an incorrect name, switched the last and

first names, sorted your list improperly, etc. Whatever the reason,

Perspective has a built—in Find function so you can quickly retrieve

any profile.

The Find function works from any Perspective list. To invoke it

draw a capital F on the Title line or the list’s banner or use the Find

selection from the Edit menu. When you implement a find, a Find

options sheet will appear like the one in Figure 5.33.

There is also an advanced find that you can use to find the occur—

rence of a word or specific condition such as all in—progress Calen-

dar items. To do an advanced find, start a regular find, and then

 

 
Figure 5 .33 E/SMC s! Elk-l ner- L r L Find

The Find E Find;

cllolog sheet E new”:
 

l .z 1 . ,2an ‘ of“ .53 CA fill-
Eit a; map} Jl’raiWM
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tap the arrow next to the Find label in the Title line of the options

sheet. This will let you switch to the Advanced Find options sheet.

In Advanced Find you will find your information first by the type

of item. You can search an entire category such as all Calendar

items, or search Phone Calls only. Then you select the detail item

you want to search by selecting the detail item in the “where” line.

You will have choices such as Contains, ls, or Is not, depending on

the type of detail item chosen in the second line of the “where” sec—

tion. Finally, you enter the name or condition you want the search

to match in the third line of the “where” section. See Figure 5.34.

In either Find dialog sheet you can go from occurrence to occur—

rence by tapping on the directional find buttons, or you can have

Perspective find all items that match your search criteria by tap—

ping l’ on the Show All button. The Show All button lists all occur—
rences that match your search criteria in a selection sheet. Here

you can see each profile that matched your search by double tap-

ping on the found items.

Special List Paper Options
It is possible to create special lists that display information accord—

ing to your special needs. To do this, copy an Address Book or Day

Planner from your Stationery Notebook to another notebook. Only

use a Day Planner if you are going to create a list with date-sensitive

items that you want cleared as they are finished. Usually, either an

Address Book or an imported Perspective List paper will work best.

When you turn to the new Address Book for the first time, Per—

spective will ask you which profile book you want to use. After

you have selected the profile book, the Address Book will open,

showing your information. Now you have to customize the list.
 

 

Figure 5.34 1/ EilviC Plarmer b Advanced Find i
- E l
lhe Advanced Find: ) ‘ZZIalendarltems l

Find dialog where: r Elam; l

sheet ’ 1'9 l
1 fi' in Progress ]‘ l

Result: 1

#— 
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Customizing the list is done by deleting columns you do not want

and inserting detail columns you want to see. To delete a detail

column you draw an x for delete X on the column title, or use the

Delete Column command from the Edit menu (after selecting the

column). To insert a new column you can either draw a caret /\ on
the Column Title line or use the Insert Column command from the

Edit menu. Select the detail item you want to display from the

pop-up list and a new column will be inserted showing the infor—
mation in the detail item selected.

Do not delete all of the columns from a list. If you delete all

columns you will not be able to insert a new column, and you’ll

have to start over. Always leave at least one column.

Once you have the detail columns you want to view, you can fur—

ther specify how the information is displayed (depending on the

type of list you are using) by setting the Paging and Sort com-

mands from the Options menu. You will have to experiment with

both of these commands to get the information you want dis—

played properly. However, it is usually worth the effort if you

want to view specific details such as phone numbers only.

Another reason for going to this trouble is so you can print a list of

specific information. The printing capabilities of Perspective do

not include custom reports, so you will have to create a special list

to print a custom report. For any special report, make a list that

shows the information you want printed and print the list. The

same applies to exporting information. This is covered next.

Importing, Exporting, and Backing Up
Your informtien

This section will cover importing, exporting, and backing up Per-

sonal Perspective information. Those features that are covered in

Chapter 7 will not be repeated here. For instructions on actually

transferring your information from one disk to another or from

one machine to another, see these chapters.

Importing Information into Perspective

To import information into Perspective you use the same basic

procedures described in Chapter 7 for importing information into
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your E0. When importing Perspective information you need to

choose the Perspective List Paper option when actually moving

the information from one disk to another or transferring the infor-

mation file from a desktop computer.

Before the information is transferred you will see an Import Infor—

mation options sheet like the one in Figure 5.35.

Prior to transferring your information into Perspective you need to

make sure it is in the proper format. Perspective accepts ASCIL
delimited data. ASCII—delimited means that items or fields in the

data you are importing are separated by a special character. Per—

spective accepts either tab— or comma—delimited fields. If you have

data where the fields are separated (delimited) by any other char-
acters, or if the data has extra tab or comma characters in the

fields, your import will fail. Creating a delimited import file is

most easily done with a spreadsheet on a desktop computer.

When importing information you have to select what category

you’re going to use. You can select from all the major category

groups. Figure 5.36 shows the Import category options.

There is a bit of trick involved here. If you are importing both indie

Vidual names and company names you can only choose one or the

other. If you select Person as the category you will have to change

all the companies you import into Companies after they’re

imported. If possible, you should divide your information. and

 

 
Figure 5.35

The Import Filename:
lnformafion Format: 549.333 Delimited

OPl'lOflS Sheet Number ofllerns: 417
Catego ry: b F'ersor‘;

Remove 1st Line: > No

 
{St—lee? Details: 1th import
Sample Data Detail
3Com Corp. J Sift/77;?fifijr' 1r
Mike > Name

 
1831 Larkin > Address

Etuit‘ ' W? b Do Not moor:
> Do Not llnpcn
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Figure 5.36

The import Filename: EXPORTIW

category Format: user Delimited

options Number of Items:
Category: ? Appointment

”we; 1
Remove 1st Line: E‘ Tto Do

Phone Call

  

 
 

 
 

    
Select Details to impc
Sample Data‘ ,—. m W E“ ,_ V
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._ fl fl
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import the Persons and Companies separately. However, this is

not the tricky part.

The tricky part is assigning the detail items. Do not, and I repeat do

not, select any of the major category headings as an import field. If

you do, no information will be imported. Remember, the major

category groups are Calendar, Name, Note, and Misc. Items. Only

use actual detail items for receiving information when importing.

If necessary, create any fields you may needfirst.

To make the import easier, on the first line of your import data file

label the fields with the same names as your Personal Perspective

detail items. This way, when you import the information, Perspec—

tive will automatically assign the correct information fields to the

fields you are importing. If you use this option, be sure to remove

the first line of all your imported information. (See Fig. 5.36.) Oth—

erwise, you will have to assign the correct Perspective detail items

to the corresponding information fields of your import informa—

tion. For any information field being imported you can specify

whether or not a particular field should be imported.

Once you have assigned the proper Perspective fields to the infor—

mation fields being imported, Perspective will ask you which Pro—

file Book you want to import the information into and present all

of the available Profile Books for selection. After you select the

Profile Book your information will be imported. Once the informa—
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tion has been imported you will be able to View the information in

a Perspective list that shows the detail items and information you

imported. This list will have the name you assigned to it when it

was imported.

You should review the information to make sure it is correct by

turning to the imported page and verifying that the detail items

are correct. If everything is correct then you can delete the Per—

spective List Paper that contains the information you imported.

Your information will then be permanently stored in your Profile

Book. Remember, before you delete the import list make sure the

imported information is correct.

If the import was incorrect for any reason, you can reverse the

import, so long as you do not delete the Perspective List Paper

that contains the imported information. If the import is incorrect

select the first row of the imported information and then scroll to

the last row and draw a plus + in the row number. This will select

all of the information in the imported list. After all of the informa—

tion is selected, draw a delete gesture X anywhere in the selected

area, and delete all of the imported information. After the informa-

tion has been deleted you can delete the import list and start over.

NOEE You can use an import list to create special List Paper such as that
described in the section on special List Paper options. Whenever
you import Perspective List Paper, the blank lines in the list are rec—
ognized by Perspective as a Person category. However, the lines of
imported information will have the profile you selected for the
import and any extra detail items you selected. Although you can-
not access the special profi/e from the Create menu, you can create
a template b selecting one of the detail items with imported infor—
mation and y cop ing this detail item. Then you can edit the line
and have a relative y custom profile.

Exporting Information

The process for Exporting information is just the reverse of the

process for importing information. Perspective will export your

information in ASCII tab— or comma—delimited format. When you

export information you do not copy your Profile Book to another

disk, but instead you copy the Perspective List containing the

information you want to export.

Kyocera PX 1046_219



Kyocera PX 1046_220

E 202i CHAPTER 5

This is where making a custom Perspective List can come in

handy. If you create a list with just the information you want to

export, you will not have to massage it once you get it wherever it

is going, that is, your desktop computer. After you get it onto your

desktop computer you should check the information with a

spreadsheet to make sure it is correct.

Backing Up Your Information

To back up your Perspective information, all you need to do is

make a copy of your Profile Book or Books. To do this, follow the

procedures outlined in Chapter 7 for copying information files. All

of your Perspective information is stored in Profile Books. If you

keep your information in various Profile Books, be sure to copy all

appropriate Profile Books to your back-up disks. If you have made

any custom lists, be sure you back them up as well.

ingBIefvj542' ‘l‘Speciol gestures 
l Gesture Name Gesture Function 4—1

Circle Used to open a profile when the gesture is performed on a line num~

ber. Otherwise it will open a pop—up editing pad to change the con-
tents of a detail item. Also used to translate ink entries.

Caret In a Profile sheet it will bring up an Insert Instance Detail dialog
sheet. In a List's column it will insert a new column. In a detail item it

will pop—up an empty editing pad.

Triple Tap Selects a detail value in a profile or list, and selects everything in a
note.

D Performed on the Title or Menu line to hide or show the tab margin

in a Perspective Page.

R Used on a Profile Book to reclaim space.

l Plus Used to extend or reduce a selection either across columns or addi—
. tional rows.

T To show or remove a notebook tab, this command works from the

page you are currently on.

Double Caret Embeds a document into a profile and works on detail rows or profile
sheets.

Cross out In a Column heading deletes the column, in a row number deletes the

profile, in a linked detail item it deletes the link (does not delete the

linked profile).
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Table53 i‘PersbncilPerSPective“rfienU$‘ . ‘ ‘ ‘ ' 
Menu Sub-Menu Description 

Document Checkpoint This option forces Perspective to save your information. You

should use this option often if you are operating in the accel—
erated mode.

Revert Reverts your document to its condition prior to executing a

checkpoint save.

Print Gives you with the PenPoint and Perspective Printing options.

Print Setup Sets your printing parameters.

Send Allows you to send a Perspective document via fax or E—mail.

Document About Gives you system information about the current document.

Edit Undo Allows you to undo any editing changes or reverse the last

Editing reversible action. All edit menus change depending on what

is selected. If a row is selected the edit commands pertain to

the row. Likewise, the edit commands apply to columns and
individual fields.

Move Move selected item. Same as using a press gesture i.

Copy Copy selected item. Same as using a tap press gesture A.

Link Link selected item. Same as using the Stick Pin from the

items profile.

Insert Inserts a blank item after the selected item.

Delete Deletes selected item. Same as using the delete gesture X.

Translate Translates any ink writing in the selected item.

Edit Edits the selected item. This command either opens a profile

or a pop—up editing pad. Same as using the edit gesture (the

circle) 0.

Find... Opens the Find options sheet. Same as gesturing with an F
on the Title or Menu line.

Options Selected Shows and allows you to set the options for the selected

Item item. Performs the same function as gesturing with a check

mark c/ over the selected item. With this command you can

set the attributes for rows and columns. To apply the attrib—

utes to an entire page select the first row and gesture with a

plus on the last row, then apply the options you wish. to set.

Selected The selected page could be appointments, To Dos, or your

Page Address Book. This command displays the options available

for what ever page type or item you are using.

 
(continued)
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 Table 5.3 PersonalPerspechve menus(conhnued)

Menu Sub-Menu Description 

Sort Sets the sort options for the list you are using. This com—

mand is page~specific.

Tile Sets the tile options for the list you are using. This command

is page—specific.

Layout Sets the layout options for whatever page you are using. The

layout is how the page appears, including whether or not the
banner will be shown.

Inkwell Sets the Ink attributes for Perspective.

Options Associate Sets the attributes for the Associate. You can set the Associ-

ate to be on or off, Associate in your notes, and whether or

not the Associate will ask for help (this applies to using the

key words in ”Scheduling a Call" section) or automatically

ask to link items with key words that are not found in linked
detail items.

Controls This command is used to set PenPoint page controls like the

Menu Line, Cork, Tab, and Scroll Margins.

Access These options determine whether the page is deleteable, its

Access Speed (it is recommended that you use standard

access speed unless you. have lots, like 20 Megabytes, of

memory), and. which Profile Book the list is using.

Comments Allows you to set the Page’s title, assign an author, and enter

comments for your own use to identify the page.

Actions Show Notes Shows notes attached to a selected item. This is the same as

tapping Y in the Notes box.

Show Shows documents attached to a selected item. This is the

Documents same as tapping Y in the Documents box.

The following actions apply only to the Day Planner.

Add Tab Adds a tab for the selected date to the bottom of the Day
Planner.

Set Alarm... Allows you to set an alarm for an appointment.

Repeat Allows you to set a repeating Appointment.

Show Year Pops up a Year at a Glance Calendar. When you tap on a

date in the Year at a Glance Calendar, your Date Book will

jump to that date.
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Special Gestures

Table 5.2 is a partial list of the names and functions of gestures you

can use in Personal Perspective. Some are listed because they dif-

fer a little bit from the standard way in which PenPoint uses these

gestures, and others are here simply as reminders. All other Pen~

Point gestures can be used in Perspective as well.

The Personal Perspective Menus

Table 5.3 provides you with an overview of Personal Perspective’s

menus. Each Perspective menu option will be discussed.

Conclusion

There should be enough information in this chapter to keep you

busy for a while, especially if you have an E0. If you are reading

this book to get an overview of the E0, 1 hope that it was interest—

ing enough to keep you engaged while at the same time giving

you an idea of just how powerful the EC) can be.

To each person the importance of this type of organization and

control is different. But I’d be willing to wager that the time saved

and increased productivity alone would let you pay for an E0 in

short order. Don’t forget the extra time you should have as well.
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Using the EO’s Built-

in Applications

 
ntroducion

In the last chapter we looked at Personal Perspective, one of the

130’s built—in applications. Of all the programs that the Communi—

cator comes with, Perspective is the most complex. The E0 also

has four other applications all of which, when combined with the

130’s accessories and Personal Perspective, make the E0 Personal

Communicator a tool that is complete and ready to be used out of

the box. It is possible for you to use the EC) without ever purchas—

ing another software package.

The applications that come with the E0 discussed in this chapter
are MiniText, MiniNote, BO Calc, and E0 Sound. GO Fax Send

and GO Mail are also applications bundled with the E0, but these

will be discussed. in Chapters 7 and 8. In this chapter we’ll look at

the four EO applications and discuss their individual uses and

how to use them together.

The other topic discussed in this chapter is application embedding.

One of the advantages that the E0 Personal Communicator has

207
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over a standard computer is that you can embed documents inside

of each other and still View the contents of the embedded program.

What this means is that it is possible to draw a picture in MiniNote

and then embed that picture in a MiniText document so that both

what you have written and the picture are visible on the same page.

This chapter will start by discussing EO applications in general,

then it will discuss the EO’S built—in applications mentioned

above. It will conclude with a discussion on embedding applica-
tions in each other.

Application Basics
PenPoint is the EO’s operating system (discussed in Chapter 3).

One of the nice features about PenPoint is that it was designed to

provide the user with a consistent and economical interface.

Because interfaces for PenPoint applications and the PenPoint

operating system are consistent, you don’t have to ”relearn” how

to work every new EO application. This consistency makes you

feel very comfortable using the E0.

The basics that are consistent for all EO applications are: creating,

opening, deleting, printing, and in most cases, editing documents

or applications. I say documents or applications because when

using the E0, each document functions just like an application——

the two appear to be one and the same. This makes the old lan—

guage of computerese a bit difficult because the distinctions no

longer carry the same meanings.

A new word should probably be devised for this new category of

software. But that might confuse things even more. The computing

industry has enough problems with the names of things and it

doesn’t seem right to make up one. So, let’s just agree to call all of

the applications and documents “documents.”

NOl'e For those of you who really want to know how your EO works, the
distinction between a plications and documents is real. However,
this is not to say thatt e document is the application.

When an application is installed on an E0 there is some program—ming code t at gets installed at a very low system level. In this
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sense an a plication is installed. What makes the application and
documentt e same is that the document is the only access you have
to the application. There is no way to access or start an application
other than through a document.

In a traditional computing environment you can run an applica-

tion and access multiple documents by opening them from within

the application. On the E0 you can only open the documents.

Anything that belongs to an application is used by all documents

that the application controls. Thus, a document can be broken, or

all of the documents for a particular program can be broken

because some part of the code is not working properly. When this

happens you will see a document with a slash through its icon like

the PenCross document in Figure 6.1 on the following page.

While using the EC), what you will probably care about most is

finding the page that has the information you need. Most people

don’t really care about where it comes from, just whether or not

they can use it and how they can use it. Thus, we’ll look at how to
use different documents.

This section will cover creating, editing, and printing a new docu-

ment, plus the PenPoint gestures you’ll need to know. If you want

to know more about the mechanics of how your EO handles appli—

cations and documents, you’ll find the information in Chapter 3.

Creating a New Document

There are three basic ways for you to create a new document. One

is to use the create gesture which is the caret /\ gesture. Another is
to use the Create menu in a notebook’s table of contents. And the

third is to copy a blank document from the Stationery Notebook,

placing the copied document into the notebook where you want it.

The reason you have so many methods for creating new docu-

ments is to make it easier for you. When you create a document

you put it where you want it and you do not have to worry about

finding the application and then deciding where to put the docu-

ment, or finding the application and then hunting all over for the

document you want. All of your documents are immediately

accessible and easy to find.

Kyocera PX 1046_227



Kyocera PX 1046_228

WI 0 3 CHAPTER 6

Figure 6.1

The Stationery
Notebook

You have four methods for creating a new document—we’ll talk

about three of those right now. (The fourth is used only for embed—

ding new documents, which we’ll discuss a little later.) To under»

stand how these two methods work and how they’re all related,

we’re going to first look at the Stationery Notebook;

The Stationery Notebook

All of the documents available for use are stored in a special note

book called Stationery. Whenever an application is installed, the

blank documents (called templates) are automatically stored in the

Stationery Notebook. In Figure 6.1 you can see some of the docu—
ments that are available on this EC). Do not be distressed because the

E0 has so many documents (it has been on steroids for some time).

To see what documents are available on your EO, tap Y the Sta-
tionery Notebook on your bookshelf. After it opens you will see a

standard table of contents. Each program that is installed on your

EO has its own section, with the title being the same as the appli—
cation. Inside each section there will be at least one document. You

should not have empty sections in your Stationery Notebook

unless you put them there.
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Other things to note about the Stationery Notebook are the Menu

Check boxes and the PenCross document with a slash through its

icon. The Menu check boxes are for telling the E0 which docu—

ments to display in the Create or pop—up menu. When the Menu

check box has a check mark the document will appear in a, note—

book's Create menu (see Fig. 6.2) or the pop~up menu you see

when you use the caret /\ gesture.

The PenCross document with a slash through its icon is an exam—

ple of a broken document. In this case the E0 thinks that the pro—

gramming code required by the document is not installed, and as

a result all PenCross documents are unusable. This problem can

occur with any document, and it is discussed further in the trou-

bleshooting chapter.

If you use M gesture on the Stationery Notebook’s Title line to dis-

play the Menu line, you will notice that it does not have a Create

menu, nor will the caret /\ gesture work (see Fig. 6.3). This inabil-

ity to create documents occurred because the Stationery Notebook

(which controls the creation of new documents) is a special Pen-

Point notebook, and the E0 currently thinks PenPoint is broken.
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To create a new document using the Stationery Notebook, you

have to copy the document from the Stationery Notebook to the
bookshelf or another notebook.

To copy a document from the Stationery Notebook:

1. Tap press 4 on the document you want to copy.

2. Drag the document to its new location (your bookshelf or

another notebook).

Documents and Templates
Think of the documents in the Stationery Notebook as blank tem—

plates—~they are custom—designed form letters that can be used

over and over again. As with any blank form, you should make a

copy of it and write your letter on the copy, saving your clean orig—

inal for the next time you need it.

The purpose of the Stationery notebook is to store all of your blank

templates. You can modify templates in the Stationery notebook

and copy them to create new templates; you can also create new

templates by copying documents from other notebooks into the

Stationery Notebook.

If you want to delete a document from the Stationery notebook

you should be careful; you will no longer have access to it from

the Create menu. The only time you cannot delete a document in

the Stationery Notebook is when it is the only document of its

type on the E0. If you try to delete a document in the Stationery

Notebook and it is the only one on your EO, you will get a mes-

sage like the one in Figure 6.4.

The message in Figure 6.4 above is not unique to the Stationery

Notebook. You will get this message if you try to delete an only

document regardless of where it resides.

The Coret Method

The caret method is the easiest way to create a new document. The

EO’s object-oriented system shows its value here—all you do is

tell the E0 that you want to create a document, and then it pre-

sents you with a list of all the types of documents you can create.
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can l delete You can’t delete or move
'Sound' because it is the last
document of its kind. There
must be at least one document

for each application.

document

dialog sheet
 

 

To create a document:

1. Gesture a caret /\ in your notebook or on the bookshelf of your

E0. The E0 will give you a pop-up list of available documents

(see Fig. 6.5).

2. Now tap Yon the type of document you want to create (includ—
ing a new section). The document will appear in your note—

book in the general area of where you gestured with the caret.

Figure 6.6 shows a notebook with three sections named Level

1, Level 2, and Level 3.

Each section resides on a different level. To create your document,

insert a caret /\ on the section where you want the document

placed. Take care Where you insert, however. If you draw your

caret right beside the Level 2 box, for example, it may be inter-

preted as being under Level 1. If your document does not land

where you want it, you can always move it. To move a document,

press i on the document and drag it to the new location after the

marquee appears.

 

 
 

Figure 6.5
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NOTE Remember, the pop-up list may not contain all of the documents
installed on your EO. Only those documents marked to appear in a
menu with a Stationery Notebook will be displayed.

To create a new notebook you can either copy an existing one (this

will also copy the contents of the notebook) or gesture with a caret

/\ on the bookshelf. When you do this you have the option of cre—

ating a notebook as well as any available document.

The Create Menu

The Create menu is available while you are in either a notebook or

section contents page. The selection of documents you can create is

exactly the same as if you gestured a caret /\ (see Fig. 6.7).

To control where a new document will be placed, you need to

select the section or a document in the section where you want the

document created. When you create the new document it will be

placed on the same level as the selected item.

Editing the Document’s Name

When you create your new document it will have the same name

as the selection from the Create menu. To change the document’s

name to something that better reflects its content you need to edit

the document’s title. This is a simple procedure.
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Figure 6.7

The Create

menu
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To edit a document’s name:

1.

Mlnilext

MiniText is the 130’s built-in word processor. A communicator

without the ability to create text documents would be pretty lame.

And if the E0 is anything it isn’t lame.

_ Seozlon 

 
Ml nl Note
I“.4lane:<t

Sound

St at l o n at“)!

 

 
  

22

 

  
.leuuetd{reg:iuawcg
33:03menstrual:

 

 

Draw a circle 0 over the document’s title. This action can be

performed on a document’s title in a notebook, on the book—

shelf, or in the Title line of an open document.

When the editing pad appears, simply write in the new name.

Figure 6.8 shows the editing pad for a document named ”Sta—

tionery.” Since the name “Stationery” is not very descriptive, the

title should be changed to something like ”Letter to Jake.” What

it’s named doesn’t matter so long as it makes sense to you.

I wouldn’t use MiniText to write a book, but it is great for personal

or business correspondence. MiniText is more than a text processor

because it does more than process text—MiniText is an intermedi—

ate-level word processor. The main MiniText features are:

0 Display Control

° Find

0 Find and Replace
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9 Keyboard Input:

6 Paragraph Control

9 Selectable Fonts

‘9 Spell Checker

6* Tab Control

In addition to the above, any document you create with MiniText

can be exported to your desktop computer with all formatting

intact if you export your document as an RTF (Rich Text Format)

file. Also, MiniText can also import a file from any word processor
in the RT]? format.

This means that you can write a letter, memo, book, or any wordy

document and use it as a template, edit the document, and fax or

E—mail the document. By attaching a keyboard to your EO you can

easily type your documents if you prefer. Using a pen to create a

document is fine if it is a short document or if you write very

clearly and quickly. I can write quickly but not clearly, so for me

writing long documents by hand is difficult. If I’m going to use the

E0 to write a long document I use a keyboard. However, if you

want to edit a document while on the run, using MiniText is a

great way to go.
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Editing a Document
{Setting the gcene)
To show you the features of MiniText, this section will go through

the process of editing a document that came from a desktop com-

puter.

The document that I’m going to use to demonstrate the editing
features of MiniText comes from Microsoft Word for DOS. it is full

of misspelled words, grammatical errors, and needs basic editing

before it can be presented to anyone. (See ”Where Is All the Jar—

gon?” on page 219 for the complete text.) The following section

contains the original document as it would appear when printed

from a desktop computer, pimples and all.

Your first task on the your mad dash out the door is to get the doc-

ument into your BC. This can be done by copying the document to

your EO using a floppy drive or with the EO’s built-in networking
and file transfer software Pen Central. The actual instructions for

importing documents can be found in Chapter 7. After the docu—

ment has been copied you are ready to join the rat race. Your docu—

ment will be in your notebook waiting for you to work on it.

 Editing DriftlieJRodd ’ ~ V F‘ :‘ t‘ i If

ere’s a common scenario—the dates and times have been changed

to protect the innocent, but you will probably recognize the underly—

ing mayhem:

it’s 7:00 AM. You're iust finishing breakfast at home when you remember
that you have to present a paper to your colleagues at an 8:l5 meeting
this morning. You commute an hour to work, so you don’t have time to edit
the document on your PC at home or at work. You’ll have to fix the docu-
ment on your way to work to make the 8:15 meeting.

The EO’s communications ability and built~in MiniText application give you
the perfect solution. You can transfer the file from your PC to your EO
before leaving, edit while you commute, and print when you get to the
office. This chapter will show you how.
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Changing the Font

Depending on how you work, you will open the document either

in the notebook or as a floating document If you want to use it as

a floating document, remember to double tapY on the documents
icon. For this demonstration we11 work on the problem document

in a notebook; regardless of how you open the document, the edit—

ing procedures are the same.

Your first View of the document could be a bit ugly. How imported

documents appear will depend on where they originated. DOS

word processing documents will look worse than those coming
from a Macintosh or Windows machine. This is because the default

font for DOS word processors is usually Courier, while machines

with graphic interfaces use a font like Times or Roman. When the

E0 imports a file without an assigned font it will automatically

assign the default system field font to the document’s text.

Once the file has been imported, tap.V on the document’s icon to
Open the file If you want to open the documentin a floating win-

dow, double tap_l’ on the document. Your fi1st View of this particu—
lar document will be like Figure 6.9.

F'gure 6'9g2/"1‘1"PC:IS.DC:H:: 21 >
. DQC‘LH’HEfl'Il Edit Optima \s‘iev-s Inseri Case

Your first

vievv of “We WHERE IS AL: THE JARGON?

Typosxiocffle Jargon pervades software
documentation. Manuals seem unable to.*
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and write about computers are not
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goes with them. JQUIJQHJuanl31115111100
Eliminating jargon from software
manuals becomes more important as more
people use computers. The new breed '
of computr owner is an expert in
particular business, scholarly, or
industrial tasks, but uninterested in
computers except as tools for getting
the job done faster, more easiely, and.
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argon pervades software documentation. Manuals seem unable to

Jescape iargon because computers fascinate those who work
around them and because the people who work with and write about
computers are not afraid of computers or the jargon that goes with them.

Eliminating iargon from software manuals becomes more important as more
people use computers. The new breed of computer owner is an expert in
particular business, scholarly, or industrial tasks, but uninterested in comput~
ers except as tools for getting the job done faster, more easily, and more
thoroughly. For these people, iargon is both a hindrance and an irritation.

Jargon can be effective shorthand among those who understand it, but iar~
gon is a barrier to the uninitiated. i doubt that those who spray jargon
around the landscape really intend to offend or cutoff others who don’t
know the lingo, but the effect is the same regardless of their motives.

To replace jargon, try substituting illustrations with call outs to the impor—
tant features. Then, even if you cannot avoid the iargon, at least the user
has some clear image of how some of the ideas fit together.

Until now, manuals have tried three solutions, with varying success:

Provide glasses of the technical term within parentheses within the text.

Provide a glossary of terms, usually as part of the back matter of the manual.

Express the ideas in other words.

Each of these solutions helps the new reader, but each also has draw—
backs. The best solution will come from a new generation of software that

is itself free of jargon because a new generation of computers provides
significant built-in resources to support advanced, graphical software.

Notice that the first line of the document is centered. This is

because of the RTF format. If the file had been a text document, the

document would not have retained its formatting.

Basically, this is a pretty ugly document. 80 to make it appear a lit—

tle more pleasing so it will be easier to work on, let’s change the

font and set the screen display.
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Figure 6.10

The Edit menu

Figure 6.1 1

The Options
rnenu

CHAPTER 6

To change the font, follow these steps:

1.

/'

Tap Y on the Edit menu (Fig. 6.10).

Choose Select All by tapping on it Y. The entire document will
be selected.

Tap Y on the Options menu (see Fig. 6.11).

Choose Character from the Options menu.
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5. In the Character Option sheet, tap l’ on the font title to see all of
your installed fonts. Select the font you want to use. (We’re
going to use Roman.)

6. If you want to change the font size for the entire document you

can also do so now. Tap on the arrow or the number designat-

ing the font size and change the size.

When you select the entire document and make a font change the

change will apply to the entire document, but any font element

that you leave unchanged will not be applied. In the example

above you will notice that the first line of our document has Small

Caps rather than standard text. If you don’t Change the style no style

Changes will take eflect. The same applies to the Font or size selec-

: tions as well. If the document or selection contains different fonts

and you wanted to change the font size but not the font, so long as

you do not change the Font selection, no fonts will be changed.

These MiniText features apply to any selection upon which you

might want to make style changes.

l
%

Changing the font or selecting a new one is always done in the

same manner using the Character selection in the Options menu.

However, other style changes including Font Size, Bold, ltalics,

Underline, and Heavy Underline can all be accomplished with

gestures. Other than the font itself, the only text attributes you

cannot change with gestures are Small Caps and Strike—Thru.

To use the gestures to change style all you have to do is select the

text you want to change and perform the gesture in the selected

area (indicated by the reverse video selection).

If you want to perform any of these gestures on a single word you

do not need to select the word, just perform the gesture on top of

the word. Otherwise, you can select a single letter, word, sentence,

or paragraph just by tapping. Table 61 lists selection gestures that

work in MiniText. See Table 6.2 for gestures used in changing fonts

size and Table 6.3 for gestures for changing styles.

If you change a font's size and you do not like the results, you can

always perform the undo ESQ gesture. Undo will return your font

size to the size you were using prior to the change.

Kyocera PX 1046_239



Kyocera PX 1046_240

%22 3 CHAPTER 6
i

TquMngtngu 
 Gesture Description

Y Tap Selects a single letter.

I Double Tap Selects an entire word.

:l’ Triple Tap Selects an entire sentence.

V Quadruple Tap Selects a paragraph.

[Left Bracket Selects the text between the Left Bracket [ and the

insertion point or selected text. This gesture must be

performed to the left of or above the selected text or

insertion point.

] Right Bracket Selects the text between the Right Bracket ] and the

insertion point or selected text. This gesture must be

performed to the right of or below the selected text or

insertion point.

  
 

Table“ MmITextges’ruresForehangmgtonts'ze 
Gesture Description 

’t Up Arrow Gesturing with the Up Arrow will increase the font

size by one size as it appears in the Character

Options sheet. If you are using 12—point text and use

the Up Arrow 1‘ you will get 14-point text. This is a

gesture that may give you difficulty. If you have

problems with it be sure to practice it in the Gestures

practice area described in Chapter 3.

\l,» Down Arrow Gesturing with the Down Arrow will decrease the

font size by one size as it appears in the Character

Options sheet. If you are using 12~point text and use

the Down Arrow l you will get 10-point text. This is

a gesture that may give you difficulty. If you have

problems with it be sure to practice it in the Gestures

practice area described in Chapter 3.

  
 

NOTE When altering the text’s style, you can assign multiple attributes to
the text. If you want, you can have Bold, Italics, Strike Thru, Under-
line, and Small Caps all apply to the some text selection.
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The View

menu
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ldeble 63 it ‘MiniTextge‘stures for changingsrylés} 3 “ H  
Gesture Description 

5 Drawing a capital B over a word or a selection will

cause the text’s style become Bold.

Drawing a capital 1 over a word or selection will

cause the text’s style to become Italics.

U Drawing a capital U over a word or selection will

cause the text to be Underlined. Performing the U

gesture U a second time will cause the underlined

text to be heavily underlined. This is the same as

choosing Heavy Underline from the Character

Options sheet.

N Drawing a capital N over a word or a selection will

cause the text to be returned to Normal, removing all

style enhancements. The N will not return text in

Small Caps to Normal, but it works on all other style

changes.

  
 

Setting the Display

The next step is to set the Display settings so you can work on the

document. When you first open an imported document the dis—

play setting is an unmagnified Screen Format. The display options

shown in Figure 6.12 are from the View menu.

" T‘v'eos. Doc: < ’23 ~

  

Dow me nt EoEt Goth; rIs

 

 
 

  

  

 4.
v , l _

WHERE-1's l Printer" Format

Jargon pervades soitware i V W
unable to esacep jargon be;
who work arcnuld them all _‘ .
with and write about corny," m amif “

or the Jargon that goes Wll‘; M agnif; ~
Eliminating jargon from software manuals becomes more
important as more people use cmnputers. The new breed oi
cornputr cmner is an expert in particular business. scholarly,
or industrial tasks, but uninterested in computers except as
tools tor getting the job done faster, more easicly, and more
thoroughly. For these pocple, jargon is both a hindrance
and an irritation.

 
Jargon can be effectivel soln'thand among those who

undertsand it, but jargon is a barrier to the munititated. 1 ii
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The screen format wraps the words on the page. Regardless of

how you resize the page you will always be able to see all of the

words in your document. The Printer Format shows how the page

will look when the document is printed, faxed, or E-mailed. Figure

6.13 shows you examples of both an unmagnified screen format

and a document set to Printer Format. In the figure, ”TyposDoc”

is in Screen Format while ”Typos. DOC 1” is in Printer Format.

While in Viewing format you can magnify the size of the text by

up to 8 points. Figure 6.14 shows our document magnified by 8

points.

Magnifying the Screen Format will not affect your document’s font

size when the document is printed. The magnification is for your

convenience. You will probably work with text that is magnified

two times on a consistent basis. This is because gestures require a

certain degree of accuracy and you will probably be more comfort"

able working with the larger display. For our example we will use

text that is magnified four times.
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/ Trees, DOC < 23 >/,
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Jargon pervades software
documentation. Manuals seem

unable to esacep jargOIl because
computers fascienate those who
work around them and because the

people who work with and write

about computers are not afraid of

computers or the jargon that goes

with them. _.t_|
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H003 
 

Checking the Spelling

If you did not immediately notice, I’m sure that by now you have

seen the inordinate number of misspelled words in our sample

document. MiniText provides three different ways for checking

words. You can spell—check the entire document or a single word,

and you can also proof a word.

Spell checking is just a matter of comparing the words in the docu—

ment against words contained in a dictionary. If the word in the

document cannot be found in the dictionary, MiniText presents

you with an Options sheet that contains a series of words closely

resembling the word in question. The Spell Checker is actually

smarter than 1 imply, because it will also guess that a word spelled

“hte” is actually ”the” and present ”the” as an option when it runs
across ”hte.”

To start the spell checker:

1. Draw a large 5 anywhere on the screen

Or

Draw an M in a notebook to get the menu.

2. Tap Y on Edit.

3. Select Spell... from the Edit menu.
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Figure 6.15

The Spell
Checker in

action or the

Spell Options
sheet

CHAPTER 6

With MiniText you do not have to worry about the S being inter—

preted and inserted because all editing in MiniText is done in an

editing pad. The spell checker will start checking from the inser—

tion point and go to the right and down the document until it

reaches the end of the document If you want the entire document

spell—checked, you have to place the insertion point at the begin—

ning of the document, or select the 111ch character and then invoke

the Spell Checkei. Figule 6.15 shows the Spell Checker finding the

first suspect word in our document.

When the Spell Checker finds a word:

1. If the wordis wrong, youvcan either write a new word into the
editing pad, and then tap..

Or

Tap Y on one of the alternate words that the Spell Checker presents.
The tapped word will replace the selected misspelled word

and the Spell Checker will run off looking for its next victim.

Or

If the word is correct, you can either tell the Spell Checker to

ignore the misspelled word by tapping.V on Ignore, or you can
have the Spell Checker remember the word it0found (adding it
to the dictionaly), by tappingv on Remember
 

/ a .717 e -,-.,—1 1. 11’:
,/ l ‘1’1L"1_)1‘:.1 LI._11_. ~ 2-: »

Ekacunient Edi" 1231;111:1115 ‘»1-"ie\1'.¢ 111511211. Case

VV’HERE IS ALL. THE JARGON?

J (110011 pervades softwaie documentation
Manuals seem unable to esace11 ja]0011
because comp111/ 113013 :1T ‘111 _
11ork alound th _ 13
11110 110111; 11'ith

are not afraid 01

that goes with "

 

  
[Eliminating 1111
becomes r1101e 1 Redmi Flemsrzmes‘i 111111m  11:11:13azapplvr12111113214pier;:11;

W:4.1-..;J_§ ”Wmuwmwaa “21%

use computels. mew-131m (tr

0111161 is an expert in paniculai business,

scholarly, or industrial tasks, but

uninterested in computers except as tools

for 013111110I the job (1013faster. mom 3

Kyocera PX 1046_244



Kyocera PX 1046_245

{WW MW:

USING THE EO’s BUILT-IN APPLICATIONS E427 E
 

 
 

 

Figure 6‘ 1 6 Ev More rhino? Spelling. ..

The Spa“ E Spelling check complete;
Checke r’s l 22 suspect words found. 

   suspects 3““4 V E”1W4

2. The Spell Checker will repeat this process until it has checked

all of the words in your document, and then it will display a

dialog sheet like the one in Figure 6.16.

There are two more things you should know about the Spell

Checker. If you write a replacement word and tap Y on the Replace
button, the Spell Checker will check your replacement word, and if

the word you are checking is correctly spelled, the Spell Checker

will happily run to the next suspect word. This is great if you’re like

me, and you kind of know how to spell a word but you’re not quite

sure. So you guess. Sometimes you guess correctly and other times

you miss. It’s nice to have a Spell Checker that will catch, the misses.

NDfiie Here are some things to keep in mind when using Spell Checker.

It you wish to spell—check the entire document, you can draw an S
in the title bar.

Before you start spell—checking, make sure that all embedded pads
are canceled. (Tap the Cancel button in each one.) MiniText will
cause spell checking to stop and find a misspelled word that is not
really there whenever it encounters an embedded edit pad.

Adding words to the dictionary dramatically improves the EO'S
ability to correctly translate any uncommon words you may tre~
quently use (acronyms, industry-specific or technical terms, etc). A
quick way to add to your dictionary is to write out these words in a
blank MiniText document, then spell-check it and tap Remember for
every word.

Proofing Your Bocument

Proofing is kind of like a nonjudgmental spell checker. With the

Proofing tool in MiniText you can select a word, draw a F7 over the

selected word, and MiniText will present you with a list of words

that are similar in spelling (this is not a thesaurus or grammar

checker), giving you an option of several words regardless of

Kyocera PX 1046_245



Kyocera PX 1046_246

{mm WM

223 CHAPTER 6

 

Figure 6.17 / neoaooc
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tic-onsealer-flJetiuemAenEsummer]

whether or not the word is spelled correctly. Figure 6.17 shows

you an example of the Prooferi

To start the Proofer:

1. Select the word you want to check by tapping Y it.

2. Draw a P on top of the selected word, or choose Proof from the
Edit menu.

NOi'e You can torget the selection process and [ust draw the P over the
word that has captured your curiosity.

In one way, the Proofer works just like the Checker. If you tap on

one of the displayed words, it will replace your selected word and

close (rather than moving on). However, should you write a new

word and replace the selected word, the Proofer will obediently do

so without questioning your choice of words. In other words, if

you misspell the word the Proofer does not care and will happily

replace a correctly spelled word with an incorrectly spelled word.

And finally, if you press the Clear button, the Proofer does exactly
that, it clears the selected text. You can then either write a new

word or tap Y the Replace button and replace the word with noth—
ing. (This deletes the word.)
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Navigating through the Document

The navigation gestures described in Chapters 2 and 3 all work in

MiniText. If you want to get to the bottom of the document quickly
you can use the Scroll Margin and drag the bar to the bottom, or

you can gesture a double flick up ii and jump to the bottom of your
document. Because MiniText uses an editing pad for changing text,

you do not need to worry about inserting characters. If you make a

mistake the worst that will happen is that MiniText will misinter—

pret your gesture and present you with an Option or Dialog sheet

you did not mean to request, or the E0 will present you with its

”expletive deleted”——the starburst or the question mark starburst.

Line-by-Line Editng

Now that all of the words in our document are spelled correctly

and you are using the font you want, it is time to look at all of the

wonderful editing gestures you can use. First, we are going to be

concerned with adding text to the document, and then we’ll look

at editing existing text. However, before actually editing the text

MiniText provides a Display option that you might want to use

called Show Special Characters.

You can always access the items in the O tions menu {in any appli—
cation) by drawing a check mark v” on t e page or item for which
you want to see the available options. When the Options sheet
Opens you can select other Options menu items by tap ing l.’ on the
arrow next to the title of the document or the name 0 the item you
gestured the check mark on, and you will see a pop-up list of the
menu items. Another way to navigate through the available Options
menu items is to draw a flick left _ on the option name to select the
menu item down or a flick right w for the next menu item above the
one displayed. {You can always tell an experienced PenPoint user
by whether or not they use this feature.)

To display special characters in your text:

1. Tap .Von the Options menu.

2. Select the Display selection, and you will see a new menu (see

Fig. 6.18).

3. Tap Y on the arrow next to Show Special Characters so that it
reads ”Yes,” and then select Apply & Close.
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Figure 6.13 / TY‘F‘DELDOC > Display !E

The Display Magnify Text on Screen: > +4 pts.

options Show Special Characters: , No i
 

The Show Special Character option displays some characters that

are normally invisible. The characters you will see most often are

the Tab and the Return characters. Iprefer to have these characters

on all the time, even on computers, so I welcomed this option on

the E0. Where I find it useful is when I perform functions like

inserting a line, or setting up tabs. Maybe I’m weird. I just like to

see everything. Figure 6.19 shows our document with invisible

characters displayed.

With the E0, since you will often be using it without a keyboard,

you might find seeing these characters useful. But, we digress.

This section is about editing our document. So let’s move on.

To insert text you have to select where you’re going to place the

new entry. Once you. know where, you can either gesture your way

to a pop—up editing pad or use the Insert menu. and select a pop—up

pad or an embedded pad. \Nhat you choose depends entirely on

,/

Figure 6ft?

Hidden 1 titumn‘rent Edi: Stations

characters in ‘
our documents iUntil now; manuals have tried three

  

‘solutions, with varying successfl
firl’rovide glosses of the technical term :

Tob // wifliin parentheses Within the textfl :
character fl-Provide a glossary of terms, usually C .

as part of the back matter of the :\ Grrloge
manualflfl i return or

maExpress the ideas in other wordsfll $7 PGFGQFOPh
, b reo k

Each of these solutions helps the new i

 
reader, but each also has drawbacks. The t
best solution will come from a new l

generation of software that is itself free of i
jargon because a new generation of ‘

cotnputeis provides significant built—in fl
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your preferences, though you will probably choose a pop—up edit—

ing pad unless you are going to write more than a sentence or two.

To get a pop-up pad:

1. Select it from under the Insert menu or gesture a caret /\ where

you want the text to appear. A pop~up editing pad like the one

in Figure 6.20 will appear.

In Figure 620, note the insertion point’s position Anything you

write and insert will go befo1e the ”” so you will either have to

place a new colon and delete the old one or cancel the edit and

start over. I would just insert a new colon and continue. I find it

quicker to delete the unwanted colon than canceling, repositioning

the cursor, and opening another editing pad.

The next step would be to reposition the editing pad and expand

its size. To move the editing pad, use the pen and press 1 any—

where on the border except in the resize corner. The pad will look

like it has been pressed: the border will become slightly darker

(unfortunately, a picture would not really show this change), indi—

cating that you can move the pad. Then drag the pen, and the pad

will follow the pen.

 
 

 

Figure (3.20 pregame": < 22 >

The pOP"UP Document Edit Donor : . _ , g i
~ - together. (Ti “—— ledIhng pod  - It‘al ‘1 J»
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After you have repositioned the pad, you will probably want to

increase its size. Do this by pressing i on the resize corner and
dragging the corner down and to the right to make it larger. If you

are using a ruled or boxed pad with small boxes, you can make the

editing pad large enough for a long sentence or a couple of short

ones. Figure 6.21 shows an expanded editing pad.

The first box has a dark line in it. This indicates that the first box is

the currently selected box. Now that you have a decent sized pad

you can write your additional text and have it inserted. In Figure

6.22 below you will notice the text that was written and inserted is

selected. You should notice the following things about this insertion:

1. It was all written in a single editing pad.

2. There is still an excess colon.

3. Both sentences need to be reformatted so they look like the

ones with square bullets.

4. The two new sentences need square bullets to be placed in
front of them.

U‘l The sentence preceding the list needs the three changed. to five.

 

Figure 6.21

The editing

pod expanded

it}:,.—

tauupH{1.9.
9:2i66;]
400211 
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6. In the text of the sentence next to the first bullet “glosses” need

to be changed to “glossaries.”

By taking care of these five points we will have covered almost all

aspects of editing this document with MiniText. We will take each

item step by step to finish. our editing job.

“There is Still on Excess Colon:

Getting rid of the colon is easy. Tap Y on the colon and gesture a
delete X over the selected colon. Also, if you’re good with the pig

tail gesture ? you can gesture a pigtail over the colon without

selecting it first and that will also remove the colon.

Both Sentences Need to Be Reformottecl So "they took Like the
Ones with Square Bullets:

This is the most complicated task. It requires using a Paragraph

options sheet and actually has two steps.
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First, you need to see what options have been set for the lines

with the bullets, then apply those same options to the two new
sentences. To do this:

1. Select one of the sentences with a bullet (remember the triple

or quadruple tap).

2. Draw a check mark \/ over the selected sentence.

3. Select the Paragraph options from the pop—up menu next to the

arrow in the options sheet Title line.

Once you have done all of this, you should see an options sheet

like the one in Figure 6.23.

This is an options sheet with lots of possibilities. Each of the set-

tings in this option sheet applies to the selected paragraph. If you

want to make an entire document consistent, you can select the

entire document and then change the settings and apply the

changes. Let’s review all of the settings options by changing our

two recalcitrant sentences (which also qualify as paragraphs

because they have a carriage return at the end of each sentence).

To make the two unruly sentences conform, you first have to select

them. Once they are selected, draw a check mark \/ over the

selected area. Once again you will see the Paragraph options sheet.
 

 
 

Figure 6.23 i[/ TYPOEDCC r F‘aragraah Ji
The Paragraph E Alignment: E E 1:3 E i. K

o hons sheet ~ 3 .
P ; Line Height: : 0 . l: 6; _3 m.

Between Lines: 04 . i 0' .0 in.

r 181 Line Offset: i - 0% i 2 8 in.
I : _ z ; ~

{ LeftMaIgin: 0% . 3 6:0,; m.
r e s 5 § .

1 Flight Margin: 0 . O: 0 m.
i ; : a
1 Space Before: 0 . 0 O; m.

' SpaceAfier: - 0E . 0? 0; im.
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Table 6.4 lists the preference, its current setting, the setting we

want it to have, and an explanation for the setting.

XTde‘eb-zt: SewingthPagaphoptonsheer "  
Setting Old value New Value Explanation  

Alignment Left Left Determines whether the paragraph will be

aligned with the text flush on the right or left,

or if the text will be centered on the page.

Line Height 0.16 0.16 in. The amount of space from the bottom of the

line to the top. This is based. on the font size

and is automatic unless you change it manu~

ally. If your lines look too close together, try

changing this setting.

Between 0.00 0.00 in. Use this setting to set the amount of space

Lines between the lines of your paragraph

Because the setting is in 100ths of an inch,

you will have to do some math. lf you are

using a 12-point font, your setting would be

.17 in. to double space the lines. The formula

to calculate this setting is: ((0139 ‘4‘ [the font

size]) * [the number of additional linesj). The

result of this calculation will give you a

number like .1668 to double—space a 12—point

font. Rounded up, you have .17. This

calculation is based on a point being 1/ 72nd
of an inch, or .0139 inches.

Ist Line 0.00 -0.29 in. This is the amount of space for indenting a

Offset paragraph. If the number is negative, the first
line will start before the rest of the lines in a

paragraph, so long as there is enough. margin

to accommodate the setting. Usually these

settings are in inches or fractions of an inch.

 
ll
l
l
lLeft 0.00 0.60 in. This is the amount of free space to the left of

Margin the text. This setting is in addition to the

margins set by the Page Layout menu item
from the Document menu.

Right 0.00 0.00 in. This is the amount of free space to the right

Margin of the text. This setting is in addition to the

margins set by the Page Layout menu item
from the Document menu.

(continued)
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Setting Old value New Value Explanation 

Space Before 0.16 0.00 in. This is the amount of space between the cur—

rent paragraph and the one above. This set~

ting should be set using the formula from

the Between Lines setting above. To have

one line between paragraphs set this setting

to .17 in. if you are using a 12-point font.

Space After 0.00 000 in. This is the amount of space between the cur-

rent paragraph and the one below. This set-

ting should be set using the formula from

the Between Lines setting above. To have

one line between paragraphs, set this setting

to .17 in. if you are using a 12—point font.

  
 

Now if I were you, I’d be wondering how on earth I am going to

remember eight different settings so I can make the necessary

adjustments. And if you are like me you know that you won’t.

Well, if you really wanted to you could memorize the settings you

need and select the paragraph to change and then write them in

and apply the changes. You don’t have to though. There is a much

easier way to change the settings for our two wayward. sentences.

To change the Paragraph options:

1. Select a paragraph with the settings you want to use. (Remem—

ber a paragraph is determined by the carriage return at the end

of a line.)

2. Quadruple tap l: on the paragraph you want to change while
the Paragraph Options sheet is still open. Quadruple tapping

will select the paragraph you want to change.

3. Tap l’ on the Apply button. If you are finished, tap on the
Apply (E: Close, otherwise repeat step 2 for each paragraph you

want to change.

Once these changes are made, our document should look like Fig—
ure 6.24.
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The Two New Sentences Need Square Bullets to Be Placed in
Front of Them:

The sentences need tabs in addition to the square bullets, and the

easiest way to make this change is to copy the square box and tab

from the existing sentences and insert the copies in front of our

increasingly obedient sentences. To copy the square box and tabs

the normal tap dance will not work. You have to set the insertion

point between the tab and the first letter of the paragraph by

pressing l between the two characters. Once the insertion point
appears, drag the pen to the left until both the tap and the square
box are selected.

Once they have been selected, you can tap press 4 on the selected

area to make a copy. Figure 6.25 shows the selected area with a

double marquee indicating that the text has been copied.

Now all you have to do is drag the copied text and place it in front

of one of the bulletless sentences. Now perform the copy and

move again to take care of the other sentence. Now all of the sen—

tences have bullets, but there is a problem with the tabs. One note

of caution: when you copy the bullets and tabs MiniText automati-
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cally places a space between the tab and the first letter of the sen—

tence. You have to delete this space. Repeat the procedures for

deleting the colon above, only perform them on the space. Figure
6.26 shows the now obedient sentences and their brethren.

Figure 6.26
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The Sentence Preceding the List Needs the ”Three” Changed to
”Five.”

Now we have to change the ”three” to ”five.” The easiest way to

do this is to select the word ”three” by double tapping ,Y on it and
drawing a circle line 9 over the word. The circle line is similar to

the circle 0 which will open an editing pad that contains the

selected word or words. A circle line 9 will open an empty editing

pad. When you enter text into the empty editing pad and press the

OK button, the selected text will be replaced by the text in the edit—

ing pad. So let’s just replace the word ”three” with ”five” using
this method.

In the Text of the Sentence, Next to the First Bullet, ”Glasses"

Needs to Be Changed to ”Glossaries.”

I was hoping that the Proofer would work on the word ”glosses”

and provide the word ”glossaries” as an alternative. Unfortu-

nately, that was not the case, so while in the Proofer I just changed

the word in the Proofer’s editing pad and replaced the incorrect

word. You can follow the steps where we changed “three” to ’five”

or you can try using the Proofer. Either method works, and if you

find you are doing a lot of this type of work you’ll find even more
tricks that work.

Using the Embedded Editing Pad

MiniText has an embedded editing pad. In function, it works just

like a pop—up editing pad. The advantage of the embedded editing

pad is that it provides a means for writing without having to

repeatedly invoke a pop—up editing pad. At the end, of our docu—

ment is an embedded editing pad. This pad is always present on a

new or newly opened (i.e., imported) document. It will remain at

the bottom of the page until you dismiss it by tapping Y the Cancel
button. Figure 627 shows the embedded editing pad.

If you remember, several lifetimes ago in this Chapter we discussed

the Embedded Pad as an option from the Insert menu. (You can also

open the embedded pad using the caret-type gesture.) So, depend—

ing on the work you are doing, you could have more than one

embedded editing pad in a document. This is nothing to be con—
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cerned with, except that the pad will print as part of the document if

you should print or fax the document Without closing the pad.

fiending the Document Somewhere

or Printing It

That was fun! In real time the editing job took less than ten min—

utes. Now you can relax. You’re ready for the meeting; all you have

to do is print the document. So rather than waiting until you arrive

at the office, you decide to print it while you are on the train. At the

same time, you decide that your boss’ boss should see the docu—

ment (just to make sure everyone is properly informed). So you’re

also going to fax it to the Big Chief before you get to the office.

First, let’s talk about faxing the document (this assumes that your

EO has a modem). If you have the Cellular Phone attachment you

can fax the document at any time.

To fax a document:

1. Close the embedded pad.

2. From the Document menu select the Send item, and from the

Send item select GO Fax (see Fig. 6.28).

Kyocera PX 1046_258



Kyocera PX 1046_259

Figure 6.28

The GO Fox

cover page

Note

USING THE EO’s BUILT-IN APPLICATIONS 
 

Gt} Fa»: Cover Shae

 
 

El Urgent It Send Cover Sheet Edit Optiors
 

 

 r rt

ix1‘}

‘

.......

Attachments:

[j W F‘ 0:2: if: no

 
 

 
 

3. A fax cover page will pop up so you can write a quick note in
the memo section.

4. Tap the TO button and select the fax number for the Big Chief

(from the Perspective Address Book).

5. Tap the Send button.

Once the Send button is tapped, the E0 will either store your fax

in the Outbox or send it immediately (if you have the Cellular

option). If the fax is stored in your Outbox, you will have to wait

until you get to the office and connect your E0 to a phone line to

send the document. (More complete instructions for faxing can be

found in Chapter 9.)

To print your document before you get to work, select the Print

item from the Document menu and select the printer in your office

at work. The E0 Will print your document and store the printed

document in your Outbox until you get to work and attach the

printer. Figure 6.29 shows the Print options sheet that you use for

controlling your printed output.

The Print menu will be grayed out if you have not set up a printer
for use. Refer to Chapter 7 for instructions on how to do this.
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Figure 6.29 T‘r'F‘SZIBDOCl: m ii
The Print Printer: > artiste 1

options sheet Printer Enabled: > ‘r'es ‘;
Paper Size: > Ll 13 Eitarwjarci ‘

Pages: > Ali

First Page £5: E 1 i   
 

In the Print options sheet you have several choices to make. The

following list discusses each option. The options you have for

printing can vary from program to program, so the choices you

have in MiniText can be different from those in other applications.

Printer It is possible to use different printers and printer defini—

tion files. If you use more than one printer, you will have to select

the correct printer by tapping Y on the arrow next to the printer
name. (Remember, the flick left or right _ or —— gestures will also

work.)

Printer Enabled The printer enabled switch (either Yes or No)

determines whether or not the E0 immediately starts printing

when you press the Print button. If you are not connected to a

printer at the moment you print, this switch does not have much

effect. Either way the printed document will be stored in your

Outbox. If, however, you. are attached to a printer and you have

several documents to print, you should try setting the enabled

switch to ”No” for everything you want to print except the last

document. When you, print the last document enable the printer.

This will. cause the printer to start printing when you press the

Print button and the E0 will then print everything waiting in the
Outbox. Go to lunch.

If you do not disable the printer and you are not connected to a

printer, your document will patiently wait in the Outbox until you

attach a printer. If everything goes right, you can walk in the

office, plug in the printer, and turn on your EO so that while you

get the first cup, can, or glass of your morning office beverage

your EO will merrily print your documents.

Paper Size The Paper size tells the E0 the paper size you are

going to print on. You can choose Standard (8.5 X 11), Legal (8.5 X
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14), A4 (A European standard), or you can enter the dimensions

for your special custom memo pads (or any other size your printer

will use). Be sure you select the correct size, otherwise you will

have to print the document again.

Pages With the Pages setting you tell the EC) which pages of

your document to print. You can print all of the pages, a specific

page, or a page range. To print a single page enter the page num-

ber of the page you want to print in both the starting and ending

page number boxes (see Fig. 6.30). To print a range of pages, enter

the number of the first page and the last page.

First Page # Use this option to set the first page’s number. Usu—

ally it will be one. But on occasions you may want to use zero

because you’re printing a cover page and cover pages don’t count

as real pages. Another reason for using a different first page num-

ber might be if your document is actually part of two documents,

and the first page of the second document needs to be page num—

ber 50 so everything can stay in order. Any other use for the first

page number goes beyond the scope of this chapter, that is, it’s too
weird for me.

So much for printing. Once you have set you printing parameters

you’re off and running. If you need more information on printing,

look in Chapter 3.

End - Find-and-Replace
When working on a document it is often desirable to having the

ability to find a word or words that are lost. On other occasions

you will also want to find a word or phrase and automatically

 

 

Figure 6.30 TYPCIISDCIZZ: Print
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change the occurrence of the word into something else. I use the

Find command quite a bit because I’m easily lost. The Find and

Replace is something I rarely use, but when I do need to use the

Find and Replace, it is a feature I would not want to be without.

The Find feature in MiniText is very straightforward. Of course

you must utter the magic words and then invoke the command

from the Edit menu, or draw an F anywhere in the document. The

Find command will start from the insertion point or the current
selection and move to the end of the document. To search the

entire document, you should select the first letter in your docu—

ment and then start the Find, or draw an F in the Title line. Figure

6.31 shows the Find options sheet.

When the Find options sheet opens, the Find line is blank. You can

write directly on the line or you can use the editing gestures used

in with MiniText. You can also copy a word from the text (use the

tap press J. gesture) and drag the word onto the Find line. When
you tap l’ on the Find button the word you are searching for will
be selected and the Find options sheet will tell you the word was

found in the Results line. The other message you will see in the
Results line is ”Reached end.” The ”Reached end” means that

your entire document was searched and the word or character you

were searching for was not found.

You should experiment with the Find feature because you can

open other options sheets (such as the Character or Paragraph

options sheet) and use the Find command to search for a word,

and then. when the word is found and selected, make changes

using the options sheet. This can be a fast way to make formatting

changes.

Figure 6.3]

The Find

options sheet

with editing

pad

 

   
Find: afraid

 Result:
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The Find and Replace options sheet is selected after you have

opened the Find options sheet by flicking left or right ~ or .— on

the word ”Find” in the Options sheet’s Title line, or by tapping Y
on the arrow next to the word ”Find” and selecting “Find &

Replace” from the pop—up menu. The Find & Replace options

sheet looks like Figure 6.32.

In the Find & Replace options sheet you have several choices.

Everything above that applies to the Find options sheet applies to

the Find & Replace options sheet. The additional choices you have
are as follows:

Match Specifies whether the search should be case—specific and

Whether you are looking for a Whole word or a partial wordt An

example of a partial word would be looking for the word ”one.” If

you select ”Complete Word Only” your search will skip words like

”someone,” and if you specify ”Same Case Only” the word ”One”

will also be skipped during the search.

Replace With Here you specify what should be used to replace

the found word. If you leave the line blank, the found word will be

replaced with nothing; the word will be deleted. By copying a

character like a Paragraph break (carriage return) or a tab you can

also replace the found character with a tab or paragraph break.

(These are also called control character's.)

Use Case Of When you perform a replace you can choose to use

the case of the word you have found. or the case of your replace—
ment word.

 

Find:

Match: 
Replace With: 1;

Use Case of: > Fieplifififl'lei‘zl ‘a-I'Iloro‘  
 

Search: > include Embedded Docs

Direction: > chmrd

Start From: > Last til‘tateh

Result:

Fir“
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Search Use the Search option to search only the current docu-

ment, or to search the current document and all embedded docu-

ments.

Direction With this command you can search from the current

word and go backwards or forwards in the document.

Start From This command lets you start from the beginning of
the document, the last word found, or the end of the document. 80

if you started. from the end of the document and performed a

backward search, you would search the entire document. If you

choose to search forward from the end of the document, you will

find nothing.

Once you have found the text you are looking for, you can choose

to replace it by tapping l." on the Replace button, find the next
occurrence of the word or text by tapping Y the Find button, or
choose Replace All. If you choose Replace All, all occurrences of

the word specified on the Find line will be replaced with whatever

is in the Replace With line and you will be asked no questions.

This means that you should be careful. Whenever you do a search

and replace manually, replace the first few finds to make sure

your options have all been set correctly and that the replacement

is happening the way you want it. Otherwise, you could end up

making a mess of your document and might not be able to fix the

replacements.

The Missing Mini'l'ext Features

Unfortunately, it was not possible to cover all of MiniText’s fea-

tures with the example. Table 6.5 will quickly cover them by listing

the Menu, menu item, and the missing feature.

For more information on the PenPoint editing gestures see Chap-

ter 3. Also, all of the editing gestures in MiniText usually work in

any application on your EO.
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Menu

Document

Edit

Options

Insert

Menu Item Description 

Checkpoint

Revert

About

Move

Copy

Delete

Edit

Tab Stops

Controls

Access

Comments

Space

Tab

Line Break

Page Break

Paragraph
Break

_i
This is a standard PenPoint menu item that causes changes
to a document to be saved. You should use this option,

especially if you use the Accelerated Access option. The E0

will not automatically save any changes until you turn to a

different page.

When you choose Revert, your document will be reopened

using the last checkpoint as the source document.

Provides a Dialog sheet that gives you the created and last

modified date and time, plus the file size While stored and

its active size while the page is open.

Pre wares selected item for movm , same as the aress i 0esture.D

Prepares selected item for copying, same as the tap press '11

gesture.

Deletes selected item; same as the delete gesture X.

Causes the selected text to appear in an editing pad; same

as the circle 0 gesture.

This option sets your tab distances. The default setting for

the Tab Stops Options sheet is for Tab Stop 1 to be .5 inches

and Tab Stop 2 to be l inch.

A PenPoint menu to set the page controls (see Chapter 3).

A PenPoint menu to set the access controls (see Chapter 3).

Lets you attach a comment to your document, assign an

author, and change the title.

Inserts a space at the insertion point; same as the insert

space L gesture.

Inserts a tab at the insertion point; same as the insert tab .La.

gesture.

Inserts a line break at the insertion. point; same as the new

line :I gesture. This command does not start a new para~

graph, just a new line.

Inserts a page break at the insertion point. A page break

causes any text after the break to be printed on a new page.

Inserts a paragraph break at the insertion point; same as the

new paragraph 4 gesture. This command starts a new

paragraph.

(continued)
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Menu Menu Item Description

Insert Signature Inserts a signature pad that you can use to draw on or use

Pad for a signature.

Case Upper Case Converts the selected text to upper-case characters, same as

the upper~case J gesture.

Lower Case Converts the selected text to lower—case characters, same as

the lower—case '7 gesture.

Initial Converts the selected text so the first letter of each word is

Capitals upper—case; same as the initial caps A gesture.

  
 

MWnNote

MiniNote is the EO’s note-taking software. The uses for MiniNote

are limited only by your imagination. You can use it to take notes

while on the phone, in a meeting, at class, or in any situation where

you might use a pad of paper and pen. You can convert what you

write to text, and you can also doodle on your MiniNote pages.

Just as MiniText is designed using text priority, MiniNote is

designed to use ink. This means that there is a big difference

between the two programs. Everything you do with MiniNote

starts as ink. Whether it remains ink is up to you. But, before we

get into the particulars we should get familiar with a MiniNote

page. Figure 6.33 shows a blank MiniNote page.

There are several important differences to note on a MiniNote

page. First of all, if the page is in Pen mode, indicated by the

Pen /Gesture toggle switch in the page’s rightwhand corner; you

cannot use PenPoint gestures on the page. If you draw a flick up l
or flick down l on a. page in Ink mode you will only be drawing
lines on the page. The same applies to any other gesture as well.

For this reason, MiniNote has a Gestures margin on the left—hand

side of the page. When using MiniNote you should really use the

Gesture margin. it is much faster than switching to and from ink.

When you tap Y on the pen it changes to a check mark, which
means you can gesture directly on the page. You can use almost all
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of the same gestures in MiniNote as in MiniText. There are a few

exceptions which will be noted as we move along.

How MinNote tunetious

When you work on a MiniNote page it is important to remember

that MiniNote uses lines. If you write a phone number and name

that you will want to translate to text it will be much easier to

translate your writing if you write your notes in lines across the

page, keeping what you write in some type of order. Figure 6.34

shows a page with a thought on a single line and another spread
over several lines. The lines in a MiniNote document share the

same characteristics as a ruled editing pad. (See Chapter 4 for

information on ruled editing pads.)

If you want to translate the thoughts to text, thought one will be

much easier to translate than thought two. To translate thought
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one, all you have to do is gesture a circle in the gesture margin

next to the line containing the writing. Doing so will cause a pop—

up editing pad to appear with my translated text in the pad (see

Fig. 6.35).

You can see that the ED did not like a lot of What I wrote. But you

can quickly edit the text and it will. be placed in the document

after you edit it. After the changes are made the document will

look like Figure 6.36.

 

Figure 6.35 // , tiliml‘dore _ _ ., ’4 24>
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Flgure 6.36 // M im‘ Note _ < 24 >
. Document Edit CJpT’iorus Arrange Pen /

After the edit

On a single line
3
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This is a quick and easy process. Thought two, however, will not

be so easy. To select all of the text for thought two you have to tap
Ynext to the first line of text. If you draw a circle 0 instead of a tap
Y a pop-up editing pad appears. This would be okay, but if you
want to edit all of the text and not just a single line you will need
to select the other lines as well.

To include the other lines in the selection you can use a combina-

tion of two methods. However, before continuing with the selec~

tion process you need to know how MiniNote processes selected

text for editing. As stated above, MiniNote operates on a line—by-

line basis. When you select several lines for translation and edit—

ing, MiniNote combines all of the writing from a single line and

presents it in an editing pad (see Fig. 6.36). After the current line is

edited and you tap Y on the OK button, another editing pad will
appear with the next line of selected writing translated, ready for

editing.

You can either skip the edit, which will cause the selected line to

be ignored and the next selected line to appear in a pad, or you

can edit the line and go on. Unless you cancel the translation oper~

ation, MiniText will process all of the selected writing line by line.

Now, how do you select more than one line of writing?

Well, you can use the Edit menu and choose the Select All option.

This will select everything in the MiniNote document—translated

text, writing, doodles, and pictures (if you drew any)mor you can

tap Ynext to the line with the text you want to translate and select
the line. To select additional lines you can gesture a plus + next to

the lines you want to select and add them to the selection. When

using the plus you can select any line you wish, skipping any

lines you do not want to translate. This is called a discontiguous
selection.
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The other selection method is to gesture a left bracket [ or a right

bracket ] in the Gesture margin next to the first or last line you

want included. The left bracket [ should. be used with text below

the initial selection. Using this gesture will select everything

between the initial selection and the line where the left bracket [ is

drawn. The right bracket ] should be used to select lines above the

initial selection. You can also use the plus + gesture with either

bracket gesture.

After you have selected the writing you want to select, you can

also use the plus + to deselect text as well. This is useful when you

have doodled on a page and have writing you want to translate.

You can use the brackets to select your text and then use the plus +

directly on any selected writing (doodling) that you do not want
to translate. This method of selection will result in translated or

translated and edited text in place of your selected writing, while

leaving your doodles and pictures in place.

To translate the selected text you can draw a circle 0 in the Ges—

ture margin next to any of the selected writing to translate the

writing with a pop—up editing pad. If your writing is very Clear

and you do not want to edit the translated text you can translate

the writing without using an editing pad by gesturing a circle tap

a; in the margin or on the selected writing.

When using MiniNote, remember that you can always perform a
gesture on selected writing even it you are in the Pen mode. Any
gestures performed directly on a page while in the Pen mode can
only be performed on selected writing. Otherwise you have to use
the Gesture margin or the Edit menu to execute your commands.

Now that the tirade is over, let’s see the results of the translate and

edit for thought two. Figure 6.37 shows these results:

In the figure you will see that words are still on the lines where

they started. If you wanted to combine them into a sentence (on

the same line) you would have to select a word and move it by

pressing .l. on the word and moving it to the line you wanted it on.

You’d then have to repeat the process for each word, and then re-

edit the line removing any extra spaces between the words. To fix

thought two in Figure 6.37 would require five actions.
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Each word on a separate line was selected and moved to the main
line, then the entire line was re-edited to combine all of the words

into a single sentence. It is a fairly quick but somewhat tedious

process. You might want to keep these steps in mind just in case

you have to combine different thoughts in the future.

Nate There is another way to select writing in a MiniNote document. This
feature is especially useful for selecting and moving drawings that
have several lines. Each line is a separate entity and can be
selected and moved. There will be times when you want to select
several lines all at once. Of course you can use the methods
described, but you can also put MiniText into Gesture mode and
press the Pen below the area you want to select. Then dra the Pen
dia anal/y upward. As you drag the Pen, a mar uee wififi appear
anjany writing or drawing that is touched or enc osed by the bor-
der of the marquee will be selected.

Setting Your Preferences

Just like all EO pages, you can set preferences for MiniNote docu—

ments. After you have played with MiniNote a bit you will proba~

bly want to create a MiniNote document that has the preferences

you want to use most of the time and place it in your Stationery
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Notebook so you can access it Whenever you create a document.

The primary preferences are page and pen options.

The page options are called Paper options in MiniNote. To check

or change these options you can either select the Paper item under
the Options menu by tapping Y on the Options menu and then the
Paper item, or you can gesture a check mark \/ in the Menu and

Title lines. The Paper options page looks like Figure 6.38.

The other options in the MiniNote’s Option menu are PenPoint

options, which are discussed in Chapter 3.

Within the Paper options sheet you have the following choices:

Page Style The page style determines how the page will look.

You have eight choices.

Font With this option you select the font you want to use. You

can use any font installed on your EO. The font selection affects all
text in a MiniNote document.

Line Spacing Line spacing determines how tall your lines will
be. It also sets the font size. Be sure to choose a line size that is

comfortable for your writing style.

Paper Width The Paper Width is how you set the width of your

paper. You can choose to use the default width, which is 3.75

inches, or enter a width more to your liking. Another alternative is

to use the same width as you’ve selected in the Print Setup (a

selection in Document menu). Or you can set the width to equal

the page’s display; this change will take effect at the moment you

apply the option. Figure 6.39 shows the Paper Width options in

 

     

                
 

 

MiniNote.

Figure 6.38 ,m/ g lar‘lmiNote fi Paper
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You might want to create MiniNote documents for different func-

tions where each requires different Page options and place them in

your Stationery Notebook. This way you can make them available

at any time you create a document and you will not have to reset

your Page options.

Another note about the paper options has to do with the paper

width. You can change the paper width of any MiniText document

at any time. However, if you make the width smaller and have

writing outside the area you selected, you will not be able to

access the writing until you restore the Width to its original set—

ting. If you do change the width, you will get a dialog sheet telling

you about the problem.

Pen thions

The next selection in the Options menu is for Pen options. The Pen

Options are for setting the type of ink and the width of ink flow.

You have four settings to choose from and they are the same as

those found under the Pen menu. Figure 6.40 shows both the Pen

options sheet and the Pen menu.

You have the choice of two pen widths and two pen colors. The

lighter pen colors can be used to highlight writing that was done

in darker ink, or you can use the different pen settings for drawing

images. You can also change the ink you use after something has
been written.

To change the ink of existing writing select the writing you want

to change, then while it is selected use the Pen menu and choose

the type of ink you want. This will change the ink of the selected
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Figure 6A0 / MiniNote < 24>

Document Edit CJotions Arrange [Pan /
The Pen ’ - 2

options  

 may" j imtyC‘el   wagssaipp'v'iauueidkegan“r.   
writing to whatever you select from the Pen menu. You can also

achieve the same results using the Pen options sheet.

NOi’e Before faxin a MiniNote document to someone, it helps to make
the en ink other by choosing Select All and setting the Pen to the
thic , black ink. (This will redraw quite slowly, so it’s a good idea to
do it lost.) If you don ’t do this, the ink is often too skinny to fax well.

 t’s a MinNote Day

Beginning the Day

You arrive at work ready to go. You’ve edited your document for

the 8:15 meeting on the way to the office and you’ve just sat down

at your desk. You connect your E0 to the printer and the fax line

and go off in search of some type of morning beverage. It’s 8:00.

You come back to your desk, beverage in hand, and review your

meeting document. It’s okay. So you pick up your EO, create a

MiniNote document, and start your daily log. It is 8:05.

The first thing you do after creating your Daily Notes MiniNote

document is insert the date and time (see Fig. 6.41). While the caret

/\ gesture will open an editing pad in most programs, in MiniNote

it pops up a menu from which you can select the current date,

time, or date and time. This is very convenient for date and time

stamping your notes.
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UsmgMInINotetoKeepTrackonourSchedule H 

One way you can employ MiniNote is to use it to keep a record ofyour day. it is a great way to keep track of incoming and outgoing
phone calls, take notes at meetings, and down all of those things that you
normally write in a spiral notebook or on legal pods. if you’re like me, you
could have legal pads all over your office or always be scrambling For a
piece at paper to write that note. Well, the E0 can definitely solve these
minor problems of business life. MiniNote is one of its solutions.

Let’s play pretend again. Let’s pretend that it’s the beginning of the day
and work is beginning. (Oh yeah, iust as an aside, my brother says, ”They
don't call ’Work,’ ’Work’ for nothing”) So let the clay begin.

Figure é_4] 19 Jun. 199308:56

The Daily ’
Notes

 
,4 2‘ . ,4»
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4 4 ,, émexfiy 92*? 4 ,

fluuv’zr’r‘ .Zo/Ajj'
4,63Lfifimhm4g WW _ , , , ,
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Pre-Meeiing Notes

Now while you’re sitting there, you write a couple of reminders

for yourself about the imminent meeting. After you have these

notes written you check your schedule for the rest of the day and

get ready to go to the meeting. Just as you. get ready to go, your

phone rings. lt’s Ralph from production.

Logging 0 Phone Call

As you’re talking to Ralph, you grab your EC) and insert the time.

You can never be too careful and you keep a record of all your

phone calls. Ralph tells you that production needs the approved

text and final artwork for the manual cover. You tell Ralph you’ll

bring it up at the editors’ meeting and run off to the meeting, tak—

ing your EC) with you of course.

The Meetng

You’re the last one to the meeting because you had to make copies

of your document. But you arrive and slip in. No one notices that

you’re late and you sit back to listen to Mary talk about problems

she is having with an author who’s behind schedule. You sympa~

thize but really it’s all rather boring.

Bored (Let’s Doodle)

So you sit with your E0 in your lap and doodle. . . doodle. . . doo-
dle. . . doodle.

Key Points Discussed

The meeting progresses and Susan the Senior Editor finally asks

you about your projects. You tell her all’s well and present your

document on manual documentation. You outline your production

schedule (that’s kept in Perspective), and you bring up Ralph’s

comments regarding the final text and cover art.

Susan says the final cover will be back from the Art Department

by 2:00 and that the copy editor is finished with the manuscript.

You say that you’ll check it and send it to production in two days.

Susan asks you to accelerate your schedule because one of your
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books needs to be done before the end of the quarter, and the

meeting is over. The day begins.

30...

Before the day begins you have used your E0 to edit a document,

keep notes on a meeting, and fax a document to the Big Chief.

Now (if your writing is neater than mine) you can translate your

notes, copy the main points (Susan’s comments to you) into the

mandatory memo no one will read (another MiniText template)

and you’re off to meet with the printer for a press check. Things
could be worse, a lot worse. . .

Extra MiniNote Commands

There is one more group of commands in MiniNote in the Arrange

menu that need to be discussed. These commands are for aligning

and arranging your writing and working on selected items. As

usual, the means for accessing the menu is to tap on the Arrange

menu and select the item of choice. If nothing is selected, none of

the Arrange menu items will be available. The following is a list of

the Arrange menu items and a description of their function.

Tidy Rearranges selected items as neatly as possible.

Center Centers selected items on the page.

Align Left Aligns selected items so they are flush left.

Align Right Aligns selected items so they are flush right.

Group Groups all selected text so you can move all selected
items at once.

Ungroup Ungroups selected items so items can be moved indi~

Vidually. Deselecting the selected items performs the same func~
tion.

You can also use the following gestures in MiniNote to add to its

versatility:

Connect U When drawn so that one side of the U starts in one

word and the other side ends on another word, this gesture will
connect the two words on the same line.
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Right Down l Used to insert blank lines between lines of writing.

Draw the gesture in the margin to the left, starting on the line you
want to move down. The line will move down for however far

you draw the down stroke of the gesture.

Right Up I This gesture moves lines of writing up. It will delete

the lines in between the start of the gesture and the end of the up
stroke.

Last Thoughts

MiniNote is deceptive insofar as it appears to be a very simple

program at first glance. As with all BO applications, there is more

to it than meets the eye. To get the most from MiniNote you need

to play with it. Only by trying the procedures suggested in this

section. will you master MiniNote. If you do not experiment, you

are likely to think that there is not much to the program, and

you’ll under-utilize it. This is actually good advice for all of the E0

applications, it’s just that MiniNote is really easy to dismiss as a

simple program with limited value. Think again.

E0 Cue

EO Calc is a program written by EC) Inc., to provide you, the busy

person on the go, with a powerful calculating tool. EO Calc has all

of the basic arithmetic operators as well as a set of scientific opera—

tors. E0 Calc is set up using a series of columns. All calculations

are performed in a vertical column.

With EO Calc you can quickly perform some fairly complicated

calculations and even prepare simple reports. If you need more

complex reports you can embed an E0 Calc document in a Mini—

Text or MiniNote document. Figure 6.42 is a quick report done in
E0 Calc to total some sales numbers.

The pop—up menu sheet in Figure 6.42 shows all of EC) Calc’s

available functions. This menu is accessed by tapping in the small
cell on the left of each field. You can see the word “sum” in some

of these cells. These cells are called the Operator column. The col—
umn with the number is the number column.
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A quick report
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When there is an operator in the operator column, the operation is

performed on the number column above and the number column

next to the operator column. If you select the text operator, the row

(one operator and number column) becomes a text field, otherwise

you can only enter numbers into the columns. Figure 6.42 shows

several text fields. You can also link one column to the next using

the link operator. In Figure 6.42 you can identify a linked column

because it is lightly shaded and has the same number as the col—

umn to the right.

Any number can be copied and pasted into another column. To

copy a number, tap press i on the number you want to copy and

drag it to its new location. Numbers can also be moved by using a

press 3 gesture on the number you want to move.

If you want to change the format of the E0 Calc page, you can

either choose the Format item from the Options menu or gesture a

check mark x/ on the Menu and Title lines of the E0 Calc page.

Your format options are as follows:
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Decimals Lets you select how many decimal places to show.

Columns Sets the number of columns to display of the columns:

Variable will fill the visible page, otherwise you can choose from
one to nine columns.

Rows Sets the number of columns to display of the columns.
Your choices are 25, 50, or 100.

Row Size Determines the height of the rows. Your choices are

small, medium, or large.

Operators Sets the type of operators that will appear when you

tap Y an operator column. The scientific setting displays the opera
tors below the line in the selection box shown in Figure 6.42.

The operators and their definitions used by ED Calc can be found

in Table C1 of Appendix C.

E0 Sound

EO Sound is a built—in digital recorder. It can be used to embed

voice notes into any document (so long as the document allows

embedded. documents). If you are sending the document to some-

one who has an E0 Communicator the recipient of your document

can listen to your voice note. This feature can add a personal touch

to your communications.

N019 Your EO has a microphone built into its right ear and a speaker in
the left. 80 when you record a message you will be speaking info
the right ear of you Communicator.

Figure 6.43 shows an 130 Sound document. Since the document is

an audio recording, all you will ever see with E0 sound is a

recorder type of device.

The E0 Sound page shows the length of the recording, the input

level, playback volume, the recording level, and the controls for

operating the recorder. In the figure EO Sound is set to record a ten

second sound note, however, the actual length of the recording can

vary. The length of the recording is dependent on how much stor—

age space your EO has and whether or not you tell EO Sound to

compress the sound file.
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E0 Sound’s Options

EO Sound has recording and playing options that we’ll look at

before actually using EO Sound. EO Sound’s options can be
accessed from E0 Sound’s Control menu. To access either the

Record or Play options sheets tap Y on the Control menu and select
the Record or Play menu item. You can gesture a check mark \/ on

the E0 Sound page and tap on the arrow next to the option’s name

to access the pop—up menu, or you can flick left ~— or right w on

the option’s name to go from one option to the next.

I

g

First, we’ll look at the recording options. Both the length of the

recording and its compression are controlled from E0 Sound’s

Record options sheet. Regardless of how you access the Record

options you Will receive an options sheet that looks like Figure 6.44.

You have two selectable options in the Record options sheet. The

first is whether or not to use compression. If you turn compression

off, your recording will use just a bit more than two and a half

times the space required by a compressed document. An example

would be a 34—second recording, which when compressed requires

99K (Kilobytes) of space. A recording of the same length that is

uncompressed would require 265 kilobytes.
 

x/LLL’
Figure 6.44-

The E0 Sound i

options sheet 3

l

l
l
l

Sound > Record

Compression: v On (Save Space]
Off {Best Quality}

Time Limit (sec) l. ? 0 .

Space for Sound: 29KB

Available Space: 3422KB 

 Wu—
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An uncompressed recording results in a clearer, higher quality

recording. But because it also uses more data space if you send a

memo with an embedded Sound note to someone using AT&T

Mail (discussed in Chapter 8), an uncompressed sound note could

cost you two to three times as much to send as would a com-

pressed sound note. So you will have to make a decision regarding

the need for a very clear recording versus the cost of sending the

document with the recording.

The other setting in the Record options sheet is the length of the

recording. As mentioned above, the length of the recording is

predicated by disk space. You will need 175K for each minute if

the recording is compressed or 468K for an uncompressed record—

ing. Usually you will use a recording that is from 10 to 30 seconds

long. You’ll be surprised at how much you can say in 30 seconds,

and E0 Sound is included so you can add emphasis or clarifica-

tion to your written communications.

In the Play options sheet you have one of two choices. First, you

can turn Quick Play on or off. Quick play controls how your

recording will behave when it is played. Quick Play lets you play

the recording by tapping l’ on the E0 Sound icon. If you turn
Quick Play Off (the default setting), when you tap l’ on the E0
Sound icon the E0 Sound page will appear rather than just play—

ing the sound. To access the ED Sound age when Quick Play is

turned on you will have to double tap .. on the E0 Sound icon.

This setting applies only to recordings that are embedded in other
types of documents.

Record and Play

To record a sound all you have to do is tap on the Record (Rec)

button and speak into the right ear of your E0. While you are
recording you should watch the Rec Level graph on the right. If

you do not see any movement in the graph you are probably not

speaking loud enough and your recording will be difficult to hear.

Also if the recording level bar should jump beyond the mark that

indicates the maximum level, your recording will sound like you

are shouting at the recipient. Figure 6.45 shows the E0 Sound

page while it is recording.
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EO Sound
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As you record, the Position Gauge will move to indicate how

much time or space you have left for your recording, and to the

right of the position gauge you will see how long the recording is

in seconds. Once you have made your recording you should play

it back. If it is not loud or clear enough and you were speaking at a

normal voice level you may want to increase the input level.

To play a recording you need. to make sure the Position Gauge is at

the beginning of the recording. If it is not, tap Y the Rewind (Rew)
button. You can also manually set the Position Gauge by pressing

i on the gauge and dragging it to some point within the shaded

area of the Position Graph. After you have either rewound or

repositioned the Position Gauge tap Y on the Play button. When
you play a recording received from someone else you may have to

adjust the volume level to hear the recording. However, if you are

checking a recording you have made you should be able to hear it

without resetting the volume level (unless you are in a noisy envi~

ronment). You do not want the recipient of your recording to think

you are shouting at them, unless that is your intent.

Another control in the E0 Sound Page is Stop. This will stop a

recording or a playback so you can resume your action by tapping

Y on either the Record or Play button. The PP button is for fast for~
ward. This will move the position gauge forward so you can skip

some portion of the recording. The fast forward can be useful if you

are trying to catch a recorded phone number or other important

message.

Both the fast forward and rewind will move the Position Gauge to

either the beginning or the end of the recording unless you tap the
Y the Stop button. Finally, if you are unhappy with your recording
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or you have listened to a recording and want to reclaim the space

it uses, you can tap the Clear button and erase the recording. Tap—

ping Y on the clear button erases the recording and there is no way
to recover it, so be sure you really want to erase the recording
before clearing it.

Embeddng Documents wthin
Documents

PenPoint has a feature that lets you place documents inside other

documents. This function is called embedding. With embedding you

can place an E0 Calc document into a MiniText document and dis—

play calculations that are pertinent to whatever you might have

written with MiniText. In the section on E0 Sound, embedding a
sound document in another document was mentioned as well.

Figure 6.46 shows a page from the tutorial that comes with the full

version of Perspective.

The document in Figure 6.46 is a MiniNote document. However,

inside this particular MiniNote document are several Perspective

pages. In Figure 6.46 you can see a Perspective Day Planner page

called ”Day Planner Step 2.” Because each document is the appli-

cation, the Day Planner page is a fully operational Perspective

document, just as if you had turned to a Perspective Day Planner

page within a notebook. Notice that the Day Planner page in Fig—
ure 6.46 has all of the elements of a standard document.

It has a Title and Menu line, the Text/Ink toggle, and a tap and

flick area for scrolling. On this document-within—a—document you

can perform any of the functions that you would perform on a

nonembedded Day Planner page. If you sent this page to someone

who has an E0, they would be able to access this document and

the embedded document with no problem as long as they had the

corresponding Perspective Profile Book. (See Chapter 4 for details

on Perspective.)
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If you were to print or fax this page, all of the information on the

page, including the Perspective page, would be printed. So if you

wanted to send. someone a fax of your schedule and you placed

your Perspective Appointment schedule in a MiniNote document

you could send this person all of the information plus notes on a

single page. Likewise, if you had a drawing that you wanted to

include in a MiniText document you could embed a MiniNote doc»

ument into the MiniText document and send, print, or fax both

documents as a single document.

The processes for embedding documents depends on the type of

document you are working with and what you want to accom—

plish. Although the context is nonsensical, Figure 6.47 shows a G0

Fax page embedded in a MiniText document.

In this case the GO Fax document looks like a picture. All of the
controls for the GO Fax document have been hidden. Yet it is still a

fully functioning GO Fax document. Hopefully, you are beginning

to see the possibilities that embedding has to offer. Embedding
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gives you the ability to combine all of your different documents in

ways that are limited only by your imagination. All of a sudden

you can create custom documents that fully exploit the EO’s capa—

bilities. If you do not have a page layout program you can use a

MiniNote document and insert several pages from GO Fax for pic-
tures and MiniText for text and create a newsletter.

If you are working on a group project that requires comments

from other people, calculations, drawings, and pictures you can
send a document with several embedded documents to other E0

users. They in turn can make Changes to your document, embed

MiniNote suggestions, add an E0 Sound recOrding saying all’s

okay, and you could receive back a truly living document. The

possibilities of this type of communication exchange give the con—

cept of an information transaction even more meaning and open a

whole world of possibilities for communicating ideas.

Brief instructions for embedding documents will be given here.

For more complete information you need to read Chapter 3 on
PenPoint. To embed a blank document inside another document

all you have to do is gesture a double caret A on your document

where you want the new document to appear. You will receive a

pop—up menu of the available documents you can create and you
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just select the type of document you want. It will be embedded

where you gestured the double caret A and you can then work on
both documents.

To place an existing document into another document:

1. Go to the notebook contents page that contains the document

you want to copy.

2. Tap press 4 on the document to be copied,

Or

Press i if you want to move the document rather than copy it.

Drag the copied document from the Menu or Title line.

4. Turn to the page on which you want to place the copy.

Drag the copied document from the Menu or Title line and

place it in the document.

Controlling the appearance of the document is done by sizing the

document from the embedded document's Options menu. The pri—

mary option you will use is the Controls options sheet. You can

also access the Options menu items by drawing a check mark \/

on the embedded document. From the Controls options sheet you
can set whether the Menu or Title line, the document’s borders, or

any other controls are shown.

Finally, you can also control appearance with gestures. All of the

PenPoint gestures for controlling options will work on an embed—

ded document. For more information on the Controls options

sheet and control gestures, see Chapter 3‘

Cenclusien

Like a bag of candy, this chapter is chock full of information about

the EO’s built—in applications. After reading this chapter you

should have a fairly complete grasp on how to use MiniText,
MiniNote, EO Calc, and E0 sound. You have learned how to cre-

ate documents and have had a brief introduction on embedding
documents inside other documents.
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Hopefully, you can see how an E0, with just the built in applica—

tions, offers you a tool of power that you can use to meet your

communication. needs and demands. If I have done a good job of

communicating the use and capability of these tools you should be

able to see that an information transaction can be as simple as

writing and faxing a letter or as complex as creating a multi-level

document for a presentation or group collaboration.

However, you will only be able to use an E0 to its fullest potential

if you step outside of the traditional computing metaphor that has

been thrust at you for the last ten years. Even though EO allows

you much flexibility in the area of personal and business commu-

nications, it can be difficult to shake the thought that it is just a

computer that uses a pen. If you only think of it as a computer that

uses a pen you will cheat yourself out of the advantages that the

E0 offers. As a computing device it can do more than portable or

desktop computers with far less overhead in software.

To get or keep you thinking along these lines, just remember how

difficult it would be to send your boss a copy of your daily or

weekly schedule, with notes and comments, if it had to be done

from a traditional computer. You, might have to schedule the task

itself before you could do it properly. If you did the same task

from an E0 it would take five to ten minutes and hardly interrupt

your day. Go figure. . .
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introducton

In the world of computers or personal communicators there is one

need that all types of devices share. They share the need to

exchange data. These days, especially if you use computers for

business, you have to be able to share your information (data) with

other people, other types of computers, and other software pacl<~

ages. This need is even more essential for personal communicators.

A highly mobile device that can be used to make business presen»

tations, keep expense accounts, and manipulate word processing

documents would be crippled if it could not exchange data with

its cousins. Not only does the personal communicator have to

share data, it must do it easily and seamlessly. If there is a lot of

fuss and frustration when transferring files, then the ability is
almost useless.

The creators of the E0 and PenPoint realized these facts of mobile

computing life and provided the E0 Personal Communicator

with the ability to transfer files by directly connecting to a DOS or

OS/2 computer. You can also attach an optional floppy drive to

the E0, and if you have an E0 880 you can also attach an external
hard drive.

271
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Other ways you can transfer data files would be via Email, an
external SunDisk drive, a terminal emulator and the modem, or a

direct serial link. So as you can see, the E0 has a wide variety of

communications capabilities for transferring documents to and

from other EO Personal Communicators or other computers.

When you purchase an E0 your receive the means to connect your

EO directly to an MS-DOS computer using a program called Pen—

Central and a PC connection cable. Because this is the EO’s pri-

mary link to other computers, this chapter will look at using

PenCentral in detail. We will discuss importing and exporting doc—

uments, backing up your data, and connecting to the MS~DOS

machine via modem. Also, we’ll look at some of the other topics

mentioned, such as attaching disk drives to your EO and using a
terminal emulator for data communications. Because the Macin~

tosh is such a popular computer, there will be a section on sharing

data with Macs as well. By the time you’ve finished with this

chapter you will know almost everything there is to know about

transferring files to and from an E0 using other types of comput—

ers. (Email is covered in Chapter 8.)

The final topic that will be covered in this chapter is setting up

your printers so you can print from the E0. Unless you tell the E0

what printers you have access to, and set them up, you will not be

able to print. Printing is controlled from the Connections acces—

sory, so you’ll find. everything you need to set up printers in this

chapter. These instructions will be in the sections on configuring

PenCentral and using the Connections accessory.

Some of the information in this chapter is technical in nature. I’ll

try to make it clear and avoid computer jargon as much as possi—

ble. However, in writing a book about a computer it is nearly

impossible to avoid jargon completely. More importantly, make

sure you have a good understanding of the material in this chapter

before attempting to do anything, especially if it has to do with

your disk drives and the data files on the drives. It is possible to

delete files your EO needs to run properly. Your E0 is designed to

be easy and fun to use. Deleting a critical file could change that

experience to a painful and frustrating one. Although every mea—

sure has been taken to keep you from causing damage, it is not

impossible. So please, be careful.
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E0 Connections Overview

As mentioned in the introduction, this chapter is about using an

E0 to connect to other computers, printers, and disk drives. This

task can be accomplished in three different ways. One is to connect

directly to another computer using PenCentral and PenTOPS;

another is by using PenTOPS Modem. The third way is to use

either a direct serial or modem connection using third—party termi—
nal emulation software.

This section’s purpose is to give you an overview of these EO

capabilities. Because there are so many different computers in use

today, this section will help you decide how you can get data

from an EC) Personal Communicator into your computer. This

section is general in nature and will only tell you what is possible.

The actual procedures will be discussed in the chapter’s remain—

ing sections.

Accessing Drives and Other Computers
with an EQ

There are two ways for you to access any disk drive that has been

attached to an E0. The disk is visible as a Bookshelf and you can

also access it with the Connections program in the Accessories

Notebook. The Connections accessory is used by the ED for

accessing all disk drives, a PenCentral network server, and print—

ers, both those that are directly attached and those networked

through fPenCentral.

Disks on the Bookshelf

Any drive you connect to your EO will appear with its own Book-

shelf. In Figure 7.1 you will see three Bookshelves. The Bookshelf
at the bottom of the screen is the Bookshelf for the 130’s internal

hard drive.

The middle Bookshelf is labeled ”Sundisk 1” and represents a
solid-state flash disk which is inserted into the EO’s PCMCIA card

slot. The third drive labeled ”Mini Drive” is a PenCentral net—

worked drive. The networked drive is an MS-DOS hard drive that
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Figure 7.]
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is connected to the EC), using PenTOPS on the E0 and PenCentral

on the MS—DOS computer. If a floppy drive was also connected to

the E0 it would appear as a Bookshelf just above the Bookshelf for
the EO’s built~in hard drive or the Sundisk drive.

If your EO does not have a hard drive, you are using a RAM~based
EO. However, it will have a Bookshelf that shows all of the EO’s

notebooks. Everything you see on the Bookshelf is held on a RAM

disk. A RAM disk works like a disk drive and is part of the EO's

memory that has been devoted to the system for storing docu—

ments and programs you install. The problem with not having a

hard disk is that you do not have as much storage space for your

information. However, the advantage is that your EC) will run a bit
faster than one with a hard drive.

When you place items on the Bookshelf they will appear in a line

that is parallel with the drive label (the drive’s name) until the

shelf is full. Then they will appear on a line above the drive label.

In a sense, your Bookshelf becomes a bookcase. In Figure 7.1 you

see that the first Bookshelf is full with the Perspective and Busi-

ness Notebooks on the second level for the EO’s hard drive. (This

drive is also called the boot drive.)

The Connections Accessory

If you want to see what is on an EO’s drive without looking at it

from the Bookshelf, you will have to use the Connections acces-
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sory. The Connections accessory is in the Accessories Notebook.

Using the Connections accessory you can see and manipulate the
files on an EO’s drive.

But before you go poking around on your EO’s drives you need to

know a few things. First of all, the E0 uses an MS—DOS drive for-

mat. This means that any floppy disk you can use on your EO can

also be used on a MS—DOS computer. It can. also be used on a Mao

intosh that has what Apple calls a SuperDrive; this is a Macintosh

disk drive that can read any 1.44 or high—density floppy disks.

(There will be more about exchanging files with a Mac in the sec-

tion called ”Sharing Information with a Mac”)

Next, if you look at the drive that is running your EO, either the

RAM disk or its internal hard drive, you will not be able to see any

directories. (A directory is like a folder and holds data files.) You

will only be able to see directories on drives other than the boot

drive. This is done so you will not delete a file that might be

needed to run your E0.

When you use the Connections accessory the View you will have

of your drives will look like Figure 7.2.

In this view all of the drives are closed; the files they contain are
not visible. Notice that all of the drives have the same names as

Figure 7-2 Floppy or Sundisk Networked disk
The EO’S

drives as seen Internal hard ‘
from the drive or RAM -——
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their Bookshelves. The drive Sundisk 1 is the same disk that con—

tains the Bookshelf Sundisk 1 in Figure 7.1. The disk drive

BOOTVOL is the 130’s startup disk. If you are using an E0 with—

out a hard disk your boot disk will be named RarnDisk.

When looking at a disk’s contents on the E0 you will see some-

thing that looks like Figure 7.3.

In Figure 7.3 you see different views of all three drives. When

looking at a disk other than the boot drive you can set the disk’s

View to any of the following:

Directory You can see all of the files and directories on a disk. In

Figure 7.3, Sundisk 1 is being viewed by directory. You can also

create directories. If you are going to share files with another com-

puter you will have to use this View on the disk that will go to the

other computer.

Applications This View lets you see all of the PenPoint applica—

tions that are on a disk and usable by the BC). In Figure 7.3 the disk

Mini Drive is set to View the applications.
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Services Services are special PenPoint system. utilities required

by other programs. You will probably never have a need to do

anything with the Services on your EO. In Figure 7.3 BOOTVOL is
set to the Services view.

Handwriting Handwriting is the View you would use if you had

different character recognition programs on your EO. When you

first get your EO, this view will be empty because the only hand~

writing software on your E0 is installed and in use.

Dictionaries This is the View you would use to see additional

uninstalled dictionaries on your EO. Once again, this View will be

empty when you first get your EO.

Fonts Here you would see any uninstalled fonts that are on your
drive.

User Profiles In this View you would see any uninstalled User

Profiles you may have created.

Bookshelf This View would show you the Bookshelf of the drive

just as if you were looking at the Bookshelf on the EO’s screen.

When you look at the boot disk, whether it is a RAM disk or a

hard drive, you will not be able to access the Directory or the

Bookshelf view. On any disk other than the boot disk you can use

any of the views. But if you place files on the Bookshelf or use any

view other than the Directory View, those files will not be accessi»

ble on any computer except one running the PenPoint operating

system. So, unless you are going to be giving that floppy disk to

another E0 user, or if the disk is a backup disk for your data, you

shouldn’t copy notebooks or place documents on the Bookshelf.

If you are going to use your documents on a desktop computer of

some type you must copy them directly onto the disk using the

Directory view. This places the document onto the disk or in a

directory. Because the ED uses an MS—DOS format on all of its drives

and PenTOPS accesses an MS«DOS hard drive, you can easily copy

information from your E0 to an MS—DOS computer. The different

'methods for accomplishing this feat will be discussed in the sec-

tion on importing and exporting your documents.

If you do not have an MS-DOS machine so you can use PenCen—

tral, you should purchase an E0 floppy drive with your EO. With—
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out an MS-DOS computer or an E0 floppy drive you will have no

way to back up your documents. To move large quantities of data

from your 130 to another computer and back you should think

about using a SunDisk and a CardPro Universal PC Card Drive.

(These are described later in this chapter.)

If you have an MS—DOS computer with a hard disk, 512K of mem-

ory, and a floppy drive you will be able to use PenCentral. If at all

possible it is best if you have 3.5~inch high-density floppy drive in

the MS—DOS machine so you can easily install software. The soft—

ware you will purchase for an E0 usually comes on a 3.5-inch

disk. The hard disk is not a necessity, but it sure makes life easier.

A cable is required to connect the E0 to the PenCentral server, but

that comes with your E0.

If you install PenCentral on a DOS machine that is on a Novell or

a Microsoft LAN Manager network, you can access that network

by connecting your E0 to the DOS computer. You’ll be able to

access the network and share documents with others in your

office. Also, you’ll be able to print from your E0 to any of the net»

worked printers.

Your EO connects to a PenCentral network server using a program.

called PenTOPS. This program is built into the E0 and integrates

with the Connections accessory so you don't even know it’s there.

The only work you’ll have to do is set up the PenCentral server.

PenTQW Madam necessary

Once you. have PenCentral up and running, if you have a modem

you’ll also be able to access documents on the server using another

EO accessory called PenTOPS Modem. PenTOPS Modem is an

accessory that will call your PenCentral server and. allow you to

connect through the modem in your E0. While you are connected

you’ll even be able to print files.

One word of caution, using PenTOPS Modem will be slow. If you

know that you’ll want access to PenCentral while on the road you

should consider investing in an a 14.4 modem for your MS-DOS

machine. If you purchased your E0 with a modem it already has a

high—speed modem. Also, if you have the Cellular option you can
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use PenTOPS Modem over a cellular connection. In essence, you

can always send files to and from your PenCentral server.

Available Disk Drives

If you are not going to use PenCentral (for whatever reason) you

will need an alternative means of storing your documents. The

EO’s floppy disk drive, SCSI hard drives, and the SunDisk, a solid-

state flash storage device, have all been mentioned. All of these

storage options can also be used to back up your documents and

increase your 1305 storage capacity, and all can be used to transfer

data from your E0 to other computers.

 

The least expensive and most versatile of these options is the EO’s

floppy drive. The EO’s floppy drive connects to your E0 through

the parallel port located on the left ear (see Fig. 7.4).

Once you’ve connected the floppy drive (be sure you connect the

floppy drive While the E0 is in Standby mode) its operation is

almost automatic. If the disk is not formatted, the E0 will tell you

so and give you the option of using a double (720K) or high den-

sity disk (1.44M). If you are using the floppy drive for backing up

your data you will probably need several disks (up to 14 disks to

back up a 20 megabyte hard drive), depending on how large your

hard drive is or how much memory you have.

Also, with the floppy drive you can share your documents with

anyone who has a DOS machine with a 3.5—inch drive or a Macin—

tosh with a SuperDrive. If you have a Macintosh with a Super-

Drive, the Mac already has everything you need to share files.

  

Figure 7.4

A view of the

EO’s left-hand

side

 

  
PoroHel port
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NOTE Every Macintosh with a SuperDrive (about 80% of the Macs avail
ableI has a utility pro ram called Apple File Exchange Apple has
been se In Macs witg SuperDrives only for tour to five years. Theystarted lthhding SuperDrives in all Macintoshes when the (SE/3O
andlllvx were released. This program can be found on the Utilities 2
or Tidbits dIsk of the Macintosh System Disks for System a O. X and
7X respectively With this program you can read a floppy disk
from an E0 and transfer files from the floppy to the Mac and from
the Mac to the floppy.

Another option you have for backing up your documents and even

sharing files with an MS—DOS machine is the SunDisk. A SunDisk

is a solid~state flash mass storage device. How’s that for a mouth—

ful? It is a thin card about the size of two credit cards pressed

together, and it fits into the EO’s PCMCIA slot. Figure 7.5 shows

the 130 with a PCMCIA card being installed. (The installation, steps

for a PCMCIA card can be found in Chapter 1.) The SunDisk comes

in sizes ranging from 2.5 to 20 megabytes and can be used as addi-

tional storage space and as back-up disks for your data.

Nfli’fi PCMCIA stands for Personal Computer MemOIy Card International
Association, which is an organIzation that has established a set of
industr standards for memory, flash disk, modem and networkin
cards {3r portable computing deviceslltyou tind abbreviations dihg
cult to remember, you might try ”People Cant Memorize Computer
Industry Abeeviations” as a way for remembering PCMCIA

There are three standards for the PCMCIA card The standards are

distinguished as Type I, Type 2, and Type 3 The E0 440 uses one
Type 2 PCMCIA card while the E0 880 can use eIther two Type 2
or one Type 3 PCMCIA cards. Right now there are two types of
caIds that the E0 can use One Is the SunDisk which is also called

a silicon disk card, and the otheI is a SRAM card. SRAM stands for

Figure 7.5

An EO with a

PCMCIA card

being instalIed  
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Static RAM. These cards are expensive and often small in capacity.
{This means I’m not going to say anything about them.)

By the end of the year you should be able to get a networking PCM~
CIA card for an E0, which means you would be able to connect
the E0 directly to an Ethernet or Token Ring network. Another type
of PCMCIA card that should be available by the end of the year is
a pager card. The pager card would turn your EO into a beeper in
addition to its other capabilities.

The SunDisk acts like a big floppy disk. It is removable so you can

exchange it with other 130 users. And if you get a device like the

Universal PC Card Drive called the CardPro from Data I /0, you
can read and write to a SunDisk with a DOS machine. The

SunDisk is also very rugged; you would have to seriously abuse

one to break it. The SunDisk is an ideal way to have unlimited

storage capacity for your EO. If you fill one up but need the docu—

ments it contains all you have to do is get another. And if you’re

using an E0 880, you can have two installed at once.

Since we’re talking about the E0 880 we might as well talk about

the ability to add a SCSI hard drive. The E0 880 has a SCSI port on

the left~hand side. SCSI pronounced ”scuzzy,” stands for Small

Computer Standard Interface. It is a means of expanding a com~

puter system’s capabilities by attaching external devices to the E0.

Right now you can connect a SCSI hard drive to the E0 880. In the

future you should be able to attach other devices like scanners and

maybe even other computers.

When you attach a SCSI hard drive to the 880 the drive will have
to be formatted as an MS—DOS drive. You. can use a drive that is

already formatted, or the 880 will format it for you. This can be a

problem if you have a Macintosh because it is difficult (although

not impossible) to use a MS-DOS SCSI drive on a Mac. The easiest

way to use an MS—DOS SCSI disk on a Mac is to use a removable

media drive like a Syquest, Bernoulli, or optical drive. For these

types of drives you can get Macintosh software that will. read an
MS—DOS disk.

Connecting a SCSI disk to an E0 that will also be used on an MS-

DOS computer is very easy, as long as your MS-DOS computer has
a SCSI interface built in or as an add—on card. The use Of SCSI hard
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drives is becoming more common on MS-DOS machines, but it

still not a very popular option. However, SCSI has been the

favorite way to add peripherals to the Macintosh for several years.

This is why you can use one of the drives mentioned above with

the E0 880 and a Mac, if you have the correct software. The actual

mechanics for connecting a SCSI disk to an E0 880 are covered in

Chapter 1.

N31? There are two companies who make software that will let a Mac
read removable disks that have been formatted for MS—DOS

machines. One is Dayna Communications. They make a product
called DOS Mounter Plus. DOS Mounter Plus will mount a Syquest
disk (available in 44 and 88 megabytes) on a Macintosh as if it
were a Mac disk. DOS Mounter will also let a Mac read MS—DOS

floppies without using the Ap le File Exchange utility. Another com-
pany that makes a product t at lets Macs read MS—DOS formatted
Syquest and floppy disks is AccessPC. AccessPC is made by
Insignia Solutions.

Terminal Emulators

The last method for transferring your documents to other comput—

ers involves using a modem or a special serial cable. If you have a

terminal emulation program for your EO you can actually com~

municate with almost any computer on earth. Of course, the other

computer also has to have a terminal program of some type. But

that is really not a problem. Every computer that I’m aware of has
at least one terminal emulator.

There are two companies who have terminal emulation programs

for the E0. One is called Mobile Access, and is written by Notable

Technologies, Inc. And the other is called PenASCll, written by

COMPSOFT Services. With either of these programs you can

access on~line services such as Compuserve, Genie, or any other
service that allows a standard VT100 connection. This also means

you will be able to access a lot of electronic bulletin board services,

generically called BBSs. These are usually free (or very inexpen-

sive) services run by special interest organizations and individuals

for sharing information or just having fun. Also, many businesses

and some government agencies maintain bulletin board services

for either their employees or the general public.
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Another use for a terminal emulator would be to access electronic

mail (E-mail) services through E-mail packages such as QuickMail

(Macintosh), cczMail, DaVinci Mail, and many others. Many com—

panies have an in-house E~mail system so their employees can

quickly and easily communicate with each other by sending

memos, notes, and even files back and forth. Although most E-

mail systems use special software for their desktop computers,
almost all of them will allow you to connect, send and receive

mail, and even transfer documents with a terminal emulation

package.

And if you want, you can even access the Internet with an E0

and a terminal emulation package. The Internet is a world—wide

network that is used by universities, governmental agencies, and

businesses. Although it is not an on—line service, the amount of

information you can get through the Internet is amazing. The

White House is even on the Internet, so you could send a mes—

sage to the President or the Vice President if you have Internet
access.

NOTE The Internet is an enormous, global network of computers. As ou
can imagine, finding your way around such a system can be a ittle
confusing at first. You’ll need to s end a bit of time learning what it
is and how it works before it wil be useful to you. But, depending
on your needs, it could prove to be invaluable. There are now com-
panies who are providing Internet services to individuals for a small
monthly fee. For more information on the Internet, see The Internet
Navigator, by Paul Gilster, published by John Wiley & Sons.

Using a terminal emulator to connect your E0 to another com—

puter so you can transfer files requires a serial cable. A serial cable

is a special cable used to connect computers, or in this case the E0

Personal Communicator and a computer, so they can communi~
cate. The cable is called serial because of how the data is

exchanged between the two devices. All data is sent one piece

(byte) at a time in either direction.

It is like using a straw to send BBs from one container to another,

where each BB is one letter of your document. When all of the BBs

from one container (your EO) have gone down the straw to the

other container (the other computer) the document has been trans—
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ferred. Of course, if you can send the document in one direction

you can also send a document in the other direction.

The PC connection cable that comes with your EO will work on

any DOS computer for this purpose, and it should also work with

any computer that has a standard RS 232 port. However, the PC
connection cable will not work with a Macintosh. To connect a

Macintosh or any other computer that has a different type of serial

port you will have to have a custom-made cable. One company

you can get a custom cable from is System Connection, located in
Orem, Utah.

System Connection is a company that specializes in computer

cables. They make cables for almost any purpose and will be able

to make you a cable that will connect your E0 to any computer

with a serial port. In most cases, all they need to know is the type

of computer you plan to connect to. They will do the rest, and in a

couple of days you’ll have a cable.

COMPSOFT also makes terminal emulators specifically for connect—

ing to IBM mini and mainframe computers. If they do not have a

terminal emulator for your system, they will make one. So, if your

company has a large computer system that you need to connect to,

you can get the software you need for your E0 and enjoy the same

features you would if you were using a desktop computer.

All in all, you can connect the E0 to any computer. If you want to

know the basics for connecting an E0 to another computer using a
terminal emulator, the nuts and bolts are discussed later in this

chapter.

Connertan “ hitters in an E0 

As mentioned in the introduction, you can connect a printer to

your E0. Although this may seem like an odd place to talk about a

printer, it really isn’t. All printers are actually dumb computers.

They contain their own computer chips and have to be talked to

by the E0 in a specific way. In a sense, when you connect your E0

to a printer you are connecting it to a very stupid computer that

has just one function: printing.
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There are all kinds of printers in the world, and your EO can print

to almost any printer you come across. Like connecting to other

computers, how easy or difficult making this connection will be

depends on the printer, not the E0. The E0 can print to two types

of printers, a dot matrix printer or a PCL printer.

The most popular brands of dot matrix printers are probably

Epson or Citizen, but there are more manufacturers than I can list

here. Basically, every dot matrix printer should be able to emulate

an Epson or an IBM Proprinter printer. If you have a dot matrix

printer you should refer to your user’s manual to see whether it
will work with an E0.

You can connect your E0 to any laser printer that uses the PCL

page description language. In English, this means your laser

printer has to emulate a Hewlett Packard LaserIet. Again almost

all laser printers, even Apple LaserWriters, can emulate an HP

LaserIet and in theory can be connected to an EC). Also, some ink

jet and bubble jet printers also support PCL, primarily the HP

DeskIet printer. Again, you will have to turn to your printer man—

ual to find out if your laser printer will work With an E0.

I’m sure you noticed the hedges in the last few paragraphs. The

reason for this is that there is no way to be sure unless you check

your manual. The E0 can print to any of the following printers or

any printer that can emulate one of them.

These printers use the PCL page emulation language:

9 HP Laserjet II

3 HP 'Laserjet HP

9 HP Laserjet IID

9 HP Laserjet III

' HP Deskjet

The following are dot matrix printers:

0 Epson FX—8O

0 Epson FX-850

0 Epson LQ-SOO
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0 Kodak Diconix 150

6 Kodak Diconix 150+

0 IBM Proprinter II

0 IBM Proprinter 24

0 NEC P5200

In order to connect your E0 to a printer you will have to get a par-

allel printer cable. Once you have the cable you can connect to any

parallel printer. I said that an Apple LaserWriter would also work,

and it will. But the older LaserWriters are serial printers, not paral—

lel, so you would have to go to a lot of trouble to use one since it

would require that you get a device called a parallel to serial cori—

uerter. Believe me, these can be a real pain to use, not to mention

reconfiguring your printer to work with the E0.

Unless you have a newer Apple LaserWriter that will automati~

cally switch emulation modes and accept data from a parallel port

while simultaneously using a serial port, I would recommend you

forget using the LaserWriter. The only other way to easily use an

Apple LaserWriter would be to attach it to a MS-DOS machine via

the serial port and make it available to the E0 using PenCentral.

Nfli'e The EO will not print to a printer using PostScript. This may be a dis-
advantage, but this is only a temporary situation. Even as i write
this, there are software geniuses hard at work writing the software
that will let the EO use PostScript printers. You can expect to see this
capability appear within a year. It will be available to existing EO
users either as a ROM update or when a new set of ROMS are
issued. (See Chapter l tor information on ROM updates and
upgrades.)

The family of ink and bubble jet printers available from Canon,

Kodak, and Hewlett Packard make great EO printers. All of these

printers will emulate a dot matrix printer, and their output is

almost laser quality. Also, they are inexpensive. You should be

able to get a printer like the Cannon Bl-ZOO, a bubble jet printer, for

less than $400.00. The 131-200 is not a portable printer, but each of

these companies make portable printers that will run off of batter—

ies so you can take a printer on the road with you. Some of these

printers weigh around two pounds.
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When you go shopping for a printer that is not in the list above,

just remember that you need either Epson FX or LQ emulation or

HP LaserIet capabilities. You. will have no problem getting a

printer to meet your needs.

Using the EO’s Conneefiem
Accessory

The Connections accessory is a mini notebook that is used to con-

trol your EO’s connections to other disk drives and printers, both
local .and networked. A local connection is one where the device

(a printer, disk drive, etc.) is physically connected directly to

your EO. A network connection is one where you use your E0 to
access devices that are connected to a DOS machine-this is done

by connecting the E0 to a DOS machine that is running PenCen-
tral.

in networking terms, a DOS machine running PenCentral becomes
a ”server.” The server makes devices available to the “client,”

which in this case is your E0. The E0 uses a program called Pen-

TOPS to connect with the DOS server. PenTOPS is already

installed on your EO as a service and works transparently with the

HO and the Connections accessory. This means that you don’t have

to do anything special to connect to a networked device (except

maybe enter a password).

When you open the Connections accessory you will see the Con—

nections contents page, which looks like Figure 7.6.

In the contents page you have two sections: Disks and Printers.
Each section has a choice between Connected and Network View.

Also, the Connections accessory has three tabs: Contents, Disks,

and Printers. The following list describes each of these options:

Connected Disks Turns to the page that displays all connected

disks, including networked disks.

Disk’s Network View Turns to the page that shows your net-
work server connections and all of the available network volumes.

You can also set certain options from this page.
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Figure 7.6 3/” Connections
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Connected Printers Shows all defined printers that are con—

nected directly to the EC). This is also the page on which you create

new printers.

Printer’s Network View On this page you can see any net—

worked printers. To see a networked printer it must be set up for

the ports on a PenCentral server.

The Disk Tab This tab will take you to the Disk page. The page

will be set to the View you were using when you last turned away
from it.

The Printers Tab This tab will take you to the printer page. The

page will be set to the View you were using when you last turned

away from it.

The Contents Tab This tab returns you to the Contents page.

This next section will look at using the Connections accessory with

connected and networked drives and printers. Connections is also

the tool you use for advanced file management. In this section you

will learn about importing and exporting data to and from the E0,

and we’ll discuss backing up your documents.
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Connections’ Menus and Optons

The Connections accessory is used to manipulate and manage

your EO’s disk drives. When you turn to the connected disk page

you will see something similar to Figure 7.7.

In Figure 7.7 the connected disks are displayed across the top of the
page. To open a disk, tap l’ on its icon. When the disk opens, it gets
its own portion or section of the page along with a menu. If it is the

only open disk it will fill the page and the disk’s icon will be gray

Each successive disk that is opened gets a section of the page and has

its own menu. The menus allow you to perform different tasks on

the disk. The following is a list of the menus and their commands:

Disk

This menu is used to perform commands that operate on the open
disk.

Close This command closes an open disk. You can also close an

open disk by tapping l’ on its icon while it is open.

Figure 7.7 Connected disks Networked disk
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Duplicate Use this command to copy a disk. This command

should only be used on floppy disks because you will have to

swap disks to make a duplicate.

Update Display Use this command to check to see if new docu-
ments have been added to a disk.

Format This command is used to format a disk that is in use.

Whenever you use a disk for the first time, if it is unreadable, it

needs to be formatted. With all disks you are given a chance not to
format a new disk.

Edit

This menu is used to manipulate files and directories. Almost all

of these commands have gesture equivalents.

Move Use this command after selecting a document, directory,

or Bookshelf item to move it to another directory or disk, or to

place it in a notebook or on the Bookshelf. After the command is

executed, the selected file or directory will have a single marquee

around it, indicating that it is selected and ready to move. To move

the document, drag it with the pen to its new location. Performing

a press i on the file will have the same result as selecting Move.

Copy This command operates in the same manner as the Move

command, only it prepares a file for copying and displays a dou~

ble marquee. A tap press xi will have the same effect.

Delete Selecting this command will delete the selected docu—

ment, directory, or Bookshelf item. The gesture equivalent is the

delete X gesture. Use this command with caution. Once you have
deleted an item it is lost forever.

Rename This command causes a pop—up editing pad to appear

so you can change the selected item’s name. Drawing the circle 0

gesture over the item will have the same effect.

Create Directory With this command you can create a directory

on the drive. This command is only available in the Directory view.

Options

These are the options you have for displaying your disks and get—

ting information about your disks or directories. This menu does

not appear for the disk that boots the E0.
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Figure 7.9
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Selected View Options The first available option will change,
depending on the View and whether either a document or a direc~

tory is selected. If you are Viewing the disk using the Directory
View and select a file, the first option in the menu will be File. If

you select a directory, the first option will be Directory. Likewise, if

you are using the Application View and select an application, the

first option will be Application.

Options for all files, documents, and directories contain informa—

tion about the selected item. The only modification you can make

is to add a comment that is associated with the item. Figure 7.8

shows the options sheet for a file and a directory.

Layout Controls what information will be displayed for a partic-

ular View. Figure 7.9 shows the Layout options sheet for the Ser—
vices View of the disk BOOTVOL.
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Disk Shows information about the selected disk, including size

and free space. You can change a disk’s name within this option

and set the Quick Installer. The Quick Installer option is used

when you have applications on a disk that are not on your boot

drive. If the Quick Installer is set to Yes, the applications will auto“

matically be installed when the disk is mounted by the E0. Figure

7.10 shows the Disk options sheet.

Disk Icons This option allows you to set how your disk’s icons

will appear. Figure 7.11 shows the Disk lcons options sheet.

If you want to see the options for your boot drive, draw a check

mark \/ on the section where the disks information is displayed

or on the disks icon. Drawing the check mark \/ on any selected

item will display the item’s options sheet.

View

The View mode is how you look at the documents or files on a

hard disk using various Views. Each of the views represents a dif—

ferent type of PenPoint file. These different types are discussed in

Chapter 3 in the discussion about the Installed Software section of

the Settings Notebook.
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Directory You can see all of the files and directories on a disk.
This View is not available for the drive that boots an E0.

Applications This view lets you see all of the PenPoint applica—

tions that are on a disk. Some installed programs are only visible

from the applications page of the Settings Notebook (see Chapter 3).

Services This view shows the services that are on a disk.

Handwriting This View shows you the uninstalled character

recognition programs on your drive.

Dictionaries This view shows any uninstalled dictionaries on

your drive.

Fonts Here you are shown any uninstalled fonts that are on your
drive.

User Profiles In this view you see any uninstalled User Profiles

you may have created.

Bookshelf This View shows you the Bookshelf of the drive just

as if you were looking at the Bookshelf on the EO’s Screen. This

View is not available for the drive that starts your EO.

There are really very few reasons to use the Connections acces—

sory. Most of your file management will be performed using

Bookshelves and notebooks. However, you will use the Connec-

tions accessory to transfer files for use on other computers, and to

make backups of applications, user profiles, and other system
files.

Accessing PenCeratral Voumes

When your E0 is connected to a PenCentral file server, Connecv
tions is used to control how the network files and devices are

accessed by the E0. The Network View page is used. to show the

PenCentral file server. From the Network View page you control

all aspects of the EO’s network connection.

To get to the Network View:

1. Open Connections

2. Tap Y on the Network View menu selection in the Disks sec-
tion. This will open a page similar to Figure 7.12.
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In Figure 7.12 the selected item is a PenCentral file server called

PenServer. Double tapping ,. on the server opens it, and you can
see the available networked disks.

Figure 7.13 shows all of the networked disks available for PenServer.
There are ten available network drives. This is because PenServer

has been set up as an applications server to make installing software

easier (see the section on configuring PenCentral). However, What is

more important to note are the options for each disk. Each disk has a

Connected and Auto-Connect check box. Tapping l’ the Connected
check box will cause the E0 to connect the checked disk. This action

will make the disk available on the Connected page and give you
access to the disks Bookshelf.
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Figure 7.14 shows the disk named Mini Drive as connected and its
Bookshelf. Notice that the Connected and Auto—Connect check

boxes are both selected. If you check the Auto—Connect check box,

the disk Mini Drive will be automatically connected each time you

connect the E0 to the PenCentral server. For every networked disk

you want auto—connected, check the disk’s Auto—Connect check box.

Once the disk is connected, you can close Connections and use it

like any disk connected to the E0. What you need to remember

about networked disks is that they are much slower than other

types of disks. Even an E0 floppy drive will probably be faster

than a networked disk. The first time you connect a networked

disk it takes longer than it will during subsequent connections.

When working in the Network View page you have access to

View, Options, and Update menus. The Update menu is actually a

button which when tapped Y will cause the E0 to scan the network
and make any new disks or documents available.

The View menu has the following commands:

Disks This command changes the View to a disk View hiding the
file server’s name.

File Servers Here, the command sets the view to show the file

server. This is the view for both figures 7.13 and 7.14.
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Expand This command is only available when View is set to File

Servers. lt expands the view so all of the file servers’ disks can be
viewed.

Collapse This command is only available when View is set to File

Servers. lt collapses the view so only the file servers are viewed.

The Options menu offers the following selections:

PenServer This selection shows you the type of server you are
connected to and the server’s location. These values are constant,

unchangeable, and of little interest.

PenTOPS Status This is the main control option for PenTOPS.

From this options sheet (see Fig. 7.15) you set the 130’s defaults
which control how the E0 interacts with the PenCentral server.

These options will be discussed below.

Layout With this options sheet (see Fig. 7.16) you tell the E0

which page elements you want to view and how you want your

disks sorted when they are displayed.

When you select a, disk and draw a check mark \/ on it, you will

see an options sheet for the disk.

These are all of the options you have for the Networked View

page. How you use them is up to you. You should experiment

with the Options to see what works best for you. However, you

really need to be careful with the PenTOPS Status options sheet
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displayed in Figure 7.15. The following is a list of the PenTOPS

Status options.

User Name This is where you can put your name to identify

yourself as the network user.

Location This is the same as the location in the PenServer

options sheet.

Connection Type The Connection Type line identifies how you
are connected to the server.

Attached Here, the EO’s status is diSplayed as either Yes or No.

Automatically Connect This setting determines how the server
disks are auto-connected. Your choices are to auto—connect All,

Selected (the default setting), or None of the networked disks
when the EC) is attached to the PenCentral server.

Remember Passwords With this setting you tell the E0 how to

remember your passwords if the PenCentral server uses them.

Your choices are Never (the default setting), For Servers, For

Disks, or For Everything.

Permissions This option sets the read /write permission for all

network disks. You can make them all read—only (you will not be

able to write to the disks) or all read /write. If you want to make a

specific disk read~only, set the read /write permission for the disk
in the PENINFODAT file. You will find these instructions later in

this chapter.

Bookshelf View This setting tells the E0 whether or not to show

the Bookshelf for networked disks. Your choices are Always

Enable, Always Disable, or Disable for Modem Link (the default

setting). The Disable for Modem Link is used as the default

because it takes the server longer to connect if the E0 is going to

display the disk’s Bookshelf.
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Figure 7.17
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Floppy Auto—Connect This setting tells the BC when to auto—

connect floppy disks. The choices are Always Enable, Always Dis—

able, or Disable for Modern Link (the default setting). Because

connecting a networked floppy disk is slow, it is best not to con—

nect to floppies when using PenTOPS modem.

Revision This is an information line that tells you what version

of PenTOPS your E0 is running.

You will probably have to experiment with these settings to cus—

tomize your EO’s network settings. However, even if you never

look at these settings, your EO will work just fine.

If you connect several disks, networked or otherwise, it is possible

to connect more disks than you can see at a single time on the EO’s

screen. When this happens, the EO’s screen will display a scroll

bar (if you have the Arrows 8: Drag option in the Fonts & Layout

page of the Settings Notebook selected) like the one in Figure 7.17.
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Working with networked disks is the same as working with any
EO disk. Once you are connected to the server you can use the net~

worked disks’ Bookshelf or any of the other disk views. However,

if you create or use documents that are stored on a network vol-

ume, your EO will run very slowly. If you need to use a document

from a networked volume, you should copy it to your EO’s drive
and then use the document.

Importing and Exporting Your Data

To share documents from your EO with other computers you will

have to get the document from your E0 to the other machine. The

first part of this process is to export the document so that it is in a

format that the other computer can use. Any program that might

be sending your documents to another computer, such as GO Mail

or terminal emulators, will give you an opportunity to change

your document into a format other computers can read. The

process of preparing and sending documents to other computers is

called exporting.

The same applies when you are receiving documents from other

computers. You have to be able to use the document(s) on your EO.

Converting documents from other computers is called importing.

Since data conversion is the most important aspect of importing

and exporting documents, let’s spend a few minutes looking at the

EO’s data conversion capabilities. Documents are converted only

when they are copied to a disk’s directory, or by an EO application

sending the document to another computer.

To convert any document:

1. Open the Notebook that contains the document you are going

to export.

2. Select the document.

3. Open the Connections accessory.

4. Select the Connected View for your disks and open the disk you

are going to put the document on. Set the View to directories.

5. Move the Connections window so you can see the document

you are going to export.
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6. Either press i or tap press 4 to move or copy the document.

7. Drag the document to the disk or directory you’re using.

8. You’ll be presented with an Export options sheet similar to the

one in Figure 7.18.

In the Export options sheet you can select the file format for the

exported document and have the opportunity to change its name.

To change the name, just tap l" on the line with the document’s
name or draw a circle 0 over it. A pop—up editing pad will appear

and you can write a new name. You will also have a list of the

available file formats for the exported document. Figure 7.18 dis-

plays the following choices:

PenPoint Document This selection simply copies the file, it does

not make any changes to it. If it is a MiniText document on the

EC), it will be a MiniText document when you copy it to the other
disk.

ASCII File An ASCII file is a file that contains text with no for-

matting. The lines in the file will end with a hard page break and

all tabs will be converted to spaces.
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Soft Line Break ASCII File This file format puts a soft line break

at the end of a line so the file will word~wrap when it is used on

another computer.

RTF File RTF stands for Rich Text Format. This is a universal file

format that keeps all of the document’s original formatting. Most

word processors on other computers can convert RTF files, so that

the document will look the same on either computer.

Once you’ve selected the format you want and tapped Y on the
Copy button, the file will be converted as it is copied. Then you

can take the copied file from the disk. Usually this will be a Pen-

Central disk that is actually a networked volume which can be

accessed by other computers on the network, or a floppy disk 50 it

can be used on another computer.

The type of file conversion options you will have depends on the

type of document you are exporting. Most documents on the E0
can be converted. However, some files that use ink, like MiniNote,

will not export the ink, even though they will export the text.

Other documents, like GO Fax documents, will export in a graph—

ics format. GO Fax will export the first page of the fax as a TIFF

file. A TIFF file is a graphics standard that can be used with most

graphics applications, and most word processors can use TIFF files

as embedded graphics.

Personal Perspective files can be exported as text, ASCII delimited,

or Perspective Data (the same as a PenPoint Document) files.

ASCII delimited files use a tab character or commas and quotes to

separate the detail fields. Which file format you choose depends

on how the data is going to be used. Most database and spread

sheet applications can read either type of delimited data.

NOIe Whenever you export a document, you will have to give it a name
that is compatible with an MS—DOS computer. Even though the E0
uses disks formatted for MS—DOS machines, PenPoint allows you to
use file names which contain up to 32 characters. An MS—DOS com—
puter can only recognize file names that contain 8 or fewer charac-
ters. An MS-DOS file name looks like:

FILENAME.TXT

The first eight letters are the file’s name. After the file’s name you have
to insert a period, and following the period is a three—letter extension.
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The extension identifies the file’s type, so a text file has the letters TXl,
while a Rich Text Format file has the letters RIF. If the file name does

not follow these conventions when it is exported, you may have prob-
lems accessing it from another computer.

Importing documents works just like exporting, only in reverse.

When you import a document, you will be copying from the disk

to a notebook. Before the file is copied, you will see an Import

options sheet like the one in Figure 7.19.

The options you’ll be given depend on what applications you have

installed on your E0. The import options you will have usually

correspond to the export options. The E0 looks at an import file,

and if it recognizes the file’s format, it will offer you the appropri—

ate choices. Any file it cannot recognize will be imported as a

Placeholder. A PenPoint Placeholder is called a binary file; the

file’s format is not modified in any way. The Placeholder is always

an option when importing documents.

This means you can import a file, save it as a Placeholder, and later

when you want to use it you can open the imported file. When

you tap l” on the Placeholder document, you will either be pre—
sented with an Import options sheet, or be told that the document

cannot be used on your EO.

To find out what import options you have for the software you’ve

installed on your E0, check the software’s manual. How software

from other companies handle imports and exports is up to the

software’s manufacturer. If importing and exporting are important

features to you, you should check with the software’s manufac-

turer before you purchase the software.

Figure 7.19

An import

options sheet
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Backing Up Yeur Documents

Backing up your documents is simply a matter of copying the doc-

uments from one disk to another. If you are backing up to a Pen—

Central file server you might want to back up your data twice.

Actually, you should always back up your data twice, once to a

network drive and a second time to floppy disks, or make two

backups on floppy disks.

Under most circumstances you will just copy your notebooks from
the Bookshelf of one disk to the Bookshelf of another. To do this,

just tap press 4 on the notebook you want to copy and drag it to

the Bookshelf of the disk you’re saving the data on.

One of the problems you’ll have if you’re backing up to floppies is

that your notebooks might be too large to fit on a single floppy disk.

To back up to multiple floppies:

1. Open the notebook you want to back up and move all loose
documents into sections.

2. Close the notebook.

3. Create a notebook on the Bookshelf of the floppy disk and

open it.

4. Open the notebook you’re backing up.

5. Tap press -i on a section you’re backing up and drag it to the
notebook on the floppy disk. Repeat this step for each section

until the floppy disk is full.

6. When the disk is full, remove it from the file server or your

floppy drive and insert a new one.

7. Finish the backup by repeating steps 2 through 5 above. Per-

form step 6 each time the disk fills up.

Your EO has some files you might want to back up that are not

contained in notebooks. These would be your User Profiles and

Dictionaries. Applications, Services, Handwriting, Gestures, and

Fonts will probably not need to be backed up. These files can usu-

ally be restored from their original floppy disks. Also, most appli-

cations cannot be copied after they have been installed.
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To back up files other than those contained in notebooks:

1.

6.

Open the Connections accessory and set the View for the back-

up disk to the Directory View.

Create a directory by selecting the Create Directory option

from the Edit menu. Name the directory something like
BACKUP.

Open the Settings Notebook and turn to the page that contains

the document you want to back up.

Resize the Settings Notebook and the Connections accessory so

you can see easily. Copy from the Settings Notebook to the

disk you’re Viewing in the Connections accessory.

Tap press 4 on the document you want to back up and drag it
to the directory you’ve just created.

Repeat steps 3 through 5 for each file you want to back up.

Figure 7.20 shows a directory with a dictionary and a user profile.

You’ll notice that the dictionary is listed as a dictionary in the type

column. However, the user profile is listed as a file. This is no

problem as long as you remember what the file is. If you’re afraid

Figure 7.20

A directory
with a
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0 user profile  
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you’ll forget, use the file’s options sheet and put a note to yourself

in the comment box. If you ever have to reinstall these files, per—

form the steps above, only copy the file from your directory to the

Settings Notebook’s page. When you copy the file back you’ll

probably see a dialog sheet like the one in Figure 7.21, asking if

you want to replace the existing file or give the one you’re copying

a new name. Go ahead and replace the file.

If you give the file a new name you'll have to install or make the

document current. This is done by tapping I’ in the install or cur-
rent check box. Once you've installed or made the new file current

you can delete the old file by drawing a cross out X over the file

you’re deleting. You’ll be asked if you want to deinstall or delete

the file. Tap I’ on the OK button to complete the procedure.

Advanced Software IInstaatian

Techniques
The normal way to install software is to use PenPoint’s Quick

Installer. All applications you get should automatically create a

Quick Installer like the one in Figure 7.22.

There will be times when you want your applications stored on a

floppy or a SunDisk so you have a backup. Also, some applica~

tions may need to be installed using this alternative method. How-
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Figure 7.22 / Ciuici; Installer for AHA.

A Quick This is the Armlioati’ori iew for this disk.

Installer Tap ct 2“ JJ-K. to iristally or use

 

 
the View stems to see sitter categories.  
 

Disk Edit "-.-" iew AHA

 

 
 

   
  

_....____....__J
 

ever, you will not save disk space by installing applications on

other disks. Any application an EO uses must be installed on the
EO’s main disk drive.

To install software onto a drive other than your startup disk:

1. Close the Quick Installer by tapping Yin its close corner.

2. Open the Connections accessory.

3. Open the disk with the software and the disk onto which you
want to install the software.

4. Set the View for both disks to Application.

Copy the application by drawing a tap press 4. on the applica—

tion and dragging it onto the drive where it is going to be
installed.

6. Check all of the Views on the software disk to make sure there

are no services, dictionaries, or other files that need to be

installed with the application. If you find another document that
needs to be installed, switch both disks to the Documents view

(i.e., the Services View) and perform step 5 on the document.

Once you’re sure you have the application and any subsidiary files

copied, you can install the application by tapping Y in the Install
check box next to the application on your secondary drive. If you
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want the application to install itself automatically when the drive

is connected, you will have to set the Quick Install option to Yes in

the Disk options sheet described above.

Setting Up Your Printers

Before you can print from an E0 you have to set up your printer

connections. As mentioned above, this is something else you do

with the Connections accessory. On the Connections contents page

you have two choices for printers just like you do for the disks;

you have a choice between connected and networked printers.

And like the disks, a connected printer is one physically attached

to the E0, and a networked printer is one attached via a PenCen—
tral server.

First, let’s look at the Connected Printer page. To get to the Con-

nected Printer page, open the Connections accessory and tap l’ on
the Connected label or check~box in the Printers section. If you

have not set up a printer yet, this page will be blank. Figure 7.23

shows a page with a printer already set up.

The menus in this page are Edit, Options, and Create. The follow—

ing is a description of each menu option:

Edit

Delete This option deletes a selected printer. The equivalent ges—
ture for this menu item is the cross out X, and it is drawn over the

printer you want to delete.

 

 

  
 

Figure 7.23 / p Primers. t» Connected
- _ Edit Iiifipticvns Create

The Printers Em Tm M an Em
Connected [EH Bubble Deriviatrik Epsom LCLEOO Fai'ailelF'or‘t g,

page with G %

configured ':
printer

SiaiuiId3x1

 

 
  

Kyocera PX 1046_325



Kyocera PX 1046_326

CHAPTER 7 

Rename Use this menu item to rename a selected printer. The
equivalent gesture for this menu item is the Circle 0, and it is
drawn over the printer name you want edited.

Options

6* The first option will be the name of any selected printer. When
you select this menu option, or draw a check mark \/ over the

selected printer, you will see an options sheet like Figure 724.
With. this options sheet you can see the type of printer, the port
it is connected to, and what type of paper feed it is using. The
main reason for selecting this option will be to tell the 130 that

you are using single feed sheet paper instead of continuous

feed paper.

9 The second option is the Layout option for the Connected

Printer page. With this option you tell the E0 Which columns to

display and how to sort your list of printers‘ Your sorting
choices are Printer, Type, Model, Port, and Enabled

Create

Dot Matrix Use this menu selection if you are going to create a
printer configuration for a dot matrix printer. The list of possible
printers can be found in the printing section earlier in this chapter-

PCL Use this menu selection if you are going to create a printer
configuration for a dot PCL compatible printer. The list of possible
printers can be found in the printing section above_

Figure 7.25 shows the Printer Creation options sheet. When you cre—
ate a printer you will have to give the printer a name and select the

type of printer. When selecting a printer type, you may have to guess

at what printer to select. If you are using the Dot Matrix option, the
lowest common denominator will probably be an Epson FX~80. You
can always try different printer selections to see What will work best.

if you are connecting to a laser printer and you do not know which

 

Flgure 7.24 / vi3r.wnnections > Bubble
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printer to select, start with the HP LaserIet II. If you have any

doubts, experiment by trying the other printer options. '

Figure 7.26 shows the Printers Network view. As you can see, this

page is very much like the Printers Connected View.

Your menu choices are a View and an Options menu. The menus

are described in the following list:

View

Printers This selection sets the View so only the available printers
are shown.

Printer Servers This selection shows the PenCentral printer

server’s name. When the view is expanded, all of the printers con—

nected to the printer are shown. When it is collapsed, only the

printer server name is visible.

Expand This selection shows all of the printers for a server when

the page is viewed in the Printer Servers mode.

Collapse This selection hides all of the printers for a server when

the page is viewed in the Printer Servers mode.
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Options

6 The first menu item is the options sheet for the selected printer.

The printer’s name is displayed as the menu item. Figure 7.27

shows a networked Printer options sheet. In this options sheet

you are shown the Type of printer, the Server’s name, the Loca-

tion of the printer, its Connected status, and. whether it is set to
Auto—Connect.

PenTOPS Status This is the same options sheet that was dis—
cussed in the networked disk section above.

Layout The Layout options sheet is the same for the networked

printers as it is for the connected printers.

Update

The Update menu performs the same function as the Update com—
mand for the networked disks.

The networked printers displayed come from the configuration in

PenCentral But, the type of printer is not established by PenCen—

tral When you connect the printei by tapping.V on the Connected
check box, you will be presented with an options sheet (see T10

728) that asks you to define the type of printer. The options sheet

that appears is almost exactly like the Create options sheet.
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With this options sheet you can name the networked printer and

define the type of printer connected to the PenCentral server.

Using PenTOPS Modem
PenTOPS Modem is an accessory found in the Accessories Note—

book. With PenTOPS Modem you can access any PenCentral

server that has been set up for modern access. With PenTOPS

Modem you can be on the road and call into your company using

the PenCentral server to send and receive documents from your

EO, no matter where you happen to be.

When first opened, the PenTOPS Modem accessory appears as a

very boring page. You have an empty page with a Connect Menu

button and an Options menu. The Options menu provides you

with two choices: Modern Settings and Status. Figure 7.29 shows

the Modem Settings option.

With this options sheet you can select the following:

Serial Port Use this option to select the serial port. If you’re

using the EO’s built-in modem, it should be set to COM2.

Modem Speaker For this setting you have three choices: Always

On, Always Off, and On Until Carrier Detect (the default). This

setting lets you listen to what the modem is doing as it dials the

server’s phone number. It makes a lot of noise if you set it to

Always On. You should use the default setting or Always Off,

unless you are trying to troubleshoot your phone connection.

Speaker Volume This setting tells the modem how loudly to

make noise. Your choices are: Whisper, Low, Medium, and High.

How it is set depends on your circumstances and whether the

noise will bother other people When you are connecting.
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Tone Detection How this setting is used depends on the type of

phone system you’re using. Your choices are: Detect Busy & Dial

Tone (the default), Detect Busy Tone Only, Detect Dial Tone Only,

and Ignore Busy & Dial Tone. You should use the default setting in

most circumstances. You will want to use the other settings if, dur—

ing the dialing sequence, the phone system you’re using generates

a busy tone or does not generate a dial tone.

We’ll talk about the Status option last because it has no config-

urable options and is for information only. Right now, let’s look at

connecting to a file server by setting up the PenTOPS Modem con—

nection. Figure 7.30 shows the options sheet that appears when

you tap on the Connection menu.

In the Connection options sheet you have three settings:

Modems This option tells the E0 whether to use the Cellular

Module or a connected phone line.

Dial Type This setting instructs the modem to dial the phone

using dial tones or the pulse method. Use the pulse method if a

phone connected to the line is a rotary type phone.

Telephone Number Here is where you enter the telephone num—
ber for the PenCentral server. You must enter the full number here

because PenTOPS Modem does not access any of the 130’s phone

books or Dialing Location options sheets. If you need to enter

access numbers to dial out on a phone system, enter them by plac—

ing them before the phone number, separating each of the access

numbers with a comma. If you are charging the call to a calling

card, enter the calling card number in the same location you

would as if manually dialing the phone. If the dialing card number

goes after the phone number, enter a couple of commas between

the phone number and the dialing card number.
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Once you have set your options, tap Y on the Dial button, and the
PenTOPS Modem will dial the server and log you in. When you’re

using PenCentral for modern access, the server should be pass—
word—protected so not just anyone can dial in. When you dial in,

you will receive a message saying that a connection has been

established. Once that happens, you need to open the Connections

to connect to any drives or printers.

When you’re using the PenTOPS Modem, your Bookshelves are

not displayed for the networked drives. You will have to do all of

your document transfers using the Connections accessory when

accessing server disks. Even if you’re using a fast modem , the

server is slower than if you are physically connected. And if the

server is using a slow modem (2400 baud is slow), you could get a

little gray waiting to access the server and transfer documents.

While you’re connected, you can look at the PenTOPS Modem Sta-

tus options sheet to see exactly what the E0 and the server are

doing. All the Status options sheet does is show you communica-

tions information about your connection. Figure 7.31 shows the

PenTOPS Modem Status options sheet.

Once you’ve finished your file transfers you’ll need to disconnect

from the file server by opening the Connection options sheet in
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PenTOPS Modem, if it has been closed, and tapping l’ on the Hang
Up button.

To improve connection speed when using PenTOPS Modem, you

should remove all unnecessary files from the root directory of the

PenCentral server. Also, keep any directories you’re going to

access as empty as possible. Other than these tips, you’ll just have

to suffer through the slow connection. There is not much that can

be done about the speed other than using a 14.4 bps modem on the
server.

geria! and Modern Connections

to Other Machines

This section is going to tell you in general terms what you need to

connect your EC) to computers other than an MS—DOS machine.

(This section does not discuss using disks of any type for connect-

ing to other machines.) This is because what you need to make this

happen is not included with your EO when you purchase it. To

connect an EC) to another computer requires special software and

hardware which you’ll have to purchase.

There are two items you need to connect an EC) to other comput—

ers. You’ll need to purchase one of the two available terminal pro—

grams and a special cable called a null modem cable. Terminal

programs are also called communications programs. The two that
are available are called PenASCll and Mobile Access. Each is dis—

cussed in Chapter 11. The computer you’re connecting to will also

need a communications package.

For the null modem cable you’ll either have to have one made or

make one yourself. This section does not tell you how to make the

cable, but the EO’s serial port configuration is in the Appendix if

you want to make your own. You can also order a null modem

cable from a company called System Connection (their address is

in the Appendix). They know about the EC) and can make a cable

that will connect it to almost any computer made. The other com-

puter has to have a serial port. If it is a very weird computer, and

System Connection does not have the information they need to
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ware manual or contact the manufacturer, then fax System Con—

nection the serial port configuration information. In most cases,

you won’t need to worry.

; Another way to make connections to other computers, without a

.5 cable, is to use the communications packages and connect to the

other computer using the EO’s modem. This assumes that the

, other computer has a modem also. However you make the con—

nection, the principles involved are the same. You have to make

sure that the E0 and the computer are talking the same language.

What determines the language is a collection of settings called

communications parameters which are set using the communica-

tions software. The settings on both machines have to be the same,

otherwise they will not be able to talk. The following is a list of the

most basic communications parameters and their functions:

BPS, Baud, or Speed The speed of the connection is how fast

data is sent from one machine to the other. If the speed setting is

not the same between the ED and the computer, they will not com-

municate. Communications speeds are designated in terms of bps

(bits per second). Baud is a term you might hear in relation to

communications speed, but this is an old and obsolete term. Direct

cable connections can be done at speeds up to 115,200 bps.

Data Bits This setting will determine how long each byte (one

letter) will be, in bits. The normal setting is either 8 or 7 data bits.

Parity Parity is an errorwchecking convention, and you will have

the choice of using None, Even, or Odd parity. Both machines

must use the same parity setting.

Stop Bits Stop bits is another error-checking convention. You

choices will usually be 1, 1.5, or 2. Some communications packages

will let you use an auto setting that will match whatever the other

device is using.

Flow Control Flow control is how the EC) and computer will tell

each other that they are ready to receive or send data. Your choices

could be Xon/Xoff, Hardware, or None. This setting will depend

on the capabilities of the computer you’re connected to and the

software. The universal setting that every communications pack—

age can use is Xon/Xoff.
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Your communications settings need to be the same on each

machine whether you’re using a modem or a direct serial connec~

tion. If you’re using the modem, you’ll have to use the data speed
of the lowest common denominator, which will be one of the

modems. The fastest modem speed you can use is 14400 bps, the

speed of the EO’s modem. When using a serial connection, start at

the highest speed possible usually 115000 bps. If there are a lot of

errors or problems decrease the speed until you have a reliable
connection.

Once you have a reliable connection, transferring files will be done

using what is called a file transfer protocol. There are several proto-

cols you can use. The following are the most common:

Xmodem This is the most common protocol used for transferring

files. Every communications package can support Xmodem file
transfers.

Ymodem This is a variant of Zmodem. It can be used to send

several files at once and offers a more automatic means for trans-

ferring files. This is often the protocol of choice when using mod-

ern modems and communications packages.

Zmodem This is the newest and most efficient transfer protocol

available. If a file transfer is interrupted while using Zmodem, the

transmission can be completed without resending the entire file. It

is the protocol you should use if you are using a modem and espe—

cially if you are using EO’s Cellular option.

Kermit This is the file transfer protocol used for most mini and

mainframe computers. It is also very good when using the modem

with poor line connections or EO’s Cellular option. However, this

protocol. is not usually used with desktop computers.

Text This protocol is used to transfer text files only.

Any document other than a text file must use a protocol transfer to

get from one machine to the other. If a document is not a text file,

it is considered to be a binary file. The communications packages

available for the E0 offer you the opportunity to convert your

files’ format before they are sent to another computer. (See the sec~

tion on exporting and importing.) Using a transfer protocol is

required for either direct or modern connections.
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Determining what will work best is usually a matter of practice. If

you are going to use a serial cable to connect an E0 to another

computer, make sure you give yourself enough time to experiment

before you need to transfer documents. If you wait until you have

to get the document from your E0 to another computer you. will

find yourself looking full-faced at Murphy’s Law.

Likewise, if you’re connecting to the company’s mainframe while

on the road, you should practice before you leave the office. Other-

wise, you’ll find yourself trying to get a critical file to your boss

and unable to do so because you’re unfamiliar with the process.

The process of data communications often seems inaccessible

because it has its own language. But it really just another facet of

computing technology. If you are patient and take the time you’ll

be able to send and receive documents from any type of computer

wherever you happen to be.

Sharing Documents wit: a oointosh
The Macintosh is an extremely popular computer, but the E0 has

no means of directly sharing documents with a Mac. This should

not be considered as a shortcoming; it was a business decision.

The Macintosh is a wonderful computer, but there are eight or

nine MS—DOS computers for every two Macintoshes in use today.

So, if you were designing a new computing device, and had to

choose what types of computers you were going to directly con—

nect to, (knowing that you could not do both and get your new

device into the marketplace in a timely manner), which would you
choose?

If you made a smart business decision, you would choose to con—
nect to the MS—DOS machines. This does not mean that E0 is

ignoring the Mac. An easy means to connect to the Mac should be

available in about a year. It was just a matter of being pragmatic.

Apple recognized that being able to share data with MS—DOS

machines was a necessity and equipped all Macintoshes with the

ability to share data with MS-DOS computers a few years ago.

This is another reason Why the EO’s ability to communicate with

MS—DOS machines actually means they can communicate with
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Macs. Apple and third—party Macintosh vendors have provided
the solutions,

Other than transferring files using a network that is used by both

MS—DOS and Macintosh computers, there are some products on

the market that you can use to read MS—DOS or E0 floppy disks
on a Macintosh. These include:

0 Apple File Exchange

0 PC Exchange

O DOS Mounter

0 AccessPC

Each of these utilities enables a Mac to read a MS-DOS disk. PC

Exchange, DOS Mounter, and AccessPC are functionally the same.

They all mount a MS-DOS disk on the Macintosh’s desktop. The

Apple File Exchange utility, on the other hand, is an application

that lets your Mac read a MS~DOS diskette. Since the desktop MS-

DOS disk mounters all operate on the same principles, we will dis-

cuss their shared attributes as well as take a look at each utility.

Apple File Exchange

Apple’s File Exchange utility is distributed as part of Apple’s Sys—

tem software. It was originally introduced when the SuperDrive

was first introduced. It can be found in the Apple Utilities folder

on the Tidbits disk of Apple’s System 7.1 and 7.0 System Disks. If

you are only going to be transferring a few files between your MS-

DOS machine and a Mac, this is the only utility you really need.

With the Apple File Exchange utility you can transfer files, read,

and format MS—DOS disks on your Macintosh.

To use Apple’s File Exchange to read and transfer files from a
MS-DOS disk:

1. Open File Exchange by double—clicking on the Apple File

Exchange icon.

2. After the application launches, you will see a screen like the

one in Figure 7.32.
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3. On the left—hand side you can see the directories (folders) on

the Macintosh hard disk. The right side is blank until you

select the drive button or insert a floppy disk. If you try to read

an MS-DOS floppy disk before running the File Exchange util-

ity, the Mac will ask you if you want to format the disk. If you

format the disk, you will destroy any data on it and turn it into
a Macintosh diskette.

4. Insert the MS—DOS floppy disk.

5. The files and directories on the MS-DOS floppy will appear in

the right-hand file window.

6. Select the file you want to transfer by clicking on it with the
mouse. When the file is selected, the Translate and Remove but—

ton between the two directory windows will become selectable.

7. Select the directory into which you. want to place the file you

are transferring by double—clicking on it. Remember that Mac—

intoshes use a hierarchical directory system just like your MS-

DOS machine’s directory structure.

8. Set the translation options by selecting the MS—DOS to Mac

menu that appears after step 7. You can see your choices in

Figure 7.33.

9. Press the Translate button. The MS—DOS file will be translated

if any options were selected, and copied to the selected direc-

tory on the Macintosh.
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When copying Macintosh files for use on the 130 you should save

the files in a format that is compatible with the E0. This means

that word processing files should be saved in RTF format. Files

that are going to be used with other EO programs may require

other formats. You’ll have to check your software’s manual. When

transferring files from the Macintosh use the Default translation

option. The only other detail you need to be concerned with is the
name of the file.

Macintosh files can have up to 32 characters in their names, while

DOS files can only have 8 characters plus their 3~character exten—

sion. So you will have to rename the Macintosh file and give it the

proper extension. If you are transferring a Microsoft Excel file

named Sales Report that you want to use on your E0, you will

have to save it as a text file or in a format compatible with the E0

application that will use the document. You will then have to

rename it to something like salesrpt.xls. Otherwise, Apple File

Exchange will automatically rename it for you with a name like

saleswrepor.

Desktop Mounting Utilities
There are three utilities available for the Mac that will ”mount” an

MS-DOS disk on the Macintosh desktop. This means that the Mac

can display the MS—DOS disk, read its files, and copy files to it.

Kyocera PX 1046_338



Kyocera PX 1046_339

E0 CONNECTIONS 

They are PC Exchange by Apple, DOS Mounter by Dayna Com—

munications, Inc, and AccessPC by Insignia Solutions. All of these

products work on the same principles.

These utilities are all Control Panel devices (Cdevs) and can be

accessed from the Control Panels folder under the Apple menu in

System 7.0 or better, or the Control Panel desk accessory if the Mac

is using System 6.0.X. Each utility lets the Mac recognize your MS—

DOS disks as if they were Macintosh disks, yet still acknowledges
that the disks are MS—DOS disks.

All three utilities allow you to copy files from an MS-DOS (hence

an E0) disk to the Mac, or from a Mac file to your MS—DOS disk.

An MS-DOS disk that is mounted on the desktop with one of these

utilities is treated by the Macintosh as if it were a native Macintosh

disk. Each utility also gives your MS-DOS disk a desktop icon that

is unique.

When you copy a file from or to the MS-DOS disk, the file is

copied without any type of translation. This means that you have
to save the files in a format that can be used on the E0 and the

Mac. Finally, each utility allows you to map or assign DOS exten—

Sions to specific Macintosh applications. The mapping capability

lets you launch the application on the Mac by double-clicking on
the icon of the MS—DOS file.

Because the files on the E0 disk are treated like Macintosh files,

you have to watch your file names (depending on the utility), oth—

erwise you will have very strange names when you look at the

disk from an MS—DOS machine or your EO (see Fig. 7.34).

You have to change the name of a file copied onto the MS—DOS

disk into a name recognizable by a MS~DOS machine.

Each of these utilities works with all floppy disk sizes (provided, of

course, that you have the appropriate hardware). A couple of them

also work with removable media hard drives, and optical drives

that have DOS partitions. These utilities can make it possible for

you to share files between MS—DOS machines and Macs without a

network. They are handy even if you do have a network, since

putting a file on a floppy will work even if the network is down.
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PC Exchange is Apple’s MS~DOS disk mounting utility. You can

tell when the Macintosh is running PC Exchange because the desk-

top icon Will look like the one in Figure 7.35.

With PC Exchange and the appropriate drive you can read and

format 1.44M or 760K 3.5—inch and 1.2M and 360K 5.25—inch floppy

disks. In other words, you can handle all of the possible floppy
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configurations for a standard MS—DOS machine. PC Exchange
works with any Macintosh running System 7.0 or later that has an

Apple SuperDrive or a Macintosh-compatible 3.5 or 5.25-inch

floppy drive. Unfortunately, PC Exchange has the fewest capabili—

ties of all the DOS mounting utilities and only works with floppy

disks. So if you need support for Syquest, Bernoulli, or optical

disks, especially if you’re using one of these with an E0 880, you

will need a different utility.

Figure 7.36 shows the Control Panel for PC Exchange. Here you

can see that any DOS file with the .doc extension is automatically

l assigned to Microsoft Word, while an .xls extension is assigned to
l Microsoft Excel. Although Figure 7.36 shows the default assign—
X ments, you can assign an extension to any application and add it

to the list in the control panel. 

DOS Mounter Plus

Of all the Macintosh desktop mounting utilities, DOS Mounter

Plus by Dayna Communications is the most unique. In addition to

mounting MS—DOS floppy disks, DOS Mounter will also mount a

Novell Netware server volume. DOS Mounter requires a Macin—

tosh with a SuperDrive, and either a Dayna SCSl 5.25-inch floppy

drive, or another third party SCSI floppy drive. DOS Mounter

does not support Apple’s 5.25~inch disk drive.
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At one time (in the very recent past) the netware capability was

part of Dayna's Net Mounter, while DOS Mounter was strictly for

mounting removable media disks, including floppies. Now Dayna

has combined both utilities into one product. Figure 7.37 shows

the icon DOS Mounter creates on the Macintosh’s desktop.

DOS Mounter does not allow Macintosh file names on MS-DOS

disks. If you copy a Macintosh file to a BC disk-mounted with

DOS Mounter, you will get a file name like the one in Figure 7.38.

DOS Mounter treats file names in the same manner as the Apple

File Exchange utility.

Like PC Exchange, DOS Mounter’s control panel is used to link

DOS extensions and Macintosh applications. This means you can

 
Figure 7.37 5153,:11'11

The Doyno's

DOS Mounter Fm;

desktop icon

 

    
 
 
 

 

 

 
 

 

  

 
 

   

PC disk

Figure 7.38 5—:ng EUUTIL '2 %EE

An MS-DOS i3 item-5 7929K in disk GEEK available

disk mounted E E ""' gig;
on 0 Mac W'lh IMSTDHT IIiISTALLEFEE FCEIiITFAL PEDIPDII-irnia
DOS Mounter

,t—t ,—. [in —. gm...“ _um}
FEMPC'IIKIT TE|_C’-_E- iAPPLEPO .INT

 

    
 

 
EDESKTOPIOL

  
   

Kyocera PX 1046_342



Kyocera PX 1046_343

E0 CONNECTIONS 

save your MiniText document onto a disk and call it something

like REPORTRTF, and then tell DOS Mounter to open any .RTF
file in Microsoft Word.

AccessPC

AccessPC is published by Insignia Solutions. AccessPC works like

Apple’s and Dayna Communications utilities and has the same

basic features. AccessPC’s desktop icon is shown in Figure 7.39.

AccessPC also comes with a removable hard disk driver called

MULTl—DRIVER and a hard disk formatter called Media Format—

ter. MULTl-DRIVER is needed if you are going to use MS-DOS

removable media disks on your Macintosh. If you have an E0 880

and a Macintosh with a removable media drive you can use the
removable media drive on both machines.

Once again, a control panel is used to control this DOS disk desk—

top utility (see Fig. 7.40). The AccessPC control panel has the usual

section for assigning extensions to Macintosh applications plus a

couple of extra features.

Like DOS Mounter, AccessPC also converts Macintosh file names so

that they are recognizable by a MS—DOS machine. in the AccessPC

control panel are some additional options, the SPMount and
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HDMount buttons. The SPMount button in the AccessPC control

panel is for mounting a SoftPC hard disk partition and the

l—lDMount button is for mounting a MS—DOS partition on a remov—

able media hard drive (this option requires MULTl-DRIVER).

Using any of these utilities will let your Macintosh read a disk

from the EO’s floppy drive, a removable media hard disk used

with an EC) 880, or a floppy disk from a PenCentral file server. So

as you can see using EO documents on a Mac, or Mac documents

on an E0, is not a problem.

Eerinl Cannectans

If you do not have an EC) floppy disk drive and need to transfer

documents from an EC) to your Macintosh, or vice versa, you can

always use a direct serial connection. To make this work, you will

need a communications package for the Mac, a null modern. cable
that will work between the E0 and the Mac, and a communica—

tions package on the E0. Truthfully, it will cost a lot less money to

purchase an E0 floppy drive than it will to buy a communications

package for both the E0 and the Mac plus a cable.

Even though the serial port on the E0 looks like the serial port on a
Macintosh, a cable that will work between two Macs will not work

between an E0 and a Mac. You must get a special cable. Otherwise,

using a serial connection has already been briefly discussed. Once

again, you should experiment before you need the connection.
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PenCentraI—Everything You Need
to Know

PenCentral is a program written by SunSelect, a subsidiary of Sun

Microsystems, Inc, for the PenPoint operating systems. Using

PenTOPS from your EO requires no more than attaching the E0 to

the MS—DOS machine running PenCentral and opening the Con—

nections accessory. However, PenCentral can be a bit more chal—

lenging. PenCentral is an MS—DOS program that needs to be

installed and configured before you can connect your E0 to the

MS-DOS machine. This section will go through the installation

steps, configuring, and troubleshooting of PenCentral.

NOI'e PenCentral can be used on a machine running 05/2 version 2. On
an 05/2 machine it will have to run in a Virtual DOS Machine

{VA/1D]. If you want to run PenCentral on a machine running
Microsoft Windows, you will have varying degrees of success. Pen—
Central is not really compatible with a Windows machine, but it has
been known to work. Using PenCentral in a DOS Window on a
Windows machine is not supported by E0 or SunSe/ect.

Installation

Included with your E0 is a 3.5—inch floppy disk. This disk contains

the PenCentral program and installation files. Before you install

PenCentral, you need to be sure your MS-DOS machine has the

following:

6 A computer running MS-DOS that is compatible with an IBM
PC, XT, AT, or PS/2

a At least 512K memory

a A serial port, either a RS 232 (a 25—pin serial port) or a RS 232C

(a 9—pin serial port). The E0 comes with a RS 232C to RS 232

converter so the cable will work with either type of port.

0 A 3.5—inch high density drive (1.44 M)

0 The floppy disk that came with your E0

0 The PC connection cable (also included with your E0)

0 A modem is optional, if you want to use PenTOPS Modem

from your EO you will need a modem on the MS—DOS machine.
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° A mouse is optional.

Before you start installing PenCentral you should make a back-up

of the floppy disk that came with your EO. If you need help mak—

ing a back-up disk, check your MS—DOS manual.

To install PenCentral:

1. Insert the floppy into your computer.

2. At the system prompt (C:\>) switch to the drive containing the

floppy by typing either A: or 3 : and then press Enter.
 

3. At the prompt (A:\> or B:\>) type Install and then press
Enter.

4. Select the drive and directory to which you want the PenCen—

tral files copied and select Begin.

5. These steps complete the initial installation. After the PenCen—

tral files have been copied to your hard disk or another floppy

you will see a screen like the one in Figure 7.41.

Nfifi'e If you are using a mouse, there is a possibility that your mouse is a
serial mouse and connected to one of your serial ports. This means
you will only have one other serial port to use for your E0 in the
default PenCentral Configuration window. However, it is possible to
add additional serial ports if they do not exist on your computer.
The E0 cannot perform data transfers using the parallel port, so this
option will not he discussed.

Figure 7.41

The

PenCentral

Server

configuration
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Configuration

The next step will be to configure PenCentral. PenCentral will list

the serial and parallel ports it found on your computer next to the

ports it can use. The next thing you have to do is tell PenCentral

which ports you want to use and how you want to use them.

To configure PenCentral:

1. Select the first port by using your mouse or the cursor keys.

2. Select the Configure button. You will see a screen that looks

like Figure 7.42.

Your choices will be:

Serial Link to Tablet Use this selection to configure PenCen-

tral to use the selected port for a serial connection.

Parallel Link to Tablet This selection is not supported by the
E0.

Modem Link to Tablet Use this selection to configure Pen—

Central to use the selected port for a modem connection if you

are going to use PenTOPS Modem on your EC).

Shared Printer Use this option to share a printer connected

to your computer with your E0. A printer can be on either a

parallel or a serial port, although most printers for MS~DOS

computers use the parallel port.
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None of the Above Select this option if you are not going to

use the selected port with your E0.

3. Select the option you want to use for the port using the mouse

or the cursor keys.

4. Repeat steps two through three for each listed port.

When PenCentral installs itself, it looks at your MS-DOS com-

puter’s configuration and automatically sets up all of the floppy,

hard, and network drives as being available for use with an E0. If

you want to change the volume configuration, you will have to

manually edit PenCentral’s configuration file. (This is discussed in

its own section later). You can also make directories on any MS-

DOS volume available as individual volumes using some DOS
tricks which are also discussed later.

Once you have configured PenCentral, you can connect your E0

to the MS—DOS machine. If you are not going to print using Pen—

Central, and you are happy with all of your drives being available

without modification, you can skip the rest of this section and look

at Using PenCentral.

Changing Your Configuration

Sometime after you have installed PenCentral, you may need to

reconfigure it for a printer or change how the ports are assigned.

To do this you will need to access the Configuration window in

Figure 7.43.

To reconfigure PenCentral after installation:

1. Start PenCentral.

2. Put any EOs connected to the server into Standby mode by

pressing the On/ Standby button.

3. Select the Setup menu and either click with your mouse or

press the Enter key.

4. Select the Ports menu item from the menu.

You will receive the same window as you did when you first set

up PenCentral. To reconfigure the ports, follow the steps at the

beginning of this section on configuration.
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Printer Configuration

Before you make your printer available to the E0, you have to

make sure it is compatible. The previous section on printers lists

all of the compatible printers. Once you know that your MS—DOS

machine’s printer is compatible, you can make it available to your

EO. Using PenCentral as a print server makes it possible for you to

use a serial printer with your EO as long as it emulates one of the

compatible printers.

To share a printer with your E0:

1. Follow steps one through four from the Changing Your Con—

figuration section.

2. Select the port to which the printer is attached.

A window like the one in Figure 7.43 will appear.

4. In the Printer Name field, enter a name to identify your

printer.

5. Select the Printer Type field and type an L for a printer attached

to your MS-DOS machine or an N for a networked printer.

6. Select the OK button and press the Enter key.

This will make the printer available to your E0. Repeat these steps

for however many printers you have connected and want to make

available to your EO. You will have to finish setting up the printer

Figure 7.43

The Printer

Configuration
window
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connection on your EC). To do this see the section on setting up

your printers.

Modem Configurations

To enable modem access to PenCentral you need to have a modem
attached to the PenCentral server. Once the modem is attached,

you’ll have to follow the steps in the Changing Your Configuration

section and tell PenCentral that you have attached a modem to

one of your serial ports. After you have configured a port for a

modem you may have to perform some additional steps so Pen-

Central will properly use the modem. PenCentral assumes that

you are using a standard Hayes compatible 2400 baud modern.

If you are using a different type of modem you will have to change

PenCentral’s configuration file so it will know how to talk to the

modem. PenCentral will support a variety of modems and has

included configuration settings for the following modems:

s Telebit T2500

a Hayes V-series SmartModem 9600

s Practical Peripheral PMléMOOFXSA V.32bis

a MultiT‘ech MultiModem V32

69 Hayes 1200 “dumb” modem

a Ventel 9600 Plus

a Viva 9642c 14.4/Fax and Viva, 9642e

If you do not have one of the modems listed above, you will prob~

ably have to call your modem’s manufacturer to set all of the con

figuration options correctly. Setting modem initialization strings,

the commands that make the modem work properly, can drive the

initiated crazy; novices may commit suicide. If you have to change

the settings and you have one of the modems listed above, you

should print out the file in your PCentral directory called

MODEMSDAT. (This is the default directory PenCentral makes

when it is installed. If you renamed the directory the file will still

be in it.) Use this file as a guide for changing the settings in Pen—

Central’s configuration file. MODEMSDAT is a text file that you

can read or print with a text editor like Edit in MS~DOS 5.0.
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The PenCentrol Configuration File

Everything PenCentral does is controlled by a text file called PEN—

INFODAT. This file can be found in the PCENTRAL directory or

the alternate directory you created when installing PenCentral. To

edit the PENINFODAT file you will have to use a text editor like

the Edit program in DOS 5.0. However, before you edit the PEN—

INFODAT file, make a backup. If you make a mistake, PenCentral

will not work and you’ll need the original file to restore PenCentral.

By editing the PENINFODAT file you can modify the following:

0 Volume Names

0 Modem Settings

0 Assign Passwords to volumes

9 Assign read and write restrictions to volumes

@ Set PenCentral for access by multiple EOs

In order to help you change these settings, this section will look at

the different sections of the PENINFODAT file and explain what

the settings are and the changes you can make. This information is

vital if you are going to customize PenCentral. If there are any
errors in the PENINFODAT file, PenCentral will not work.

Server Configuration Information
The following section of the PENINFODAT file sets the default val-

ues for your PenCentral server. The format for the PENINFODAT
file is as follows:

Parameter name or description (allowable settings): Current setting

Ii_ll

To change a setting, enter a new value after the . on the settings
line. In the section of the PENINFODAT file below, the numbers

before the lines are added for easy reference. Your file should not

have numbers in front of the configuration setting.

PenCentral Server Configuration Information

1. PenCentral server name (up to 31 chars): PenServer

2. Total number of configurable COM ports (1 — 16): 2
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